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Utilisation du mode Smart Hub

Connexion a Internet
MENU/123 > MENU > Réseau > Paramétres réseau

Connecter le téléviseur a Internet. Vous pouvez utiliser une connexion cablée ou sans fil.
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Configuration du mode Smart Hub

Appuyez sur la touche § de votre télécommande. Lorsque le mode Smart Hub est activé pour la premiére fois,
s'affiche alors I'écran Configurer Smart Hub. Suivez les directives a I'écran pour régler les parametres requis et

terminer la configuration.

Bienvenue dans Smart Hub

La fagon la plus facile d’obtenir et de découvrir de la télé en direct, des films, des applications, des jeux et plus encore.

Configurer Smart Hub | Plus d’infos I

Utilisation du mode Smart Hub
Le mode Smart Hub vous permet d'avoir simultanément plusieurs fonctions sur un seul écran.

Pour plus d'information, reportez-vous a la section « Smart Hub ».



Commander votre téléviseur a I'aide de votre voix

Configuration du mode Reconnaissance vocale
MENU/123 > MENU > Systéme > Reconnaissance vocale

Configurez les parameétres requis pour la commande vocale, comme la langue a utiliser et si vous désirez ou non
utiliser la fonction Voix TV.

Systéme

Accessibilité

Configuration

Mode Sports

Langue menu Francais
Sécurité intell.

Config. télécommande universelle

Reconnaissance vocale

> N e . . ipes . .
¢  Selon le modéle de votre téléviseur, le menu affiché peut différer de I'image ci-dessus.

Commande du téléviseur avec votre voix

Appuyez sur la touche MENU/123 de la télécommande Smart Control et maintenez la pression. L'écran de
reconnaissance vocale s'affiche. Lorsque I'icbne Reconnaissance vocale s'affiche, prononcez des commandes
lentement et a un volume modérément élevé dans le microphone situé dans la télécommande Samsung Smart
Control.

» N P o . . 2~ . 2~ 2z
@  Pour les modéles de série 9500, vous pouvez utiliser la fonction de reconnaissance vocale avec la caméra intégrée au
téléviseur et la télécommande Samsung Smart Control. Réglez I'option Microphones activés a TV et télécommande.

> " . < . P <l .
@ Pour plus d'information, reportez-vous a la section « Commander votre téléviseur a l'aide de votre voix ».



Commander votre téléviseur a l'aide de gestes

Configuration du mode Commande gestuelle
MENU/123 > MENU > Systéme > Commande gestuelle

Réalisez le Test environnement de commande gestuelle, puis réglez les configurations associées 8 Commande
gestuelle, comme ajuster la Vitess pointeur et indiquer si vous préférez afficher le Guide gestuel animé.

Systéme

Configuration

Mode Sports

Langue menu Francais
Sécurité intell.

Config. télecommande universelle

Reconnaissance vocale

Commande gestuelle Activer

> N e . . cpes . .
¢  Selon le modéle de votre téléviseur, le menu affiché peut différer de I'image ci-dessus.



Commande du téléviseur avec des gestes

MENU/123 > MENU > Systéme > Commande gestuelle > Commande gestuelle
1. Réglez le mode Commande gestuelle a Activer.

2. Faites face a la caméra et levez votre main, dans une position confortable, en pointant votre index vers le
haut, puis déplacez votre index lentement vers la droite ou la gauche.

3. Repliez votre index et redressez-le de nouveau pour exécuter la fonction que vous avez pointée.

¢ Lafonction Commande gestuelle est disponible soit en mode de commande de la direction ou en mode de pointage avec
des mouvements.
> e . . z 2 7 7
¢  Lorsque votre téléviseur n'a pas de caméra intégrée ou ne comprend pas de caméra, vous devez acheter une caméra
pour téléviseur en option pour pouvoir utiliser la fonction Commande gestuelle.
> . . N . A = .
¢  Pour plus d'information, reportez-vous a la section « Commande du téléviseur a l'aide de gestes (Commande gestuelle) ».



Utilisation de la fonction Samsung Smart Control

Faire fonctionner le téléviseur a I'aide de la touche POINTER

Placez un doigt sur la touche POINTER puis effectuez un mouvement avec la télécommande Samsung Smart
Control. Le pointeur a I'écran se déplace dans la méme direction que la télécommande Samsung Smart Control.
Déplacez le pointeur sur une des icdnes suivantes a 'écran, puis appuyez sur la touche POINTER.

. @ : Permet d'afficher la télécommande a I'écran.
. @: Vous permet d'ajuster le volume ou de sélectionner les haut-parleurs.
. @ : Vous permet d'afficher la liste des chaines.

o @ : Permet de lancer Smart Hub.



Configuration de la télécommande Samsung Smart Control
MENU/123 > MENU > Systéme > Paramétres Smart Control

Configurez les paramétres de base pour utiliser la télécommande Samsung Smart Control.

Systéme

Config. télécommande universelle
Reconnaissance vocale
Commande gestuelle

Heure

Avis

Gest. périph.

Paramétres Smart Control

Exécution du pairage entre le téléviseur et Samsung Smart Control

Lorsque vous mettez le téléviseur sous tension pour la premiére fois, il est automatiquement apparié avec la
télécommande Samsung Smart Control. Si l'appariement de la télécommande Samsung Smart Control avec le
téléviseur ne se fait pas automatiquement, pointez-la vers le capteur du téléviseur, ensuite appuyez simultanément
sur les touches (D et (2) indiquées dans le diagramme pendant 3 secondes au minimum.




Améliorer I'expérience de visionnement d'événements sportifs

Activer le mode Sport
MENU/123 > MENU > Systéme > Mode Sports ou Mode Soccer

Réglez le mode Mode Sports a Activer. Le téléviseur configure automatiquement les réglages de l'image et du son
afin qu'ils soient adaptés aux matches de soccer.

Systéme

Accessibilité

Configuration

Mode Sports

Langue menu Francais
Sécurité intell.

Config. télécommande universelle

Reconnaissance vocale

Vv

¢ Vous pouvez agrandir une image lorsque vous utilisez le mode sports. Déplacez la cible de saisie sur la partie de I'écran a
agrandir.

¢ Selon le modele de votre téléviseur, le menu affiché peut différer de l'image ci-dessus.

¢ Lenom courant peut différer selon les zones géographiques.

¢  Pour plus d'information, reportez-vous a la section « Rendez vos émissions sportives plus réalistes avec le mode Mode

Sports ».



Afficher plus d'un écran

Vous pouvez naviguer sur Internet ou exécuter une application tout en regardant la télévision. Vous pouvez
modifier la taille de chaque écran en déplacant le cercle dans le milieu de I'écran vers la gauche ou vers la droite.

" . . N . . 7 X . a N .
¢  Pour plus d'information, reportez-vous a la section « Afficher plus d'un écran a l'aide du mode Ecran a plusieurs sources

».



Connexion d'une antenne

Branchez le cable de la prise d'antenne ou de cable murale dans le connecteur ANT IN, tel qu'illustré dans le
diagramme ci-dessous pour recevoir les signaux d'émission.

> . . . a z 2
@ lln'est pas nécessaire de brancher l'antenne si vous connectez un cablosélecteur ou un décodeur.

ANT IN




Connexion a Internet

Etablir une connexion a Internet cablée

Utilisation de cables LAN

Vous pouvez brancher le téléviseur aux points d'accés Internet de trois fagons, conformément aux l'illustrations ci-
dessous :

e Prise LAN murale

e Modem externe

SEESSSS888SSS

(gesa g=5)

~—

e (D Routeur IP + (2 Modem externe
LAN
SESESSSESSES|T2
Hod @ ( @@@@@
SS \SS

> "
¢  Nous vous recommandons d'utiliser des cables réseau de catégorie 7.

> . . < A L . N L1z = . N
¢ Lavitesse de votre connexion a Internet doit &tre supérieure a 10 Mbps pour que le téléviseur puisse se connecter a
Internet.



Connexion automatique a un réseau Internet cablé

MENU/123 > MENU > Réseau > Paramétres réseau L0
Connexion automatique au réseau disponible

1. Sélectionnez Cable.

2. Une fois la connexion réseau établie, un message de confirmation s'affiche. En cas d'échec, essayez a nouveau
ou établissez la connexion manuellement.

Etablir une connexion a Internet sans fil

.)))rrr.

Connexion automatique a un réseau Internet sans fil

MENU/123 > MENU > Réseau > Paramétres réseau

Assurez-vous d'étre en possession du SSID (nom) et du mot de passe du routeur sans fil avant de tenter de vous
connecter.

1. Sélectionnez Sans fil. Le téléviseur affiche automatiquement une liste des réseaux sans fil disponibles.

2. Seélectionnez un réseau. Sile réseau que vous souhaitez n'apparait pas dans la liste, I'écran retourne a
l'affichage des paramétres du réseau.

3. Sivotre réseau est sécurisé, entrez le mot de passe a l'aide du clavier affiché a I'écran. Si la fonction sécurité

n'est pas activée sur votre réseau, le clavier n'apparaitra pas a I'écran et le téléviseur tentera immédiatement
une connexion.



Connexion a un réseau Internet sans fil avec WPS

MENU/123 > MENU > Réseau > Paramétres réseau

Sile routeur est pourvu d'une touche WPS (configuration de protection du réseau sans fil), vous pouvez I'utiliser
pour connecter automatiquement le téléviseur au routeur.

1. Sélectionnez Sans fil. Le téléviseur affiche automatiquement une liste des réseaux sans fil disponibles.
2. Sélectionnez une Arréter, puis WPS (PBC).

3. Appuyez sur la touche WPS ou PBC sur votre routeur sans fil aprés deux minutes.

4

Le téléviseur se connecte automatiquement au réseau.

Vérification de I'état de la connexion Internet

MENU/123 > MENU > Réseau > Etat du réseau S

REE

Etat du réseau

Paramétres réseau
Wi-Fi Direct

Gestionnaire de périphériques multimédias

Screen Mirroring

Nom de I'appareil Tizen_Device

¢  Selon le modéle de votre téléviseur, le menu affiché peut différer de I'image ci-dessus.

Visualisez I'état actuel du réseau et d'Internet.

Modifier le nom du téléviseur sur un réseau

MENU/123 > MENU > Réseau > Nom de I'appareil ZZLE0

Vous pouvez modifier le nom du téléviseur. Ce nom apparait sur les ordinateurs et les appareils mobiles branchés a
votre réseau.

1. Sélectionnez Nom de I'appareil dans le menu Réseau.

2. Seélectionnez un nom a partir de la liste qui s'affiche. Vous pouvez également sélectionner Entrée util. pour
saisir un nom manuellement.



Résolution de problémes de connectivité a Internet

Résolution de problémes de connectivité cablée a Internet

Aucun cable réseau détecté

vérifiez que le cable réseau est branché. Si c’est le cas, vérifiez que le routeur est sous tension. Si I'appareil est sous
tension, éteignez-le et rallumez-le.

Echec de la configuration automatique de I’adresse IP

Effectuez les étapes suivantes ou configurez le réglage Param. IP manuellement.

1. Veillez a ce que le serveur DHCP soit activé sur le routeur, puis réinitialisez le routeur.

2. Sile probléme persiste, communiquez avec votre fournisseur Internet.

Impossible de se connecter au réseau
1. Veérifiez toutes les valeurs dans Param. IP.
2. Veillez a ce que le serveur DHCP soit activé sur le routeur. Puis, débranchez et rebranchez le routeur.

3. Sila configuration ne fonctionne toujours pas, communiquez avec votre fournisseur Internet.

La connexion au réseau local a été établie, mais impossible de se connecter a Internet
1. Veérifiez que le cable LAN Internet est branché correctement au port LAN externe du routeur.
2. Veérifiez les valeurs DNS dans Param. IP.

3. Sile probléme persiste, communiquez avec votre fournisseur Internet.

La configuration du réseau est terminée, mais impossible de se connecter a Internet

Si le probléme persiste, communiquez avec votre fournisseur Internet.



Résolution de problémes de connectivité sans fil a Internet

La connexion au réseau sans fil a @choué

Si le routeur sans fil sélectionné n'est pas détecté, allez a Paramétres réseau et sélectionnez le routeur adéquat.

Impossible de se connecter au routeur sans fil
1. Veérifiez que le routeur est sous tension. Si c'est le cas, éteignez-le et rallumez-le.

2. Entrezle bon mot de passe, si nécessaire.

Echec de la configuration automatique de I’adresse IP

Effectuez les étapes suivantes ou configurez le réglage Param. IP manuellement.

1. Veillez a ce que le serveur DHCP soit activé sur le routeur. Puis, débranchez et rebranchez le routeur.
2. Entrezle bon mot de passe, si nécessaire.

3. Sile probléme persiste, communiquez avec votre fournisseur Internet.

Impossible de se connecter au réseau
1. Veérifiez toutes les valeurs dans Param. IP.
2. Entrezle bon mot de passe, si nécessaire.

3. Sile probléme persiste, communiquez avec votre fournisseur Internet.

La connexion au réseau local a été établie, mais impossible de se connecter a Internet
1. Veérifiez que le cable LAN Internet est branché correctement au port LAN externe du routeur.
2. Veérifiez les valeurs DNS dans Param. IP.

3. Sile probléme persiste, communiquez avec votre fournisseur Internet.

La configuration du réseau est terminée, mais impossible de se connecter a Internet

Si le probléme persiste, communiquez avec votre fournisseur Internet.



Connexion d'appareils vidéo

Votre téléviseur dispose d'une variété de connexions pour les entrées vidéo provenant d'appareils externes. Voici
une liste de connexions disponibles classées selon une qualité d'image décroissante.

e HDMI
e Composante
e Composite (A/V)

Branchez un appareil vidéo au téléviseur a I'aide d'une connexion HDMI afin d'obtenir la meilleure qualité d'image.
Sil'appareil n'a pas de connexion HDMI, essayez une connexion pour composante.

Connexion a I'aide d'un cable HDMI
Il est recommandé d'utiliser I'un des cables HDMI suivants :

e (Cable HDMI haute vitesse
e Cable HDMI haute vitesse avec Ethernet

Reportez-vous a l'illustration ci-dessous et branchez le cable HDMI a la connexion de sortie HDMI de I'appareil
vidéo et a la connexion d'entrée HDMI du téléviseur.

HDMI IN
(STB)

%



Connexion a l'aide d'un cable pour composante

Reportez-vous a l'illustration ci-dessous et branchez les cables pour composante aux connexions de sortie pour
composante de |'appareil utilisant I'adaptateur AV et aux connexions d'entrée pour composante du téléviseur.
Assurez-vous de raccorder ensemble les connecteurs de méme couleur (rouge avec rouge, bleu avec bleu, etc.).

COMPONENT IN

Connexion a l'aide d'un cable pour composite (A/V)

Reportez-vous a l'illustration ci-dessous et branchez les cables AV aux connexions de sortie AV de 'appareil
vidéo et aux connexions d'entrée AV du téléviseur. Si vous utilisez les connexions AUDIO OUT/COMPONENT IN/
AV IN 1 du boitier One Connect, branchez le cable AV a I'adaptateur (accessoire) AUDIO / COMPONENT / AV et
aux connexions AUDIO OUT/COMPONENT IN/AV IN 1 du boitier One Connect et aux connexions de sortie AV du
téléviseur. Assurez-vous de raccorder ensemble les connecteurs de méme couleur (rouge avec rouge, blanc avec
blanc, jaune avec jaune).




Connexions d'entrée et de sortie audio

Votre téléviseur dispose d'une variété de connecteurs pour les appareils audio externes. Voici une liste des
connexions.

e HDMI/ARC (Audio Return Channel)
e Audio numérique (optique)

e Audio (analogique)

Connexion avec un cable HDMI (ARC)

Le mode ARC (Audio Return Channel) permet la sortie audio numérique du téléviseur vers un appareil audio et
I'entrée audio numérique provenant du méme appareil audio a l'aide d'un seul cable HDMI. Le mode ARC n'est
disponible qu'a partir de la prise HDMI (ARC) et seulement lorsque le téléviseur est branché a un récepteur
audiovisuel prenant en charge la fonction ARC.

Connectez un cable HDMI a la connexion d'entrée HDMI (ARC) du téléviseur et a la connexion de sortie HDMI (ARC
activée) de l'appareil, tel qu'indiqué ci-dessous.

HDMI IN
(ARC)

@7/




Connexion a l'aide d'un cable audio numérique (optique)

Vous pouvez avoir une connexion audio numérique en connectant un récepteur AV au téléviseur par l'intermédiaire
d'un cable audio numérique (optique).

Branchez le cable optique a la connexion de sortie audio du téléviseur et a la connexion d'entrée audio du
récepteur tel qu'indiqué ci-dessous.

DIGITAL
AUDIO OUT
(OPTICAL)

Connexion a l'aide d'un cable audio stéréo

Reportez-vous a l'illustration ci-dessous et branchez un céble audio stéréo a la connexion de sortie audio du
téléviseur et a la connexion d'entrée audio du dispositif.

AUDIO OUT




Connexion a un ordinateur

Voici une liste des connexions que vous pouvez établir.
Pour utiliser le téléviseur comme un écran d'ordinateur

e Branchezle téléviseur au port HDMI a l'aide d'un cable HDMI.
e Branchez-vous au port HDMI (DVI) a l'aide d'un cable HDMI vers DVI.

Pour visualiser ou faire jouer sur le téléviseur le contenu enregistré dans un ordinateur

e Etablir une connexion en utilisant votre réseau domestique

Connexion au moyen du port HDMI
Pour une connexion HDMI, nous recommandons un des types de cables HDMI suivants :

e (Cable HDMI haute vitesse

e Cable HDMI haute vitesse avec Ethernet

Connectez un cable HDMI a la connexion d'entrée HDMI du téléviseur et a la connexion de sortie HDMI de

l'ordinateur, tel qu'indiqué ci-dessous.

HDMI IN
(STB)

%

o Réglez Modifier le type de périphérique a DVI PC pour un ordinateur connecté avec un cable HDMI-DVI et PC pour un
ordinateur connecté avec un cable HDMI. Dong, il faut régler Modifier le type de périphérique a Appareils DVI pour un

appareil A/V connecté avec un cable HDMI-DVI.



Connexion a I'aide d'un cable HDMI-DVI

Si la carte graphique de votre téléviseur ne prend pas en charge l'interface HDMI, connectez |'ordinateur au
téléviseur grace a un cable DVI (Digital Visual Interactive) vers HDMI. Veuillez remarquer que la connexion HDMI
vers DVI est uniquement prise en charge par le port HDMI (DVI), et ne transmet pas le signal audio. Pour entendre le
son provenant de I'ordinateur, branchez les haut-parleurs externes a la connexion de sortie audio de 'ordinateur.

Reportez-vous au diagramme ci-dessous et branchez le cable HDMI vers DVI au port HDMI (DVI) de One Connect
et au port de sortie DVI de 'ordinateur.

HDMI IN
(ovi)

Etablir une connexion en utilisant votre réseau domestique

Vous pouvez accéder rapidement aux fichiers photos, vidéos et de musique enregistrés sur un ordinateur et les lire
sur le téléviseur.

1.

Connectez le téléviseur et I'ordinateur au méme routeur ou point d'acceés. Si vous avez connecté le téléviseur
au réseau pendant la configuration, ce point est réglé.

Sur l'ordinateur, sélectionnez [Panneau de commande] [Réseau et Internet] [Centre Réseau et partage]

[Modifier les paramétres de partage avancés] et sélectionnez [Choisir les options de lecture en continu
multimédia...] pour activer la lecture en continu multimédia.

Dans la liste des appareils disponibles affichés par I'ordinateur, réglez le téléviseur a [Permis].

Pour de plus amples renseignements sur la lecture de contenu, reportez-vous a la section « Lire du contenu multimédia
sur un ordinateur ou un appareil mobile ».



Connexion d'un appareil mobile

Vous pouvez connecter un appareil mobile comme un téléphone intelligent ou une tablette directement au
téléviseur, ou le connecter au réseau et faire afficher I'écran de l'appareil mobile, ou lire son contenu, a l'aide du
téléviseur. Voici une liste des connexions que vous pouvez établir.

e Etablir la connexion a l'aide d'un cable MHL-HDMI et voir I'écran de I'appareil mobile sur le téléviseur.
o Etablir la connexion a 'aide d'une mise en miroir de I'écran de I'appareil sur le téléviseur
o Etablissez une connexion a un appareil mobile sans routeur sans fil (Wi-Fi Direct).

e Connecter un appareil mobile par le biais de Samsung Smart View 2.0

Connexion a l'aide d'un cable MHL-HDMI

Vous pouvez utiliser la fonction Mobile High-Definition Link (MHL) pour afficher sur le téléviseur le contenu affiché
a I'écran d'un appareil mobile. Cependant, la fonction MHL est disponible uniquement par l'intermédiaire du port
HDMI (MHL) du téléviseur et seulement conjointement avec un appareil mobile compatible avec la fonction MHL.
Pour de plus amples renseignements sur la configuration de MHL sur votre appareil mobile, consultez le guide de
l'utilisateur de 'appareil.

¢ Sivous connectez un appareil mobile au téléviseur a I'aide d'un cable MHL-HDMI, le téléviseur commute
automatiquement sur la taille d'image d'origine de tout contenu enregistré sur I'appareil mobile.

Reportez-vous au diagramme ci-dessous et branchez le cable MHL vers HDMI a la connexion d'entrée HDMI (MHL)
du téléviseur et au port USB de I'appareil mobile.

HDMI IN
(MHL)




Utilisation du mode Screen Mirroring
MENU/123 > MENU > Réseau > Screen Mirroring X350

Effectuez la connexion sans fil au téléviseur d'un appareil mobile dont la fonction de mise en miroir de I'écran est
activée, puis procédez a la lecture des fichiers vidéo et audio stockés dans I'appareil sur le téléviseur. La mise en
miroir fait référence a la fonction qui effectue la lecture des fichiers vidéo et audio d'un appareil mobile sur le
téléviseur et I'appareil mobile simultanément.

Connexion par le biais d'un appareil mobile

1.

Lancez la fonction Screen Mirroring a partir de votre appareil mobile. L'appareil mobile recherche les
appareils disponibles auxquels se connecter.

Sélectionnez le téléviseur dans la liste et entrez le mot de passe. Le téléviseur permet automatiquement la
connexion, et le dispositif se connecte.

Sélectionnez Permet. pour connecter l'appareil mobile.

4 . . . g P . ~ .
¢  Tous les appareils mobiles autorisés antérieurement se connecteront automatiquement sans nécessiter
d'approbation.

&  Sivous sélectionnez Bloquer, I'appareil ne pourra pas se connecter. Pour modifier la connexion d'un dispositif
bloqué, sélectionnez MENU > Réseau > Gestionnaire de périphériques multimédias, sélectionnez le dispositif, puis
sélectionnez Permet..

Se connecter automatiquement en permettant les connexions

1.

Vous pouvez également lancer la fonction de mise en miroir en sélectionnant Réseau > Screen Mirroring,
puis en appuyant sur la touche SOURCE sur la télécommande et en sélectionnant Screen Mirroring dans la
liste qui se trouve dans la partie supérieure de I'écran.

Lancez la mise en miroir a partir de votre dispositif mobile. L'appareil mobile recherche les appareils
disponibles auxquels se connecter.

Sélectionnez le téléviseur dans la liste. Le téléviseur permet automatiquement la connexion, et le dispositif se
connecte.

g . . . . . T . .
¢  Sil'appareil mobile ne peut pas se connecter, éteignez le téléviseur et I'appareil mobile et rallumez-les.



Connexion a un appareil mobile sans routeur sans fil (Wi-Fi Direct).
MENU/123 > MENU > Réseau > Wi-Fi Direct ZLFD

Vous pouvez connecter un appareil mobile qui prend en charge la fonction Wi-Fi Direct directement au téléviseur,
sans utiliser un routeur ou un point d'accés sans fil. Aprés avoir connecté un appareil mobile au téléviseur a l'aide de
la fonction Wi-Fi Direct, vous pouvez lire sur le téléviseur des fichiers vidéo, de musique et de photos enregistrés
sur l'appareil mobile.

1.

&%

&

A

Activez la fonction Wi-Fi Direct sur l'appareil mobile, et ensuite exécutez la fonction Wi-Fi Direct sur le

téléviseur. Le téléviseur recherche automatiquement la liste des appareils disponibles et |'affiche. Le nom du
téléviseur s'affiche également sur I'appareil mobile.

Sélectionnez 'appareil dans la liste pour effectuer la connexion. Si une demande de connexion est faite par le
téléviseur, un message d'autorisation s'affiche sur I'appareil mobile et vice-versa.

Acceptez la connexion. Une connexion s'établit entre le téléviseur et I'appareil mobile.

Pour plus d'information, reportez-vous a la section « Lire du contenu multimédia sur un ordinateur ou un appareil mobile
».

Pour confirmer si un appareil mobile autorise ou refuse une connexion, sélectionnez MENU > Réseau > Gestionnaire de
périphériques multimédias.

Pour faciliter la connexion, activez la fonction Wi-Fi Direct sur le téléviseur et I'appareil mobile, puis placez ce dernier
a proximité du téléviseur. La fenétre de confirmation de l'autorisation de connexion s'affiche dans le bas a gauche de
I'écran du téléviseur afin que vous puissiez facilement connecter I'appareil.

Gérer le statut de connexion d'appareils mobiles que vous avez déja connectés

1.

w0 N

.

Sélectionnez MENU > Réseau > Gestionnaire de périphériques multimédias. Le téléviseur affiche une liste

des appareils que vous avez connectés au téléviseur auparavant, ou dont la connexion au téléviseur a déja
été bloquée. L'état de la connexion est également affiché (Permettre/Bloquer).

Sélectionnez un appareil.

Sélectionnez le type de connexion ou supprimez |'appareil de la liste.

Cette fonction est uniquement disponible si vous avez déja connecté des appareils au téléviseur, ou si vous avez fait une
tentative qui a été bloquée.

Connecter un appareil mobile par le biais de Samsung Smart View 2.0

Lorsque vous installez Samsung Smart View 2.0 sur un appareil mobile connecté au téléviseur et activez ce mode,
vous pouvez faire jouer le contenu multimédia de ce dernier, comme des vidéos, des photos et des fichiers de
musique sur le téléviseur. Il vous est également possible d'envoyer des textos et de commander votre téléviseur a
partir de I'appareil mobile.



Commuter entre des appareils externes connectés au
téléviseur

Appuyez sur la touche SOURCE pour basculer d'un appareil externe branché au téléviseur a un autre.

&%

Options

Pour accéder au menu Options, appuyez sur la touche directionnelle vers le bas. Voici les fonctions qui
peuvent figurer au menu Options :

V4

Les noms des connecteurs peuvent varier selon le modéle.

Modifier le type de périphérique : Permet de changer le type d'appareil externe connecté au téléviseur.
Sélectionnez I'appareil externe qui doit étre changé. Par exemple, vous pouvez sélectionner la
dénomination PC pour un ordinateur branché a la connexion HDMI et Blu-ray pour un lecteur Blu-ray
branché a une autre connexion HDMI. Lorsque vous affichez la liste source, le téléviseur affiche le nom
de toutes les connexions et le type de l'appareil branché a chaque connexion.

Entrer le nom : permet de renommer des appareils branchés au téléviseur pour identifier facilement les
sources externes.

Information : permet d'afficher de l'information détaillée sur les appareils branchés.

Anynet+ (HDMI-CEC) : permet d'afficher une liste des appareils compatibles avec la fonction Anynet+
(HDMI-CEC) branchés au téléviseur.

& Cette option n'est disponible que lorsque la fonction Anynet+ (HDMI-CEC) est réglée a Activer.
Retirer I’appareil USB : permet de retirer un dispositif USB branché au téléviseur.

Supprimer la miniature de la source : permet de retirer les saisies d'images de la vidéo que vous avez vue
le plus récemment et enregistrées dans un appareil externe branché au téléviseur.

Supprimer la télécommande universelle : permet de supprimer |'appareil externe branché au téléviseur a
l'aide de la télécommande universelle.

Conf. téléc. universelle

Vous pouvez utiliser la télécommande du téléviseur pour commander les appareils externes.

Pour de plus amples renseignements sur l'utilisation de la télécommande universelle, reportez-vous a la section «
Commande des appareils externes avec la télécommande — Utilisation de la télécommande universelle ».



Information en ce qui concerne les connexions

> . . . . N sz
¢ Lenombre de connecteurs ainsi que leurs noms et emplacements peuvent varier en fonction du modéle du téléviseur.

> . ™ . . L1z e
¢  Reportez-vous au guide d'utilisation de 'appareil externe pour son branchement au téléviseur. Le nombre de
connecteurs ainsi que leurs noms et emplacements peuvent varier en fonction du fabricant.

Information en ce qui concerne la connexion HDMI

e Utiliser un cable HDMI d'une épaisseur de 14 mm (0,55 po) ou moins.
e L'utilisation d'un cable HDMI non-certifié peut causer une absence d'image ou une erreur de connexion.

e Certains cables et appareils HDMI peuvent ne pas étre compatibles avec le téléviseur en raison de
spécifications HDMI différentes.

e Ce téléviseur ne prend pas en charge le canal Ethernet HDMI. Ethernet est un réseau local (LAN) formé de
cables coaxiaux respectant la norme IEEE.

e Pour obtenir la qualité visuelle optimale en UHD, utilisez un cable dont la longueur est inférieure 8 3 m (10
pi).
e Beaucoup d'adaptateurs graphiques n'ont pas de ports HDMI, mais des ports DVI. Si votre adaptateur

graphique a un port DVI, connectez |'ordinateur au téléviseur a l'aide d'un cable HDMI-DVI.

¢  Pour plus d'information, reportez-vous a la section « Connexion a l'aide d'un cable HDMI-DVI ».

e Sivous utilisez un adaptateur HDMI pour connecter un appareil MHL, le téléviseur reconnait le signal comme
un signal HDMI et peut répondre différemment que si vous utilisiez un cable MHL-HDMI.

e Certaines fonctions comme Smart Hub peuvent ne pas étre disponibles si la Source est réglée a HDMI et
que Affichage 3D auto est réglé a Auto1 ou Auto2. Si c'est le cas, réglez Affichage 3D auto ou Mode 3D a
Désactiver.



Etablir une connexion a un appareil audio

Il est recommandé d'utiliser un récepteur AV pour obtenir une meilleure qualité audio.

Le branchement de I'appareil a I'aide d'un cable optique n'éteint pas automatiquement les haut-parleurs du
téléviseur. Pour désactiver les haut-parleurs du téléviseur, réglez Liste des haut-parleurs (MENU/123 >
Liste des haut-parleurs ) a un autre élément que les haut-parleurs du téléviseur.

f Sur la télécommande standard, appuyez sur la touche TOOLS, et sélectionnez I'option Liste des haut-parleurs. Ou,

ajustez le volume, et ensuite appuyez sur la touche .

Un bruit inhabituel venant de I'appareil audio en cours d'utilisation peut indiquer un probléme avec 'appareil
audio lui-méme. Si cela se produit, demandez de l'aide au fabricant de I'appareil audio.

L'audio numérique est disponible seulement avec les diffusions a canaux 5.1.

Information en ce qui concerne la connexion a un ordinateur

Pour connaitre les formats de résolutions pris en charge, reportez-vous a la section « Instructions a lire
avant de procéder a la connexion d'un ordinateur (résolutions prises en charge) ».

Si le partage de fichiers est activé, des accés non autorisés peuvent se produire. Si vous n'avez pas besoin
d'accéder a des données, désactivez le partage de fichiers.

Votre ordinateur et votre téléviseur intelligent doivent étre connectés ensemble sur le méme réseau.

Information en ce qui concerne la connexion a des appareils mobiles

Pour utiliser la fonction de Recopie d'écran, I'appareil mobile doit prendre en charge une fonction de mise en
miroir telle que AllShare Cast ou Recopie d'écran. Pour vérifier si votre appareil mobile prend en charge la
fonction de mise en miroir, veuillez visiter le site Web du fabricant de I'appareil mobile.

Pour utiliser Wi-Fi Direct, I'appareil mobile doit prendre en charge la fonction Wi-Fi. Veuillez vérifier si votre
appareil mobile prend en charge la fonction Wi-Fi Direct.

L'appareil mobile et votre téléviseur intelligent doivent étre connectés I'un a l'autre sur le méme réseau.

L'image ou le son pourrait s'interrompre par intermittence selon I'état du réseau.



Au sujet de la télécommande Samsung Smart Control

SMART HUIE

SAMSUNG




Touche

4 /cc

MENU/123

POINTER

4 touches directionnelles

Touche Enter

RETURN / EXIT

>
<>
(Al

EXTRA

SOURCE

Description

Cette touche permet de désactiver temporairement le son.

Appuyez sur cette touche et maintenez la pression pour que s'affiche le menu Raccourcis
d'accessibilité qui permet d'activer ou désactiver les fonctions du menu Accessibilité (MENU
> Systéme > Accessibilité).

Affiche a I'écran les touches numériques, la touche de commande du contenu et d'autres

touches de fonction de maniére a pouvoir exécuter une fonction en toute convivialité.

Appuyez sur cette touche et maintenez la pression pour exécuter la fonction de

reconnaissance vocale.

¢ Pour plus d'information, reportez-vous a la section « Affichage et utilisation de la
télécommande a l'écran ».

Placez un doigt sur la touche POINTER puis effectuez un mouvement avec la

télécommande Samsung Smart Control. Le pointeur a |'écran se déplace dans la méme

direction que la télécommande Samsung Smart Control. Appuyez sur la touche POINTER

pour sélectionner ou exécuter |'élément saisi.

¢ Pour plus d'information, reportez-vous a la section « Faire fonctionner le téléviseur a
I'aide de la touche POINTER ».

Permet de déplacer la cible de saisie et de modifier les valeurs affichées dans le menu du
téléviseur.

Permet de sélectionner ou d'exécuter un élément ciblé.
Appuyez sur cette touche en maintenant la pression pour lancer le Guide pendant que vous
regardez la télévision.

Permet de revenir au menu précédent ou a la chaine précédente.
Appuyez sur cette touche et maintenez la pression pour quitter la fonction en cours
d'exécution a I'écran du téléviseur.

Lance les applications Smart Hub

Permet de controler le contenu lorsque vous regardez une vidéo ou des photos ou écoutez
de la musique.

Permet d'afficher de l'information détaillée sur I'émission en cours.

Permet d'afficher et de sélectionner les sources vidéo disponibles.

¢  Votre télecommande Samsung Smart Control peut étre différente des illustrations représentant la Samsung Smart
Control dans ce guide électronique, den fonction du modeéle.

N

Utilisez la télécommande Samsung Smart Touch Control a une distance inférieure & 6m (20 pieds). La distance

d'utilisation appropriée peut varier en fonction des conditions de I'environnement sans fil.

&

Les touches et les fonctions de la télécommande Samsung Smart Control peuvent varier selon le modéle.



Utilisation de la télécommande Samsung Smart Control

Faire fonctionner le téléviseur a lI'aide de la touche POINTER

Placez un doigt sur la touche POINTER puis effectuez un mouvement avec la télécommande Samsung Smart
Control. Le pointeur a I'écran se déplace dans la méme direction que la télécommande Samsung Smart Control.
Déplacez le pointeur pour sélectionner un élément a I'écran.

POINTER

-

Commander le téléviseur a I'aide des touches directionnelles et de la touche
Enter

Appuyez sur les touches directionnelles (haut, bas, gauche, droite) pour déplacer la cible de saisie, le pointeur ou

le curseur dans la direction voulue ou modifier un réglage appliqué a I'élément ciblé. Appuyez sur la touche Enter
pour sélectionner ou exécuter I'élément saisi. Appuyez sur la touche Enter et maintenez la pression pour consulter
le Guide pendant que vous regardez la télévision.

¢  Pour ajuster la vitesse de déplacement du pointeur, sélectionnez MENU > Systéme > Paramétres Smart Control >

Sensibilité aux mouvements. lm

¢ Pour utiliser la POINTER et faire fonctionner le téléviseur en effectuant des mouvements avec la télécommande, la
fonction, Guide vocal doit étre réglé a Désactiver.
¢  Pour avoir un tutoriel qui montre comment utiliser la touche POINTER, sélectionnez MENU > Support technique >

Didacticiel Smart Control. lm



Affichage et utilisation de la télécommande a I'écran

Vous pouvez afficher et utiliser la télécommande a I'écran du téléviseur en appuyant sur la touche MENU/123 de la
télécommande Samsung Smart Control.

Touche

Menu

Reconnaissance vocale

Image Format
Sous-titres
Parameétres réseau
3D

Info

Guide

Liste des chaines

Multi-Link Screen

Mode Sports ou Mode
Soccer

Description

Permet d'afficher le menu a I’écran.
Permet d'exécuter la fonction de reconnaissance vocale.
> . . N . o <wp e

@ Pour plus d'information, reportez-vous a la section « Instructions a lire avant d'utiliser
a commande vocale, la commande gestuelle ou la reconnaissance faciale ».
I d le, | d tuell I facial

Permet de changer la taille de 'image.

Permet d'activer ou de désactiver les sous-titres.

Affiche les écrans qui vous permettent de modifier les paramétres de réseau.

Permet d'activer ou de désactiver la fonction 3D.

Affiche de l'information au sujet du programme ou du contenu en cours.

Permet que s'affiche I'écran Guide.

Permet de lancer la Liste des chaines.

Permet de diviser I'écran du téléviseur et d'utiliser de multiples fonctions, comme regarder
la télévision, surfer sur le Web et jouer a un jeu vidéo, simultanément.

g . . < . . z A .
@ Pour plus d'information, reportez-vous a la section « Afficher plus d'un écran a l'aide du
mode Ecran a plusieurs sources ».

Permet d'activer et de désactiver le mode Sport.
¢ Le nom courant peut différer selon les zones géographiques.

4 . N . pr————
@ Pour de plus amples renseignements, reportez-vous a la section « Rendez vos émissions
sportives plus réalistes avec le mode Mode Sports ».



Touche

Extra
e-Manual
Image Mode

Liste des haut-parleurs
MTS

Mise en veille
Outils
Source

Alimentation

NE B

Déplacer le pavé numérique
a droite / Déplacer le pavé
numeérique a gauche

Description

Permet d'afficher de l'information détaillée sur I'émission en cours.

Permet d'ouvrir le Guide électronique.

Permet de modifier le mode d'affichage.

Permet de sélectionner les haut-parleurs qui diffuseront le son du téléviseur.

Vous permet de passer le mode de diffusion audio a stéréo, mono ou SAP (seconde piste
audio) pour les chaines analogiques.

Permet au téléviseur de se mettre automatiquement hors tension aprés le délai choisi.
Permet d'afficher le menu Outils a I’écran.

Permet que s'affiche I'écran Source.

Permet de mettre le téléviseur hors tension.

Utilisez ces touches de couleur pour accéder a des options supplémentaires propres a la
fonction utilisée.

Cette touche est disponible uniquement aux Etats-Unis et au Canada.

Permet de déplacer le pavé numérique vers la gauche ou la droite.

Les touches de télécommande a I'écran peuvent varier en fonction du modéle de téléviseur et des fonctions que vous

utilisez.

Pour changer 'ordre des options de menu dans la premiére rangée, sélectionnez une option de menu a déplacer, appuyez
sur la touche Enter et maintenez la pression; ensuite, sélectionnez les touches directionnelles pour spécifier un nouvel

emplacement.

Exécution du pairage entre le téléviseur et Samsung Smart Control

Lorsque vous mettez le téléviseur sous tension pour la premiére fois, il est automatiquement apparié avecla
télécommande Samsung Smart Control. Si l'appariement de la télécommande Samsung Smart Control avec le
téléviseur ne se fait pas automatiquement, pointez-la vers le capteur du téléviseur, ensuite appuyez simultanément
sur les touches (D et 2) indiquées dans le diagramme pendant 3 secondes au minimum.




Commande des appareils externes avec la télécommande -
Utilisation de la télécommande universelle

MENU/123 > MENU > Systéme > Config. télécommande universelle ZLFT

Vous pouvez commander les appareils externes branchés au téléviseur a l'aide de la télécommande du téléviseur.

4

A

Vous pouvez utiliser la fonction Anynet+ (HDMI-CEC) pour faire fonctionner les appareils externes Samsung a l'aide de
la télécommande du téléviseur et sans faire de réglages additionnels. Reportez-vous a la section « Utilisation du mode
Anynet+ (HDMI-CEC) » pour plus d'information.

Certains appareils externes branchés au téléviseur pourraient ne pas prendre en charge la fonction de la télécommande
universelle.

Configuration de la télécommande universelle

1.

b

A

Branchez au port HDMI du boitier One Connect I'appareil externe a commander avec la télécommande
universelle et mettez ce dernier sous tension.

Appuyez sur la touche SOURCE de la télécommande pour afficher I'écran Source.

Sélectionnez Conf. téléc. universelle a I'écran Source, et suivez les instructions a I'écran pour effectuer la

configuration et enregistrer le dispositif. Les instructions différent en fonction de I'appareil que vous voulez
configurer.

Si apreés avoir enregistré |'appareil externe, celui-ci ne répond pas, enregistrez-le de nouveau a l'aide de son numéro de
modéle.

Le téléviseur mémorise a la fois I'appareil externe et la connexion (HDMI 1, HDMI 2, etc.) a laquelle I'appareil est branché.



Commander le téléviseur a lI'aide d'un clavier

MENU/123 > MENU > Systéme > Gest. périph. > Réglages du clavier ZHETD

¢  Certains modéles ne prennent pas en charge les claviers de classe USB HID.

Branchement d'un clavier

Branchement d'un clavier USB

Branchez le cable du clavier dans le port USB du boitier One Connect.

Branchement d'un clavier Bluetooth
1. Mettez le clavier Bluetooth en mode de veille.

2. Sélectionnez MENU » Systéme > Gest. périph. > Réglages du clavier > Ajouter un clavier Bluetooth. Le
téléviseur effectue automatiquement un balayage afin de détecter les claviers disponibles. lm

> . P . . . N e . . . P e
@  Siletéléviseur ne détecte pas votre clavier, déplacez-le prés du téléviseur, puis sélectionnez Rafraichir. Le téléviseur
effectue un nouveau balayage afin de détecter les claviers disponibles.

3. Sélectionnez le clavier Bluetooth dans la liste, et ensuite Associer et connecter. Un chiffre s’affiche Sa I’écran.

4. Entrezle nombre grace au clavier Bluetooth. Cela conclut le pairage du clavier Bluetooth et du téléviseur.



Utilisation du clavier

Vous pouvez utiliser les touches suivantes sur un clavier USB ou Bluetooth branché au téléviseur afin de pouvoir
commander les fonctions suivantes de la télécommande.

Clavier Fonctions de la télécommande
Touches directionnelles Déplace de la cible de saisie
Touche Windows Affiche le menu

Touche de liste des touches - ix <z
Permet d'afficher la télécommande a I'écran

du menu

Touche Enter Permet de sélectionner ou d'exécuter un élément ciblé.
Touche ESC Retourne a 'écran précédent.
TouchesF1/F2/F3/F4 N/E/ /D)

Touche F5 Lance la touche §

Touche F6 Affiche I'écran Source.

Touche F7 Permet de lancer la Liste des chaines.

Touche F8 Coupe le son

TouchesF9/F10 Permet de régler le volume

TouchesF11/F12 Permet de changer de chaine

Changer les réglages du clavier
MENU/123 > MENU > Systéme > Gest. périph. > Réglages du clavier > Options de clavier TP
e Langue du clavier
Affiche les langues que vous pouvez sélectionner pour le clavier et vous permet d'en sélectionner une.
e Type de clavier

Affiche une liste de types de claviers et vous permet d'en sélectionner un qui correspond a la langue
sélectionnée.

¢ Laliste des types de claviers différe en fonction de la langue que vous avez sélectionnée sous Langue du clavier.
e Changer langue saisie

Affiche une liste des touches que vous pouvez utiliser pour changer de langue, et vous permet d'en
sélectionner une.



Commander le téléviseur a lI'aide d'une souris

MENU/123 > MENU > Systéme > Gest. périph. > Réglages de souris SR

¢  Certains modéles ne prennent pas en charge les souris de classe USB HID.

Branchement d'une souris

Branchement d'une souris USB

Branchez le cable de la souris dans le port USB du boitier One Connect.

Branchement d'une souris Bluetooth
1. Placez la souris Bluetooth en mode veille.
2. MENU > Systéme > Gest. périph. > Réglages de souris > Aj. souris Bluetooth ZZHLEID

3. Seélectionnez la souris Bluetooth a partir de la liste puis sélectionnez Associer et connecter. La connexion
entre la souris Bluetooth et le téléviseur s'établira.

Utilisation d'une souris

Vous pouvez utiliser ce pointeur pour commander le téléviseur, exactement comme vous le feriez sur un
ordinateur.

e Sélection et exécution d'un élément
Cliquez a gauche sur la souris.
o Défilement du menu ou de I'écran du téléviseur
Tournez la molette de la souris vers le haut ou le bas.
e Quitter le menu ou la fonction du téléviseur

Placez le pointeur sur un point blanc a I'écran, puis faites un clic gauche avec la souris.



Modifier les touches de la souris et la vitesse du pointeur
MENU/123 > MENU > Systéme > Gest. périph. > Réglages de souris > Options souris ZLE
e Bouton principal
Sélectionnez la touche (gauche ou droite) a utiliser pour sélectionner et exécuter les options.
e Vitess pointeur

Ajuster la vitesse de déplacement du pointeur.

Branchement d'une console de jeux Bluetooth

MENU/123 > MENU > Systéme > Gest. périph. > Paramétres de la manette Bluetooth

Vous pouvez jouer aux jeux téléchargés et installés en utilisant le service Smart Hub a 'aide d'une console
Bluetooth. Sélectionnez Paramétres de la manette Bluetooth, et ensuite placez votre console de jeux Bluetooth
prés du téléviseur. Le téléviseur effectue automatiquement un balayage afin de détecter les consoles de jeux
Bluetooth disponibles. (Nous recommandons d'utiliser la console DualShock®4 qui est optimisée pour les
PlayStation.) Une fois le balayage terminé, vous pouvez utiliser la console de jeux Bluetooth pour jouer.

¢ Sile téléviseur ne détecte pas la console de jeux Bluetooth, placez-la prés du téléviseur, et ensuite sélectionnez
Rafraichir. Pour en savoir davantage sur le pairage, reportez-vous au guide d'utilisation de la console de jeux Bluetooth.

Saisir du texte a l'aide du clavier QWERTY a I'écran

Utilisation de fonctions supplémentaires

Sélectionnez O al'écran du clavier QWERTY. Les options suivantes sont disponibles :
e Texte recommandé

Permet d'activer ou désactiver la fonction de Texte recommandé. Le clavier affiche les mots recommandés
de sorte que vous puissiez saisir le texte plus facilement.

e Restaurer les données texte recommandées
Supprime les mots recommandés et les mots mémorisés pour vider la liste.

e Prédire le prochain caractére (lorsque vous utilisez les boutons de direction)
Permet d'activer ou désactiver la fonction de prédiction textuelle.

e Langue

Permet de sélectionner une langue a partir de la liste.



Afficher plus d'un écran a I'aide du mode Ecran a plusieurs
sources

MENU/123 > MENU > Image > Ouvrir Multi-Link Screen

Vous pouvez ainsi faire des recherches sur le Web, utiliser des applications et en faire bien plus tout en regardant
une émission.

Utilisation du mode Multi-Link Screen

Apprendre les fonctions de base

e Changer la chaine et le volume d'un écran a plusieurs sources

Pour changer les chaines en mode Ecran a plusieurs sources, appuyez sur les touches de chaine pendant que
vous regardez la télévision. Pour ajuster le volume d'un mode écran a plusieurs sources, allez a I'écran pour
ajuster le volume, et ensuite appuyez sur les touches de volume.

e Changer le signal d'entrée

Appuyez sur la touche SOURCE pendant que vous utilisez le mode Ecran a plusieurs sources pour afficher
la liste source. Sélectionnez une source de signal dans la liste. Vous pouvez voir I'écran de I'appareil externe
pendant que vous regardez la télévision.

e Changer les navigateurs et les applications

Pendant que vous utilisez un Multi-Link Screen, les applications ou navigateurs utilisés récemment sont
affichés dans le coin droit de I'écran. Vous pouvez changer ces pages ou ces applications lorsque vous
utilisez le navigateur ou les applications sous Smart Hub.

e Changer la taille d'un écran a plusieurs sources

Pour changer la taille d'un écran a plusieurs sources, déplacez la cible de saisie de I'écran que vous souhaitez
redimensionner, et ensuite utilisez les fleches directionnelles vers le haut et vers le bas. Vous pouvez
également déplacer la ligne située au milieu de I'écran vers la gauche ou vers la droite. Pour afficher en mode

plein écran I'écran a plusieurs sources, sélectionnez .
e Sélectionner un haut-parleur pour un écran a plusieurs sources

Sélectionnez MENU/123 > Liste des haut-parleurs > Haut-parleurs Multi-Link Screen pour régler le haut-
parleur de chaque écran.

¢ Surlatélécommande standard, appuyez sur la touche TOOLS, et sélectionnez l'option Liste des haut-parleurs. Ou,
ajustez le volume, et ensuite appuyez sur la touche .



A lire avant d'utiliser le mode Ecran a plusieurs sources

¢  Avant d'utiliser le mode Multi-Link Screen, assurez-vous que le téléviseur est connecté a Internet.

¢ Avant d'utiliser Smart Hub avec le mode Multi-Link Screen, assurez-vous d'avoir terminé la configuration de Smart Hub.

& linest pas possible de visualiser simultanément des chaines et des contenus en résolution UHD.

& lise peut que la fonction Multi-Link Screen ne prenne pas en charge certaines options du téléviseur et certaines
applications. Dans ce cas, quittez la fonction Multi-Link Screen et utilisez |'option en question.

¢ Vous pouvez entendre le mode son sélectionné lorsque vous utilisez I'option Multi-Link Screen par le biais des haut-

parleurs du téléviseur et vous pouvez entendre le son de |'autre écran avec les dispositifs Bluetooth.

Smart Hub

$ ouMENU/123 > MENU > Smart Hub > Ouvrir Smart Hub & D

Récents En vedette

o B o = B

GAMES Recherche = YouTube Tuneln Vimeo YuppTV [AcculWeat:: MY CONj

APPS

4 L'image peut différer selon le modéle et la zone géographique.

Avec Smart Hub, vous pouvez naviguer sur le Web et télécharger des applications. De plus, vous pouvez visualiser
des photos, regarder des vidéos et écouter de la musique stockés sur des appareils externes.

Placez un doigt sur la touche POINTER pour afficher le pointeur a I'écran. Sélectionnez @ au bas de I'écran pour
lancer le mode Smart Hub.

Lorsque vous lancez le mode Smart Hub, vous pouvez faire une liste des applications ou caractéristiques
récemment utilisées ou les effacer. Vous pouvez également établir un élément en tant que favori. Pour supprimer
toutes les applications en cours d'exécution, sélectionnez Clear Recent Items. Les éléments de la liste de favoris ne
seront pas supprimés.

> . e . . ~ A~ 3
@  Pour exécuter Smart Hub pendant que vous utilisez un service fourni par Smart Hub, procédez de la méme maniére que
celle décrite ci-dessus.



Retirer ou marquer un élément dans le groupe Récent

Pour retirer ou épingler un élément dans le groupe Récents, sélectionnez @ qui apparait au-dessus de I'élément.
Les icOnes suivantes sont disponibles.

¢ Surlatéléecommande standard, appuyez sur la touche A,

° : permet de supprimer I'élément. Bien que vous ayez retiré un élément du groupe Récents, il n'est pas
retiré du téléviseur.

° @ : permet d'épingler 'élément dans la premiére position. Pour désépingler I'élément, sélectionnez de
nouveau ¥g.

o @ : exécute |'élément dans plusieurs écrans avec la fonction Ecran a plusieurs sources. (MENU/123 >
MENU > Image > Ouvrir Multi-Link Screen)

¢ Licone peut ne pas s'afficher en fonction de I'élément.

Lancement automatique de Smart Hub
MENU/123 > MENU > Smart Hub > Paramétres d'autodémarrage > Smart Hub

Vous pouvez démarrer automatiquement le mode Smart Hub lorsque vous mettez le téléviseur sous tension.

Essai des connexion Smart Hub
MENU/123 > MENU > Support technique > Autodiagnostic > Test de connexion a Smart Hub

Sile Smart Hub ne fonctionne pas, sélectionnez Test de connexion a Smart Hub. L'essai de connexion diagnostique
le probléme en vérifiant la connexion Internet, votre fournisseur d'accés Internet, le serveur Samsung et le service
d'applications.



Utilisation du tutoriel Smart Hub
MENU/123 > MENU > Support technique > Didacticiel Smart Hub

Vous pouvez apprendre en détail les fonctions de base de Smart Hub et de son service.

Réinitialiser Smart Hub
MENU/123 > MENU > Smart Hub > Réinitialiser Smart Hub ZRLETD

Vous pouvez supprimer les comptes Samsung enregistrés dans le téléviseur et tout ce qui est associé a ces
comptes, incluant les applications.

4
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Certains des services Smart Hub sont des services payants a la carte. Pour utiliser un service a la carte, vous devez avoir
un compte aupreés d'un fournisseur de services, ou encore un compte Samsung. Pour plus d'information, reportez-vous a
la section « Utilisation du mode Smart Hub par l'intermédiaire d'un Compte Samsung ».

Pour utiliser la fonction Smart Hub, votre téléviseur doit étre connecté a Internet.

Il est possible que certaines fonctions de Smart Hub ne soient pas disponibles en fonction du fournisseur de service, de la
langue ou de la région.

Les interruptions de service de Smart Hub peuvent &tre causés par des interruptions de votre service Internet.

Pour utiliser Smart Hub, vous devez accepter le contrat d'utilisation et la politique de confidentialité. Si vous ne le faites
pas, vous n'aurez pas acceés aux fonctions et aux services associés a ces documents. Vous pouvez voir I'ensemble du texte
des Conditions et politique en vous rendant Smart Hub > Conditions et politique. Si vous désirez cesser d'utiliser Smart

Hub, vous pouvez résilier l'entente. ZZRLES

Pour voir l'option Didacticiel Smart Hub, sélectionnez la touche [¥2 a ['écran Récents.



Utilisation du mode Smart Hub par l'intermédiaire d'un Compte
Samsung

Création d'un compte Samsung
MENU/123 > MENU > Smart Hub > Compte Samsung

Certains des services Smart Hub sont des services payants a la carte. Pour utiliser un service a la carte, vous devez
avoir un compte aupreés d'un fournisseur de services, ou encore un compte Samsung.

Vous pouvez créer un compte Samsung en utilisant votre adresse de courriel comme nom d'utilisateur.

¢ Vous devez accepter le contrat d'utilisation et la politique de confidentialité pour créer un compte Samsung. Pour
consulter le contenu complet de I'entente, sélectionnez MENU > Smart Hub > Compte Samsung > Conditions et
confidentialité.

A

Vous pouvez également créer un compte Samsung au http://content.samsung.com. Une fois votre compte créé, vous
pouvez utiliser le méme nom d'utilisateur sur votre téléviseur et sur le site Web de Samsung.

Création d'un compte Samsung

MENU/123 > MENU > Smart Hub > Compte Samsung > Créer compte > Créer un compte Samsung

Vous pouvez créer un compte Samsung en suivant les directives a I'écran. Une fois votre compte Samsung créé,
une séance s'ouvre automatiquement sous ce compte.

D . . . o . . . a4
¢  Sivous souhaitez relire les conditions, sélectionnez Afficher les détails.

¢  Sivous souhaitez que votre compte soit protégé, sélectionnez Sélection d’image de profil et protection par mot de passe
(sécurité élevée) dans le champ sous celui du mot de passe.

> . R . N e
@  Sivous voulez que votre téléviseur se connecte automatiquement a votre compte lorsque vous mettez le téléviseur sous
tension, cliquez sur Connecter automatiquement.

Créer un compte Samsung a partir d'un compte Facebook

MENU/123 > MENU > Smart Hub > Compte Samsung > Créer un compte Samsung avec Facebook

Pour terminer la configuration du compte, saisissez votre nom d'utilisateur et votre mot de passe Facebook, puis
suivez les directives a I'écran. Une fois votre compte Samsung créé, une séance s'ouvre automatiquement sous ce
compte.

& Les comptes Samsung et Facebook sont automatiquement liés lorsque vous créez un compte Samsung a partir de votre
compte Facebook.



Se connecter a un compte Samsung
MENU/123 > MENU > Smart Hub > Compte Samsung > Connexion

Vous pouvez automatiquement ouvrir une session dans votre compte Samsung et utiliser la fonction Smart Hub.

Enregistrer un compte Samsung existant sur le téléviseur

Si vous possédez déja un compte Samsung, vous pouvez enregistrer ce compte pour votre téléviseur. Sélectionnez
+ > Connexion a |'écran de votre compte Samsung, puis suivez les directives a I'écran..

Se connecter a un compte Samsung enregistré et sauvegardé sur le téléviseur

Si vous enregistrez un compte Samsung, il est sauvegardé sur le téléviseur. Pour vous connecter a un compte
Samsung enregistré, il vous suffit de le sélectionner au téléviseur.

> g . . N . . . N
¢  Pour modifier la méthode d'ouverture de session, reportez-vous a la section « Ajouter des renseignements a un compte
Samsung, ou les modifier ».

Lier votre compte Samsung a des comptes de services externes

LOFSC|UE vous liez votre compte Samsung ades comptes de services externes, vous pouvez vous connecter
automatiquement aces comptes en vous connectant avotre compte Samsung.

> m . . . .
¢ Pour utiliser Lier des comptes de service, vous devez d'abord ouvrir une session dans votre compte Samsung.

Créer un lien a un compte de service ou le briser
MENU/123 > MENU > Smart Hub > Compte Samsung > Lier des comptes de service
e Lier un compte de service

Sélectionnez un compte dans la liste et ouvrir une session en suivant les directives a I'écran. Le compte de
service est ainsi li€ au compte Samsung.

e Déconnexion d'un compte lié

Sélectionnez un compte dans la liste et briser le lien en suivant les directives a I'écran.



Ajouter des renseignements a un compte Samsung, ou les modifier
MENU/123 > MENU > Smart Hub > Compte Samsung > Modifier profil

Vous pouvez gérer votre compte Samsung. Entrez votre mot de passe a l'aide du clavier affiché a I'écran, puis
sélectionnez Fait. Vous pouvez exécuter les fonctions suivantes a I'écran.

¢ Pour modifier les renseignements sur votre compte, vous devez vous connecter a votre compte Samsung.
e Modifier votre image de profil
e Enregistrez votre visage dans votre compte Samsung
Les visages enregistrés sont utilisés dans les Login Options.
e Sélectionnez une méthode d'ouverture de session dans votre compte Samsung
e Activer ou désactiver I'ouverture de session automatique
e Entrer les renseignements de base sur I'utilisateur

e S'abonner au bulletin Samsung

Supprimer un compte Samsung du téléviseur
MENU/123 > MENU > Smart Hub > Compte Samsung > Supprimer comptes téléviseur

Vous pouvez supprimer de votre téléviseur tous les renseignements et mots de passe associés a un compte
Samsung. Les données associées au compte pour tout compte externe lié au compte Samsung sont également
supprimées.

g . . A
& Pour retirer les renseignements sur votre compte, vous devez vous connecter a votre compte Samsung.



Utilisation du service GAMES

@ > Envedette > GAMES

GAMES

Mapage - sLes plus populairess  Nouveautés . Arcade/action - Sports/course - Féte/musique

Tendances Jeux de stratégie et de tir
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Vous pouvez télécharger, installer et gérer des jeux ou des jeux achetés via votre compte Samsung et y jouer.
Sélectionnez un jeu affiché a I'écran ou sélectionnez une catégorie de genre, comme En vedette, Les plus
populaires, Nouveautés en haut de I'écran, puis sélectionnez un jeu dans le genre que vous avez sélectionné. Vous
pouvez également gérer les jeux téléchargés sous Ma page.

Cette fonction n'est pas disponible sur certains modéles dans certaines zones géographiques particuliéres.
Pour utiliser cette fonction, votre téléviseur doit étre connecté a Internet.

Les catégories de genres affichées en haut de I'écran peuvent varier selon le modéle et les zones géographiques.

Gérer les jeux a partir du menu contextuel Options

Déplacez la cible de saisie sur un jeu, puis appuyez sur la touche Enter et maintenez la pression. Un menu affiche
alors toutes les options ou certaines des options suivantes.

e Télécharger / Supprimer

e Lecture

e Annuler

e Achats dans les applications
e Afficher les détails

e Miseajour

Le menu contextuel peut varier selon les applications.

Affichage de I'écran Information détaillée

Déplacez la cible de saisie sur un jeu, puis appuyez sur la touche Enter. Vous pouvez également sélectionner la
fonction Voir détails. Voir ci-dessus.



Installer et exécuter un jeu

Installation de jeux
Sélectionnez un jeu a installer, puis appuyez sur la touche Enter et maintenez la pression. Sélectionnez Téléch. dans
le fenétre sensible au contexte, ou installez le jeu a partir de I'écran d'information détaillée sur le jeu.

¢ Pour avoir de linformation sur les consoles de jeux compatibles avec le jeu téléchargé, sélectionnez GAMES > Options >
Guide de commande de jeu. \Vous pouvez aussi sélectionner ksl a I'écran d'information détaillé.

& s I'espace disponible dans la mémoire interne du téléviseur ne permet pas l'installation d'un jeu, vous pouvez installer ce
jeu sur un dispositif USB.

¢ Vous pouvez jouer a un jeu installé sur un dispositif USB uniquement lorsque le dispositif USB est branché au téléviseur. Si
le dispositif USB se débranche alors que vous jouez, vous quitterez le jeu.

¢ Vousne pouvez pas jouer a un jeu installé sur un dispositif USB sur un ordinateur, ou un autre téléviseur.

Lancement d'un jeu installé

Pour activer un jeu, vous devez vous connecter a votre compte Samsung. Aprés vous étre connecté, sélectionnez
un jeu sous GAMES > Ma page a I'écran GAMES. Vous verrez des renseignements détaillés sur le jeu sélectionné.
Sélectionnez Lecture. Le jeu démarre.

Gestion des jeux téléchargés ou achetés

Sélectionnez Ma page a I'écran de service GAMES.

Mise a jour d'un jeu

Sélectionnez Ma page > Options > Mettre a jour Mes jeux. Vous pouvez mettre a jour les jeux installés sur le
téléviseur.

Modifier un surnom

1. Sélectionnez [ a I'écran de service GAMES, et ensuite sélectionnez Modifier surnom.

2. Entrez votre surnom a l'aide du clavier a I'écran, puis sélectionnez Fait.

¢  Votre surnom s'affiche a I'écran Ma page.



Activer les mises a jour automatiques des jeux

MENU/123 > MENU > Smart Hub > Mise a jour automatique des applications et des jeux ou Mise a jour
automatique des applications

Pour mettre automatiquement a jour les jeux, réglez Mise a jour automatique des applications a Activer. Les jeux
seront alors mis a jour automatiquement si de nouvelles versions sont disponibles.

¢  Lenom courant peut différer selon les zones géographiques.

Supprimer un jeu

1. Sélectionnez [B) a I'écran Ma page, puis sélectionnez Supprimer Mes jeux.

2. Sélectionnez un jeu a retirer, puis appuyez sur la touche Enter. Répétez le processus pour sélectionner
d'autres jeux a retirer. Pour sélectionner I'ensemble de vos jeux, appuyez sur Choisir tout.

> . . . . . . .
@  Vous pouvez retirer un jeu en le sélectionnant, puis appuyez sur la touche Enter en maintenant la pression.

3. Quand vous avez retiré tous les jeux voulus, sélectionnez Supprimer.

Evaluation d'un jeu

Vous pouvez évaluer un jeu a I'écran de renseignements détaillés sur le jeu.

¢  Cette fonction est disponible uniquement si le jeu est installé sur votre téléviseur.

Enregistrer un coupon

Entrez le numéro du coupon a I'écran Ma page pour I'enregistrer.



Utilisation du service APPS

@ > Envedette > APPS

APPS

Mesapps - <Lesplus populaires| Enfant - Vidéo -« - Sports - Information - Styledevie - Education

smees SPART TV
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Vous pouvez bénéficier d'une vaste gamme de contenu comme des nouvelles, les sports, la météo ou des jeux en
installant les applications correspondantes sur votre téléviseur. Vous pouvez télécharger les applications a partir
de Smart Hub. Sélectionnez une application affichée a I'écran ou sélectionnez une catégorie de genre, comme
Les plus populaires, Nouveautés, en haut de |'écran, puis sélectionnez une application dans le genre que vous avez
sélectionné. Vous pouvez également gérer les applications téléchargées sous Mes apps.

Pour utiliser cette fonction, votre téléviseur doit étre connecté a Internet.

Lorsque vous lancez Smart Hub pour la premiére fois, les applications par défaut sont installées automatiquement. Les
applications installées par défaut peuvent varier en fonction de la région.

Gérer les applications a partir du menu contextuel Options

Déplacez la cible de saisie sur une application, puis appuyez sur la touche Enter et maintenez la pression. Un menu
affiche alors toutes les options ou certaines des options suivantes.

e Supprimer
o Afficher les détails
o Réinstaller

Le menu contextuel peut varier selon les applications.

Affichage de I'écran Information détaillée

Déplacez la cible de saisie sur une application, puis appuyez sur la touche Enter. Vous pouvez également
sélectionner la fonction Voir détails. Voir ci-dessus.



Installer une application

Installation rapide d'applications
1. Sélectionnez une catégorie a I'écran APPS.

2. Déplacez la cible de saisie sur une application, puis appuyez sur la touche Enter et maintenez la pression. Un
menu contextuel s'affiche.

3. Sélectionnez Téléch.. L'application sélectionnée est installée dans le téléviseur.
S . . . . z ANz
@  Vous pouvez voir les applications installées a I'écran Mes apps.
¢ Vous pouvez également lancer une application a partir de son écran d'information détaillée.
> . . . . . . e . . . .
@  Sil'espace disponible dans la mémoire interne du téléviseur ne permet pas l'installation d'une application, vous pouvez
installer cette application sur un dispositif USB.
¢ Vous pouvez utiliser une application installée sur un dispositif USB uniquement lorsque ce dernier est branché au
téléviseur. L'application se ferme si la clé USB est retirée pendant I'exécution de |'application.
¢ Vousne pouvez exécuter une application installée sur un dispositif USB sur un ordinateur, ou un autre téléviseur.

Lancement d'une application

Vous pouvez lancer une application en la sélectionnant a I'écran APPS. Les icones ci-dessous s'affichent a I'écran
des applications sélectionnées, et voici ce qu'elles signifient :

e =t :l'application est installée sur un dispositif USB.
e (3 :l'application requiert un mot de passe.

o g :I'application est installée.

Activer les mises a jour automatiques des applications

MENU > Smart Hub > Mise a jour automatique des applications et des jeux ou Mise a jour automatique des
applications

Pour mettre automatiquement a jour les applications, réglez Mise a jour automatique des applications a Activer.
Les applications seront alors mises a jour automatiquement si de nouvelles versions sont disponibles.

¢ Lenom courant peut différer selon les zones géographiques.



Supprimer l'application du téléviseur

Sélectionnez une application que vous désirez retirer de I'écran APPS, et appuyez sur la touche Enter en
maintenant la pression pour confirmer le retrait. Si vous désirez retirer plus d'une application, sélectionnez-les
toutes en vue de les supprimer et sélectionnez Options dans la partie supérieure de I'écran, puis sélectionnez
Supprimer Mes apps.

g . . . ~ .z 2~ .z
& Lorsque vous retirez une appllcatlon, assurez-vous que les données associées sont egalement retirees.

Déplacer des applications
Vous pouvez déplacer des applications a un endroit sélectionné parmi la catégorie Mes apps.

Sélectionnez Options > Déplacer mes apps a |'écran APPS. Sélectionnez une application que vous désirez déplacer.
4 fléches directionnelles s'affichent autour de I'application. Déplacez I'application sélectionnée a l'aide des fléches
directionnelles a I'écran, puis appuyez sur la touche Enter.

¢  Cette fonction n'est pas disponible sur certains modéles dans certaines zones géographiques particuliéres.

Verrouiller et déverrouiller des applications

Sélectionnez Options > Verrouiller/déverrouiller Mes apps a I'écran APPS. L'écran de saisie du mot de passe
s'affiche. Entrez votre mot de passe et ensuite sélectionnez les applications a verrouiller ou déverrouiller. Une fois
terminé, sélectionnez Enregistrer. Toutes les applications sélectionnées sont verrouillées ou déverrouillées.

Mise a jour des applications

Sélectionnez Options > Met. app. a j. dans la partie supérieure de I'écran APPS. Le téléviseur recherche les mises
a jour des applications et affiche une liste. Vous pouvez mettre a jour I'ensemble des applications, ou certaines
d'entre elles.

Réorganiser les applications

Sélectionnez Options > Trier par a I'écran APPS, puis triez les applications par date, par heure ou autre critére.

Evaluation des applications achetées

Vous pouvez indiquer le nombre d'étoiles a l'aide des touches directionnelles gauche ou droite et a I'écran des
renseignements détaillés.

Utiliser les fonctions des autres applications

MENU/123 > MENU > Smart Hub > Paramétres d'autodémarrage > Applications et messages défilants liés aux
canaux

Vous pouvez configurer des fonctions supplémentaires de vos applications.

Utiliser les applications associées a des chaines.

Une application liée a une chaine fournit de l'information sur les offres et les services disponibles sur une chaine.
Vous pouvez recevoir de l'information sur les émissions télévisées et d'autres services importants pendant que
vous regardez la télévision en utilisant une application liée a une chaine, installée sur le téléviseur, et connectée a
une chaine donnée.

¢  Cette fonction est disponible uniquement lorsqu'une application prenant en charge Applications et messages défilants
liés aux canaux est installée sur le téléviseur.



Utilisation de la fonction e-Manual

Lancement du guide électronique
MENU/123 > MENU > Support technique > e-Manual

Le guide électronique intégré contient de l'information sur les principales fonctions du téléviseur. Appuyez sur la
touche MENU/123 puis sélectionnez e-Manual.

1. Sélectionnez une catégorie a I'écran e-Manual. Le contenu de la catégorie sélectionnée s'affiche a I'écran.

2. Sélectionnez un élément dans la liste. Le sujet correspondant du guide électronique s'affiche.

¢ Surlatélécommande standard, appuyez sur la touche E-MANUAL.
¢ Vous pouvez aussi télécharger une copie du guide électronique sur le site Web de Samsung.
¢  Lesmotsenbleu (p. ex. Image Mode) indiquent un élément du menu.

Les fléches dans le navigateur du menu indique le chemin du menu. Par exemple, MENU/123 > MENU > Image >
Image Mode signifie que vous appuyez sur la touche MENU/123 de la téléecommande Samsung Smart Control, et
ensuite sélectionnez les éléments affichés a I'écran, Menu, Image, et Image Mode dans l'ordre.

Utilisation des touches dans le guide électronique

@ (Recherche) : permet que I'écran de recherche s'affiche. Entrez le terme a rechercher, puis sélectionnez Fait.
Sélectionnez un élément a partir des résultats de la recherche pour charger la page correspondante.

@ (Index) : permet que I'écran de l'index s'affiche. Sélectionnez un sujet dans la liste pour accéder a la page
correspondante.

@ (Sujets consultés récemment) : affiche une liste des pages visionnées auparavant. Sélectionnez une page. Le
guide électronique se déplace a la page sélectionnée.

Acceés a I'écran de menu associé a partir d'une page du guide électronique

@ (Ess. maint.) : vous permet d'accéder a I'élément correspondant du menu et de faire I'essai de la fonction sur-le-
champ.

@ (Lien) : vous permet d'accéder a la page de référence correspondante.

» . N . . .~ .
¢  Certains menus a I'écran ne permettent pas d'accéder au guide électronique.

Accés a I'écran de menu associé a partir d'une page du guide électronique

Appuyez sur la touche MENU/123 de la télécommande Samsung Smart Control, puis sélectionnez e-Manual a la
télécommande affichée a I'écran pour consulter la rubrique traitant de de la fonction du menu en cours a I'écran.

¢ Surlatélecommande standard, appuyez sur la touche E-MANUAL.

» . Xz . . ~ .
¢  Certains menus a I'écran ne permettent pas d'accéder au guide électronique.

Mise a jour du guide électronique en fonction de la version la plus récente

Vous pouvez mettre a jour le guide électronique de la méme facon que vous mettez a jour les applications.



Utilisation du navigateur Web

Vous pouvez naviguer sur Internet a |'aide de votre téléviseur comme vous le feriez sur un ordinateur, et vous
pouvez méme regarder une émission en méme temps grace a la fonction ISI. Sélectionnez Aide pour voir les
renseignements sur le navigateur.

» N . . o v ™ . . e
¢  Pour que la navigation soit plus conviviale, utilisez un clavier et une souris que vous branchez au téléviseur.

N,

Vous pouvez faire défiler la page du navigateur Web a l'aide des 4 touches directionnelles.

g La page du navigateur peut étre différente de celle que vous verriez sur un ordinateur.

Préférences de navigation
Permet de configurer les paramétres de navigation selon vos besoins. Sélectionnez = > Paramétres.

e Général

Masque automatiquement les onglets du navigateur ou les barres de menu apreés une période d'inactivité.
Vous permet également de réinitialiser tous les réglages de I'utilisateur.

& Vos historiques de signets et de navigation ne seront pas réinitialisés.
e Page d'accueil
Configure la page d'accueil. Lorsque vous lancez le navigateur, il affiche cette page.
e Moteurrech.
Vous permet de rechercher de l'information et affiche ensuite les pages Web pertinentes.
e Confidentialité et sécurité

Empéche d'accéder a des pages Web inappropriées. Vous permet également de ne pas enregistrer votre
historique de navigation.

e Pages bloquées

Permet de bloquer des pages Web et de les débloquer. Vous pouvez gérer la liste des pages que vous avez
bloquées.

e Pages approuvés

Limite le navigateur uniquement aux pages que vous avez approuvées. Pour utiliser cette option, vous devez

créer un mot de passe. Vous pouvez ajouter et retirer des pages approuvées.

e Encodage

Vous offre I'option de régler I'encodage a Auto ou de sélectionner une méthode d'encodage a partir d'une
liste.

e Aproposde

Permet d'afficher la version actuelle du navigateur.



Utilisation du service MON CONTENU

& > Envedette > MON CONTENU

MON CONTENU

Vous pouvez lire le contenu multimédia enregistré dans les dispositifs de stockage, comme un dispositif USB,
un appareil mobile et la caméra du téléviseur. Lorsque vous branchez un dispositif de stockage au téléviseur,
ce dernier affiche un onglet avec le nom du dispositif branché. Sélectionnez I'onglet pour confirmer le contenu
enregistré dans le dispositif de stockage.

» . . . e . A . i
@  Vous ne pouvez toutefois pas lire de contenu si le téléviseur ne prend pas en charge le contenu lui-méme ou son dispositif
de stockage. Pour plus d'information, reportez-vous a la section « Instructions a lire avant d'effectuer la lecture des

fichiers photos, vidéos ou de musique ».

A

Faites une copie de sauvegarde de vos fichiers importants avant de brancher un dispositif USB. Samsung décline toute
responsabilité en cas de fichiers endommagés ou perdus.

Instructions a lire avant la lecture de tout contenu média

& Pour brancher le téléviseur a un ordinateur, reportez-vous a la section « Connexion a un ordinateur ».
& Pour brancher le téléviseur a un dispositif USB ou de stockage externe, branchez le dispositif au port USB du téléviseur.

@  Pour brancher le téléviseur a un appareil mobile, reportez-vous a la section « Connexion d'un appareil mobile ».



Lire du contenu multimédia sur un ordinateur ou un appareil mobile

4

Avant de connecter le téléviseur a un ordinateur ou un appareil mobile, configurez les paramétres de réseau.

Lire du contenu multimédia enregistré sur un ordinateur ou un appareil mobile

@ > Envedette > MON CONTENU

Pour lire sur le téléviseur du contenu multimédia enregistré sur un ordinateur ou un appareil mobile, vous devez
approuver la connexion entre le téléviseur et |'ordinateur ou I'appareil mobile.

1.
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Connexion a un ordinateur ou un appareil mobile. Le téléviseur affiche les noms des appareils et dresse la liste
des fichiers multimédia enregistrés.

Sélectionnez le fichier multimédia que vous voulez lire a partir de la liste. Le fichier multimédia sélectionné
joue.

Sélectionnez la touche g pour arréter la lecture ou appuyez sur la touche RETURN.

Vous pouvez également aller au contenu média que vous souhaitez lire, et ensuite appuyez sur la touche B pour lire le
contenu.

Pour connecter un ordinateur par I'entremise d'un réseau domestique, reportez-vous a la section «Connexion a un
ordinateur ».

Il se peut que le contenu enregistré sur un ordinateur ou un appareil mobile ne puisse pas étre lu par le téléviseur en
fonction du type d'encodage et du format du fichier du contenu.

Pour connecter un appareil mobile par I'entremise de Smart View 2.0, reportez-vous a la section «Connexion d'un
appareil mobile ».

Il se peut que la lecture du contenu ne soit pas de niveau égal en fonction du statut du réseau. Si c'est le cas, transférez le
contenu d'un dispositif de stockage USB, et ensuite lancez la lecture du contenu a partir de ce dispositif.

Lecture du contenu média enregistré sur un dispositif USB

1.
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Sélectionnez un dispositif USB a I'écran MON CONTENU. Le téléviseur affiche la liste de vignettes des
contenus multimédias enregistrés dans un dispositif USB.

Sélectionnez le contenu média que vous voulez lire a partir de la liste. La lecture du contenu média s'effectue.
Sélectionnez la touche g pour arréter la lecture ou appuyez sur la touche RETURN.

Pendant la lecture d'une vidéo en résolution UHD, le mode Commande gestuelle n'est pas disponible.

Si vous sélectionnez un dispositif USB a I'écran Source, le téléviseur passe automatiquement a I'écran MON CONTENU.

Retrait d'un dispositif USB en toute sécurité

1.
2.

Appuyez sur la touche SOURCE. L'écran Source s'affiche.

Déplacez la cible de saisie vers le dispositif USB que vous souhaitez retirer, puis appuyez sur la fléeche
directionnelle vers le bas.

Sélectionnez |'option Retirer I’appareil USB dans la liste.



Touches et fonctions disponibles pendant le visionnement de photos

Pendant le visionnement de photos, appuyez sur la touche Enter pour afficher les options disponibles. Vous pouvez
également voir les vignettes des photos enregistrées tout en regardant les photos. Les options disparaissent quand
vous appuyez sur la touche RETURN.

e Pause/Lecture

Lance ou arréte le diaporama. Le diaporama vous permet de visionner automatiquement toutes les photos
contenues dans un dossier, une par une.

e Précédent/ Suivant
Voir la photo précédente ou suivante.

e Options
Fonction Description
Vitesse du diaporama Permet de régler la vitesse du diaporama.
Effet de diaporama Permet d'appliquer des effets de transition au diaporama.

Permet de faire un agrandissement par un facteur de 4.

Zoom et rotation Permet de faire tourner la photo.

Permet d'entendre une musique de fond pendant que le téléviseur affiche des photos.
& Les fichiers de musique doivent étre enregistrés sur le méme dispositif USB que les fichiers de

hotos.
Musique de fond o P A ) o o )

@ Une icone de lecteur de musique apparait a I'écran lorsque vous faites jouer une musique de
fond. L'icéne vous permet d'interrompre la lecture du fichier de musique actuel ou de lire un
autre fichier.

Affiche une liste des modes de son et vous permet de changer de mode.

Son Mode

& Cette fonction est disponible uniquement pendant la lecture de musique de fond.

Li haut- - - o .
iste des haut Vous pouvez choisir quels haut-parleurs utiliser pour faire jouer la musique de fond.

parleurs
Image Mode Affiche une liste des modes d'image et vous permet de changer de mode.
Information Permet d'afficher de l'information détaillée sur la photo en cours.

> . . . erz < Z
¢  Les options disponibles peuvent différer selon les modéles et les valeurs de paramétrage.

& Les options Liste des haut-parleurs et Son Mode sont disponibles uniquement pendant que le téléviseur joue une
musique d'arriére-plan.



Touches et fonctions disponibles pendant le visionnement de vidéos

Pendant le visionnement de vidéos, appuyez sur la touche Enter pour afficher les options disponibles. Des apercus
de vidéos sont affichés simultanément selon certains intervalles, ce qui vous permet d'aller a un point précis. Les
options disparaissent quand vous appuyez sur la touche RETURN.

e Pause/Lecture

Interrompre ou reprendre la lecture d'une vidéo Quand la lecture d'une vidéo est en pause, vous pouvez
utiliser les fonctions suivantes.

i Quand la lecture d'une vidéo est en pause, le téléviseur n'émet aucun son.
— Etape: La touche Il vous permet de parcourir le fichier vidéo mis en pause, une image a la fois.
— Ralenti: La touche pp vous permet de réduire la vitesse de lecture (1/8, 1/4, 1/2).

e Rembobinage / Avance rapide

Revenir en arriére ou effectuer la lecture d'une vidéo en avance rapide. Appuyez a plusieurs reprises sur la
touche pour augmenter jusqu'a 3 fois la vitesse de lecture en rembobinage ou avance rapide. Pour rétablir la
vitesse normale de lecture, appuyez sur la touche p-.

e Précédent/ Suivant

Permet de lire la vidéo précédente ou la vidéo suivante. Appuyez deux fois sur la touche |44 pour faire la
lecture de la vidéo précédente. Appuyez une seule fois sur la touche |4« pour lire la vidéo actuelle depuis le
début.

Appuyez sur la touche pp| pour lire la vidéo suivante.
o Répéter

Joue plusieurs fois le fichier vidéo en cours ou tous les fichiers vidéo dans le méme dossier.



e Options

Fonction Description

Image Format Permet de changer la taille de I'écran. Les formats d'image pris en charge différent selon la vidéo.

Commande les sous-titres de la vidéo.

Sous-titres : permet d'activer ou de désactiver les sous-titres.

Langue : définit la langue de sous-titrage.

Synchroniser : permet d'ajuster la synchronisation lorsque la vidéo et les sous-titres ne sont pas
Sous-titres synchronisés.

Réinitialiser la synchronisation : permet de réinitialiser les paramétres de synchronisation a 0.

Taille : permet de modifier la taille des sous-titres.

Encodage : permet d'afficher une liste d'encodages de caracteéres. Vous permet de changer

I'encodage des caracteéres lorsque les sous-titres sont affichés de maniére incorrecte.

Pivoter Permet de faire tourner la vidéo.
Image Mode Affiche une liste des modes d'image et vous permet de changer de mode.
Son Mode Affiche une liste des modes de son et vous permet de changer de mode.

Liste des haut-

parleurs Vous pouvez choisir quels haut-parleurs utiliser pour faire jouer le son des vidéos.

Affiche une liste des langues et vous permet de sélectionner la langue qui sera utilisée pendant la

L i s . Sl . . . .
angage audio lecture des vidéos. Cette fonction est seulement offerte si la vidéo contient plus d'une piste audio.

Information Permet d'afficher de l'information détaillée sur la vidéo.



Touches et fonctions disponibles pendant la lecture de fichiers de musique
Vous pouvez utiliser les fonctions suivantes lorsque vous sélectionnez un fichier de musique.

e Pause/Lecture
Sert a mettre en pause le fichier de musique ou a le relancer.
e Précédent/ Suivant

Permet de lire le fichier de musique précédent ou suivant. Appuyez deux fois sur la touche |«« pour faire
la lecture du fichier de musique précédent. Appuyez une seule fois sur la touche [«« pour lire le fichier de
musique actuel depuis le début.

Appuyez sur la touche pp| pour lire le fichier de musique suivant.
o Répéter
Relit le fichier de musique en cours plusieurs fois ou tous les fichiers de musique dans le méme dossier.
e Lect.al
Lit les fichiers de musique en ordre aléatoire.
e Liste des haut-parleurs
Vous pouvez choisir quels haut-parleurs utiliser pour faire jouer de la musique.
e Image Non

Lit les fichiers de musique uniquement avec I'écran désactivé.



Ecoute de musique en qualité HD

Vous pouvez écouter de la musique en mode HD en qualité HD. Réglez la fonction Audio HD (MENU > Son >
Paramétres supplém. > Audio HD) a Activer. Ensuite, allez a I'écran de service MON CONTENU et sélectionnez un
fichier de musique a lire en qualité HD.

¢ Un signal audio standard fait I'objet d'un échantillonnage a 48 kHz, alors qu'un signal audio HD fait I'objet d'un
échantillonnage a 96 kHz.

& llest possible que certains récepteurs S/PDIF ne soient pas compatibles. Si le récepteur est incompatible, désactivez le
mode Audio HD et utilisez plutét le mode audio normal.

RS

Certains lecteurs audio externes connectés par l'intermédiaire de HDMI, Bluetooth ou de réseaux Wi-Fi ne sont pas en
mesure de traiter les signaux audio HD.

A

Si un fichier de musique prend en charge le format audio HD, l'icdne HD s'affiche dans la liste.

'~

Sélectionnez le fichier de musique, puis sélectionnez P pour le lire.

A

Lorsque vous réglez le mode Audio HD a Désactiver pendant la lecture, le fichier de musique suivant est lu avec les
signaux en format audio standard.

A

Lorsque vous faites jouer un fichier de musique HD pendant que le mode Multi-Link Screen est en cours d'exécution,
Multi-Link Screen est automatiquement interrompu.

Fonctions dans I'écran de la liste des contenus média

Vous pouvez utiliser les fonctions suivantes dans I'écran de la liste des contenus multimédia sur un dispositif de
stockage.

e Filtrer par
Filtre le contenu multimédia pour afficher le type que vous souhaitez.
e Trier par
Permet de trier la liste de contenu. Les critéres de tri varient en fonction du type de contenu sélectionné.
&  Cette fonction n’est pas accessible lorsque I'option Filtrer par est réglée a Tout.
e Supprimer
Permet de supprimer le contenu multimédia figurant sur la liste.
&  Cette fonction n'est pas disponible aux Etats-Unis et au Canada.

& Cette fonction est disponible seulement lorsque le dispositif de stockage comprend le contenu multimédia
enregistré.

e Liresélection

Permet de lire le contenu multimédia sélectionné a partir de la liste.

&  Cette fonction n'est pas accessible lorsque I'option Filtrer par est réglée a Tout.



Utilisation du service NewsON

¢ > Envedette > NewsON

NewsON

Vous pouvez trouver de l'information sur un vaste éventail de sujets d'une maniére intelligente et pratique, mise
a jour en temps réel. NewsON vous offre les grands titres, les principaux reportages, les thémes populaires et les
prévisions météorologiques du jour.

&  Cette fonction n'est pas disponible aux Etats-Unis et au Canada.

S e . , s ge . ra P
¢ Avantd'utiliser le service NewsON, vérifiez si le téléviseur est branché a Internet.

Utilisation du contenu NewsON

e Regarder de nouvelles vidéos
Vous pouvez regarder les toutes derniéres vidéos de nouvelles et celles qui leur sont associées.

Lecture d'articles

Vous pouvez lire des articles a I'écran.
e Voir l'information sur la météo

Vous pouvez voir les prévisions météorologiques actuelles et les prévisions pour les 7 prochains jours pour la
ou les villes que vous sélectionnez.

> P . . N .
@  Vous pouvez sélectionner jusqu'a 5 villes.



Utilisation du service Soccer

@ > Envedette > Soccer

Vous pouvez obtenir un large éventail d'information au sujet des parties de soccer dans le monde ainsi que des
vidéos, des nouvelles, des affrontements et des classements. Vous pouvez également accéder facilement a de
l'information sur votre équipe favorite en I'ajoutant a la Liste des favoris.

&  Cette fonction n'est pas disponible aux Etats-Unis et au Canada.

S e . P . L1z ® P
¢  Avantd'utiliser le service Soccer, vérifiez si le téléviseur est branché a Internet.

Configuration de I'écran de service Soccer pour afficher vos équipes
favorites

Vous pouvez configurer I'écran de service Soccer afin d'afficher uniquement vos équipes favorites. Pour ajouter
une équipe a la liste des équipes favorites en haut de I'écran, sélectionnez + s'affichant a cété de la liste, puis
sélectionnez une équipe. Aprés avoir ajouté les équipes, si vous sélectionnez une équipe dans la liste des équipes
de soccer favorites, son classement dans la ligue, les résultats du match, les jeux vidéos et les programmations
s'affichent dans la zone de contenu de I'écran.

g . . g . .
¢ Laliste peut comporter six équipes au maximum.

Utilisation de fonctions supplémentaires

Sélectionnez O en haut de I'écran de service Soccer. Les fonctions suivantes sont disponibles :
e Ajouter des équipes

Affiche I'écran de sélection de la ligue afin que vous puissiez ajouter des équipes a la liste des équipes
favorites.

e Déplacer des équipes
Vous permet de réorganiser I'ordre des équipes sélectionnées.
e Supprimer des équipes

Vous permet de retirer les équipes sélectionnées de la liste des équipes favorites.



Voir des vidéos de soccer

Vous pouvez voir les vidéos de soccer et les faits saillants de vos équipes de soccer favorites. A I'écran de service
Soccer sélectionnez une équipe, puis sélectionnez la vidéo que vous voulez voir.

Touches et fonctions disponibles en regardant une vidéo de soccer

Lecture / Pause

Interrompre ou reprendre la lecture d'une vidéo

Précédent / Suivant

Permet de lire la vidéo précédente ou la vidéo suivante.

Rembobinage / Avance rapide

Revenir en arriére ou effectuer la lecture d'une vidéo en avance rapide.
Répéter

Repasse la vidéo.

e Options
Fonction Description
Image Format Permet de changer la taille de I'écran.
Image Mode Vous permet de changer le mode d'affichage de la vidéo en cours.
Change le mode audio de la vidéo en cours lorsque vous faites jouer la vidéo par le haut-parleur
Son Mode e
du téléviseur.
Liste des haut-

parleurs

Vous pouvez choisir quels haut-parleurs utiliser pour faire jouer le son des vidéos.



Commander votre téléviseur a I'aide de votre voix

MENU/123 > Reconnaissance vocale

> . . ~ gz . . . . \
¢  Votre écran de reconnaissance vocale peut étre différente de l'illustration ci-dessus, en fonction du modéle.

» , . . ™ . . .
¢  Lorsque vous exécutez la reconnaissance vocale, le guide d'utilisation de reconnaissance vocale s'affiche en haut de
I'écran. Le guide est différent selon la langue prise en charge par la reconnaissance vocale.

Vous pouvez exécuter la reconnaissance vocale en deux modes :

e Le mode de reconnaissance vocale a courte distance qui utilise le microphone intégré dans la télécommande
Samsung Smart Control.

- Appuyez sur la touche MENU/123 puis sélectionnez Reconnaissance vocale.
- Appuyez sur la touche MENU/123 et maintenez la pression.

e Le mode de reconnaissance vocale a distance qui utilise le microphone intégré dans le téléviseur.

¢ Cemode est pris en charge seulement par les téléviseurs de série 9500.

4 Lorsque vous utilisez les modeéles de série SEK-3500 de I'ensemble UHD Evolution, le téléviseur doit étre équipé
d'une caméra intégrée pour utiliser ce mode.
— Regardez en direction de I'écran du téléviseur, et prononcez une commande, par exemple, « Bonjour TV ».
> . \ . . . . .
¢  Lemotdéclencheur « Smart TV » n'est pas pris en charge dans certaines zones géographiques. Cependant, si vous
réglez le Langue menu a Frangais, le mot déclencheur « Smart TV » est disponible.
& lse peut que les modéles de série 9500 ne reconnaissent pas votre voix par le microphone intégré en raison du

bruit environnant qu'enregistrent la caméra et le microphone. Dans ce cas, utilisez le mode de reconnaissance a
courte distance : Appuyez sur la touche MENU/123 en maintenant la pression et prononcez la commande en vous
tenantde 10 cm a 15 cm (4 a 6 po) du micro de la téléecommande Smart Touch Control. Le volume optimal pour les
commandes vocales se situe entre 75 dB et 80 dB.



Lisez les instructions ci-aprés avant d'utiliser la fonction de reconnaissance
vocale
MENU/123 > MENU > Systéme > Reconnaissance vocale

Vous pouvez accéder a certaines options de menu et fonctions, et les sélectionner, a I'aide de commandes vocales.
Pour une reconnaissance vocale plus efficace, parlez lentement et clairement dans la langue indiquée dans 'option
MENU > Systéme > Reconnaissance vocale.

> . < . . N T
@ Pour de plus amples renseignements sur la commande vocale, reportez-vous a la section « Instructions a lire avant
d'utiliser la commande vocale, la commande gestuelle ou la reconnaissance faciale ».

Apprentissage des bases de la commande vocale

o Voirl'ensemble des commandes vocales :

Appuyez sur la touche de fléche vers le bas de la télécommande Samsung Smart Control afin d'afficher une
liste compléte des commandes vocales par catégorie. Vous pouvez aussi dire « Aide ».

e Désactivation de la reconnaissance vocale :
Dites « Fermer », ou appuyez sur la touche RETURN pour terminer la reconnaissance vocale.

> e N JEPP . e
@  Letéléviseur reconnait les commandes vocales prédéfinies seulement. Les commandes reconnues pourraient différer de
celles que contient le manuel, en fonction de la version que contient le téléviseur.

Activer ou désactiver le mode voix du téléviseur

MENU/123 > MENU > Systéme > Reconnaissance vocale > Voix TV

Activer ou désactiver le mode voix du téléviseur avec vos commandes vocales.

Sélectionner le sexe de la voix du téléviseur

MENU/123 > MENU > Systéme > Reconnaissance vocale > Genre de la voix

Vous pouvez sélectionner le sexe de la voix du téléviseur lorsque vous utilisez la fonction de reconnaissance vocale.

Modification de la langue de la reconnaissance vocale

MENU/123 > MENU > Systéme > Reconnaissance vocale > Langue Z P
Vous pouvez sélectionner une langue pour utiliser la fonction de reconnaissance vocale.

» . . . . . . z . ~
¢ Lareconnaissance vocale interactive n'est pas disponible dans toutes les langues. Si la langue sélectionnée n'est pas
disponible, sélectionnez une autre langue.



Ajouter ou supprimer des mots d'activation

MENU/123 > MENU > Systéme > Reconnaissance vocale > Mot de déclenchement

Vous pouvez ajouter ou supprimer des mots d'activation. Un mot d'activation est un terme ou une phrase que vous
prononcez pour lancer la fonction Reconnaissance vocale. Pour ajouter un nouveau mot d'activation a la liste,
sélectionnez 'option Ajouter des mots de déclenchement. Pour retirer un mot d'activation de la liste, sélectionnez
Supprimer des mots de déclenchement puis sélectionnez le mot d'activation.

¢  Cette fonction est prise en charge seulement par les téléviseurs de série 9500.

o Lorsque vous utilisez les modéles de série SEK-3500 de I'ensemble UHD Evolution, le téléviseur doit étre équipé d'une
caméra intégrée pour utiliser cette fonction.

Mesure de la réaction aux commandes de reconnaissance vocale

MENU/123 > MENU > Systéme > Reconnaissance vocale > Voice Sensitivity

Vous pouvez configurer la maniére selon laquelle le téléviseur percoit le son de votre voix dans la piéce et les
niveaux de réaction du téléviseur aux commandes de reconnaissance vocale.

&  Cette fonction est prise en charge seulement par les téléviseurs de série 9500.

o Lorsque vous utilisez les modéles de série SEK-3500 de I'ensemble UHD Evolution, le téléviseur doit étre équipé d'une
caméra intégrée pour utiliser cette fonction.

Utilisation de la reconnaissance vocale interactive a courte distance

Vous pouvez rechercher du contenu qui est disponible dans la grille horaire ou exécuter diverses autres fonctions
sans avoir a retenir des commandes ou des mots clés particuliers.

Activez Reconnaissance vocale et dictez une commande. Voir les exemples ci-dessous :

e Lorsque vous voulez trouver un contenu particulier :
«***(Titre) » / « Rechercher ***(titre) »)

e Sivous souhaitez avoir diverses nouvelles :

« Quelles sont les conditions météo a ***(nom du lieu)? » / « Quel est le cours de I'action*** (nom de la
société) ? » / « Nombre de buts ***(nom de I'équipe») ».

e Lorsque vous utilisez la fonction du téléviseur :
« Réglez la minuterie (hom de la fonction) aprés 30 minutes »

¢  Certaines des phrases ci-dessus peuvent ne pas étre prises en charge, en fonction du pays.

Utiliser la reconnaissance vocale avec un ton impératif

1. Placez-vous & 4 métres (13 pi) du téléviseur et prononcez le mot d'activation. Vous pouvez également
appuyer sur la touche MENU/123 de la télécommande Samsung Smart Control. Lorsque l'icbne de
microphone s'affiche a I'écran, vous pouvez utiliser la Reconnaissance vocale.

2. Dites une commande. Vous pouvez faire fonctionner le téléviseur a l'aide de la reconnaissance vocale lorsque
vous regardez des émissions de télévision ou des vidéos.



Utilisation de la reconnaissance vocale a distance
MENU/123 > MENU > Systéme > Reconnaissance vocale > Microphones activés

Vous pouvez utiliser le micro intégré au téléviseur. Sélectionnez Microphones activés, puis sélectionnez le nom de
modeéle de la télécommande et du microphone.

¢  Cette fonction est prise en charge seulement par les téléviseurs de série 9500.

4 Lorsque vous utilisez les modeéles de série SEK-3500 de |'ensemble UHD Evolution, le téléviseur doit étre équipé d'une
caméra intégrée pour utiliser cette fonction.

Test de bruit autour du micro intégré au téléviseur

MENU/123 > MENU > Systéme > Reconnaissance vocale > Test environnement de la commande vocale

Ce test permet de déterminer le niveau de fonctionnement de la reconnaissance vocale du téléviseur dans
I'environnement courant. Effectue le Test environnement de la commande vocale avant d'utiliser la reconnaissance
vocale afin de s'assurer qu'elle fonctionne correctement.

&  Cette fonction est prise en charge seulement par les téléviseurs de série 9500.

o Lorsque vous utilisez les modéles de série SEK-3500 de I'ensemble UHD Evolution, le téléviseur doit étre équipé d'une
caméra intégrée pour utiliser cette fonction.

Exécutez la commande Test environnement de la commande vocale et tenez-vous a 4 m (13 pi) du téléviseur.

2. Sélectionnez Démarrer pour mesurer le niveau d'écho. Si le niveau est convenable, le test passera a I'étape
suivante. Si cette étape du test échoue, restez silencieux et essayez de nouveau.

3. Seélectionnez Démarrer pour mesurer le niveau de bruit ambiant. Si le niveau de bruit est convenable, le test
passera a |'étape suivante. Si cette étape du test échoue, restez silencieux et essayez de nouveau.

4. Evalue le volume et la clarté de votre voix. Dites « Bonjour TV », puis prononcez la commande face a I'écran
du téléviseur clairement et a voix forte en une période de 30 secondes. Si la voix est correctement reconnue
par le téléviseur, le test passe a I'étape suivante. Si cette étape du test échoue, essayez de nouveau.

¢  Lemotdéclencheur « Smart TV » n'est pas pris en charge dans certaines zones géographiques. Cependant, si vous
réglez le Langue menu a Frangais, le mot déclencheur « Smart TV » est disponible.

Vérifier le bruit et la lumiére ambiants (test de I'environnement de commande gestuelle et
vocale)

MENU/123 > MENU > Support technique > Autodiagnostic > Vérific. environn. commande vocale/gest. ou
Vérific. environn. commande gestuelle

Vous pouvez mesurer le bruit et la lumiére ambiants dans les environs de la caméra et du micro du téléviseur afin
de vérifier si l'environnement convient a l'utilisation de la commande vocale et gestuelle.

¢ Lenom courant peut différer selon les zones géographiques.

Utilisation du tutorial sur la reconnaissance vocale
MENU/123 > MENU > Support technique > Didacticiel reconnaissance vocale Z4uEID

Ce tutoriel vous permet de vous familiariser avec les fonctions de base de la Reconnaissance vocale. Exécutez la
fonction Didacticiel reconnaissance vocale dans le menu Support technique ou exécutez Reconnaissance vocale
et dites « Didacticiel ».



Commande du téléviseur a I'aide de gestes (Commande
gestuelle)

MENU/123 > MENU > Systéme > Commande gestuelle T3 FTD

La commande gestuelle n'est pas disponible :

Lorsque vous faites jouer une vidéo de qualité UHD enregistrée sur un dispositif USB
— Lorsque vous regardez une émission sur une chaine numérique en résolution UHD

Lorsque vous utilisez la télécommande Samsung Smart Control ou une souris

¢  Cette fonction n'est pas prise en charge par certaines applications.

> . . N . " Swis T
@  Pour plus d'information, reportez-vous a la section « Instructions a lire avant d'utiliser la commande vocale, la commande
gestuelle ou la reconnaissance faciale ».

/A\ Lorsque votre téléviseur n'a pas de caméra intégrée, il doit &re connecté a une caméra pour téléviseur en
option pour pouvoir utiliser cette fonction. La caméra en option doit étre connectée au port TV CAMERA
correspondant a l'arriére du téléviseur. Les autres ports USB ne prennent pas en charge la caméraou la
Commande gestuelle.

Test de luminosité ambiante au moyen de la télécaméra
MENU/123 > MENU > Systéme > Commande gestuelle > Test environnement de commande gestuelle lm

Effectuez cet essai avant d'utiliser la fonction de la commande gestuelle pour vérifier son bon fonctionnement.

1. Tenez-vousde 1,5ma3,5m (5a 11,5 pieds) de I'écran du téléviseur. Lancez Test environnement de
commande gestuelle, puis sélectionnez Démarrer. Le téléviseur peut ne pas reconnaitre le mouvement que
vous faites avec la main si I'écran refléte de la lumiére ou s'il y a du mouvement en arriére-plan.

2. Tenez-vous face a la caméra et suivez les instructions apparaissant a I'écran.



Activation de la commande gestuelle
MENU/123 > MENU > Systéme > Commande gestuelle > Commande gestuelle Z3 EL

Tenez-vous face a la caméra du téléviseur. Abaissez la main de sorte a étre dans une position confortable. Levez

la main, l'index entiérement tendu vers le haut et ensuite exécutez lentement un mouvement avec la main vers la
gauche ou la droite. Si votre main est bien reconnue par la caméra du téléviseur, la commande gestuelle est activée
et un pointeur et des icones de commande gestuelle s'affichent a I'écran.

> . . . . . . .
@  Pour désactiver la commande gestuelle, faites un geste de la main hors du champ de la caméra. Pour réactiver la
commande gestuelle de nouveau, vous n'avez qu'a déplacer de nouveau votre main vers la caméra de la télévision durant
trois secondes.

.

La fonction de commande gestuelle peut s'interrompre si votre index n'est pas totalement tendu ou si vous exécutez trop
rapidement le mouvement.

Utilisation du tutoriel de commande gestuelle

MENU/123 > MENU > Support technique > Tutoriel sur les commandes gestuelles ZZHLELR

Vous pouvez apprendre les bases de la commande gestuelle.

Apprentissage des bases de la commande gestuelle

Les éléments suivants sont disponibles :

e Déplacement du pointeur

Le déplacement de votre main permet de déplacer le pointeur en conséquence.

o Sélection d'un élément

Pour sélectionner des éléments, pliez votre index et dépliez-le. Vous pouvez sélectionner
un menu sur le téléviseur, ou exécuter une fonction. Gardez votre index plié équivaut a
maintenir une touche de la télécommande enfoncée.




e Retour au menu précédent

Faites un cercle avec votre main en sens antihoraire pour retourner a I'écran de menu
précédent.

e Affichage du menu sensible au contexte / des renseignements relatifs aux émissions

Pliez votre index, puis dépliez-le aprés qu'une seconde se soit écoulée. Cette opération
affiche le menu sensible au contexte. Pendant que vous regardez une émission, pliez votre
index pendant une seconde, puis pointez-le vers un point blanc a I'écran. Vous pouvez voir
les renseignements relatifs aux émissions qui sont enregistrés automatiquement pour
toutes les chaines.

Affichage ou masquage du guide gestuel animé

MENU/123 > MENU > Systéme > Commande gestuelle > Guide gestuel animé LD
Vous pouvez maintenant afficher un guide animé lorsque la commande gestuelle est activée.

> . . . e . . . .. ~
¢  Lorsque vous exécutez une application en utilisant la commande gestuelle pour la premiére fois, le guide animé apparait.

Sélection d'un pointeur et ajustement de sa vitesse.

MENU/123 > MENU > Systéme > Commande gestuelle > Vitess pointeur LR

Sélectionnez un pointeur et ajustez sa vitesse.



Changer le mode d'affichage de I'écran de la commande gestuelle

Changer les écrans de commande gestuelle pendant que vous regardez une émission

Mode de commande de la direction Mode de commande gestuelle par pointage

Mode de commande de la direction

Si vous effectuez une commande gestuelle pour la premiére fois en levant la main pendant que vous
regardez une émission, I'écran du mode de commande de la direction s'affiche. L'écran comprend l'icone de
commande de la direction.

Mode de commande gestuelle par pointage

Avec votre index, déplacez le pointeur au centre de l'icone de commande de la direction et ensuite pliez
votre index vers le bas. Les quatre icones vous permettent d'exécuter les fonctions principales du téléviseur.
Pour passer a I'écran du mode de commande de la direction, déplacez la main hors de I'écran et ensuite
dirigez votre index vers |'écran.

Icéne Description

Sélectionnez 4 et — pour ajuster le volume.

Sélectionnez A et ‘v pour changer la chaine en cours.

Sélectionnez le point au centre de cette icone pour passer a I'écran Mode de pointage par
gestes.

Permet d'afficher la télécommande a I'écran.

Affiche la liste des chaines ou de l'information au sujet de I'émission en cours.

Vous permet d'ajuster le volume ou de sélectionner les haut-parleurs a utiliser.

@ Lance le mode Smart Hub



Affichage de l'icbne de commande de la direction pendant que vous ne regardez pas d'émission

Pour afficher I'icbne de commande de la direction pendant que vous ne regardez pas d'émission, déplacez le
pointeur vers le centre de I'écran, et repliez votre index. Lorsque l'icone de commande de la direction apparait,
déplacez la cible de saisie @ ou @, et pliez votre index vers le bas pour afficher la télécommande a I'écran ou
lancer Smart Hub. L'icdne de commande de la direction disparait s'il n'y a aucune opération pendant 5 secondes ou
plus.

Affichage de l'icbne de commande de la direction masquée pendant que vous utilisez divers services et ne regardez pas
d'émissions



Utilisation de la fonction de reconnaissance faciale

Vous pouvez enregistrer votre visage a l'aide de la caméra du téléviseur, et vous connecter a votre compte
Samsung en utilisant la fonction de reconnaissance faciale. Il est possible d'enregistrer un seul visage par compte.
Le téléviseur pourrait avoir de la difficulté a reconnaitre un visage, en fonction de la lumiére ambiante et des
ombres qui couvrent le visage.

4 . . s . . NUT .
@  Pour plus d'information, reportez-vous a la section « Instructions a lire avant d'utiliser la commande vocale, la commande
gestuelle ou la reconnaissance faciale ».

/\ Lorsque votre téléviseur n'a pas de caméra intégrée, il doit &étre connecté a une caméra pour téléviseur en
option pour pouvoir utiliser cette fonction. La caméra en option doit &tre connectée au port TV CAMERA
correspondant a I'arriére du téléviseur. Les autres ports USB ne prennent pas en charge la caméraou la
Commande gestuelle.

Enregistrer votre visage pour votre compte Samsung
MENU/123 > MENU > Smart Hub > Compte Samsung > Modifier profil

Sélectionnez apreés avoir entré le mot de passe de votre compte. Sélectionnez Prendre photo, alignez votre
visage a l'intérieur du cercle rouge. Lorsque le cercle devient vert, cela signifie que le téléviseur a terminé le

processus d'enregistrement de reconnaissance faciale.

> ™~ . N
2 Pour utiliser cette fonction, vous devez vous connecter a votre compte Samsung.

A

La caméra doit couvrir I'ensemble de votre visage. Evitez que des ombres couvrent votre visage. Les ombres empéchent
la caméra de reconnaitre les visages avec précision.

4 Adoptez une expression aussi neutre que possible. De plus, gardez votre bouche fermée et aussi neutre que possible.

A

Pour plus d'information, reportez-vous a la section « Création d'un compte Samsung ».



Passer a la méthode d'ouverture de session par reconnaissance faciale
MENU/123 > MENU > Smart Hub > Compte Samsung > Modifier profil

Vous pouvez passer a l'ouverture de session par reconnaissance faciale. Pour changer votre méthode d'ouverture
de session, procédez comme suit :

1. Entrez votre mot de passe, puis sélectionnez OK.

2. Atlécran « Modifier profil », sélectionnez Mode de connex. Dans la liste déroulante qui apparait, sélectionnez
Sélection d’image de profil et reconnaissance faciale (sécurité moyenne).

3. Sélectionnez Fait.

Se connecter a un compte Samsung grace a la reconnaissance faciale
MENU/123 > MENU > Smart Hub > Compte Samsung > Modifier profil

1. Sélectionnez votre compte Samsung.

2. Sivous avez sélectionné la reconnaissance faciale comme mode de connexion a votre compte Samsung, le
téléviseur reconnaitra votre visage automatiquement. En cas d'échec de la reconnaissance, réessayez.

> . . . . L . .
¢  Lacaméra doit couvrir I'ensemble de votre visage. Evitez que des ombres couvrent votre visage. Les ombres
empéchent la caméra de reconnaitre les visages avec précision.

V4 Adoptez une expression aussi neutre que possible. De plus, gardez votre bouche fermée et aussi neutre que
possible.

%

Une fois la reconnaissance réussie, le téléviseur ouvre automatiquement une session dans Smart Hub. Si le téléviseur
reconnait plusieurs visages, une liste des comptes correspondants s’affiche. Sélectionnez le compte souhaité. Sile
téléviseur détecte un visage non enregistré, il affichera « Non enregistré » a I'écran.



Apercu de la diffusion numérique

Utilisation du guide
MENU/123 > MENU > Diffusion > Guide Y FI»
Vous pouvez consulter les horaires de diffusion des émissions et Planifier un visionnement a partir du Guide.

Vous pouvez vous déplacer dans le Guide en intervalles de 2 heures dans n'importe quelle direction en appuyant
sur la touche 4qoupp. Vous pouvez consulter I'horaire des émissions ultérieures uniquement.

Vous pouvez sélectionner les touches qui apparaissent au bas de I'écran en utilisant la touche POINTER de la
télécommande Samsung Smart Control.

> . . A 7 . A~ .
¢ Lesrenseignements contenus dans le Guide ne concernent que les chaines numériques. Les chaines analogiques ne sont
pas prises en charge.

¢ Pour afficher le Guide, il faut d'abord régler 'horloge du téléviseur (MENU > Systéme > Heure > Horloge).

Pour accéder aux fonctions du Guide apreés avoir lancé le Guide, appuyez sur la touche Enter de la télécommande
et maintenez la pression. Une fenétre contextuelle contenant la liste des fonctions suivantes s'affiche.

e Filtre chaines
Filtre les chaines affichées dans le Guide selon les catégories suivantes : Tout et Favoris 1 - Favoris 5.
e Gestionnaire progr.

Affiche le gestionnaire d'horaire.

> . - . . . . , . R . . . e
@  Pour avoir de l'information au sujet du gestionnaire d'horaire, reportez-vous a la section « Configuration de l'option
Planifier un visionnement ».

e Modifier les chaines favorites
Permet de marquer comme chaine favorite une chaine que vous avez sélectionnée dans le Guide.
e Voir détails

Permet d’afficher de l'information détaillée sur I'émission sélectionnée. L'information disponible sur les
émissions peut varier selon le signal de diffusion et peut ne pas étre du tout disponible dans le cas de
certaines émissions.

— Sélectionnez une émission en cours sur une autre chaine, puis Afficher les détails pour Regarder ou
Enregistrer I'émission.

- Sélectionnez une émission a venir, puis sélectionnez Afficher les détails pour planifier un Planifier un
visionnement ou un Planifier un enregistrement.

¢ Lafonction d'enregistrement n'est pas prise en charge aux Etats-Unis et au Canada.

> -
¢  Surlatéléecommande standard, appuyez sur la touche INFO.
> . PR ' . . . .
¢  Pour de plus amples renseignements sur les émissions ou sur |'option Planifier un visionnement, reportez-vous
ala section « Configuration de 'option Planifier un visionnement ».
D . L P .
¢  Vous pouvez consulter I'horaire des émissions ultérieures uniquement.
S . . e . A .
¢  Pour de plus amples renseignements sur l'option Planifier un enregistrement, reportez-vous a la section «

Enregistrement d'émissions ».
e Enregistrer

Démarre instantanément l'enregistrement de 'émission sélectionnée.



Vérification de l'information sur I'émission en cours

Vous pouvez afficher de I'information sur I'enregistrement immédiat d'une émission ou appliquer la fonction
Timeshift a8 une émission que vous étes en train de regarder en appuyant sur la touche Enter pour la fenétre
Information, programme. En outre, vous pouvez voir de l'information sur les émissions a venir en utilisant les
fleches directionnelles gauche ou droite, ou vous pouvez programmer un Planifier un visionnement ou Planifier un
enregistrement concernant une émission en appuyant sur la touche Enter dans la fenétre Information, programme
qui est affichée pour cette émission.

B

La fonction d'enregistrement n'est pas prise en charge aux Etats-Unis et au Canada.

¢ Surlatélécommande standard, appuyez sur la touche INFO.

¢  Pour afficher linformation sur une émission, il faut d'abord régler I'horloge du téléviseur (MENU > Systéme > Heure >
Horloge).

¢  Pourde plus amples renseignements sur |'option Planifier un enregistrement, reportez-vous a la section «
Enregistrement d'émissions ».

¢  Linformation disponible sur les émissions peut varier selon le type de signal de diffusion et peut ne pas étre du tout
disponible dans le cas de certaines émissions.

¢ Pourde plus amples renseignements sur l'option Planifier un visionnement, reportez-vous a la section « Configuration de

I'option Planifier un visionnement ».

Changer le signal de diffusion
MENU/123 > MENU > Diffusion > Antenne &30

Vous pouvez choisir le mode DTV correspondant a votre environnement de visionnement. Sélectionnez le mode
Hertzien ou Cable. Le mode Hertzien convient aux foyers munis d'une antenne par satellite. Le mode Cable
convient aux foyers qui ont souscrit a un service de cable local ou assuré par un fournisseur de services par
satellite.

> e . . T Z x a z P
¢ N'utilisez pas cette fonction si votre téléviseur est connecté a un cablosélecteur ou un décodeur.

Vérification de I'
MENU/123 > MENU > Support technique > Autodiagnostic > Info. sur signal Z3LETDR
Vous pouvez vérifier des renseignements sur le signal de la chaine numérique, dont la force du signal.

> . . - N Lo T . . . .
¢ Siune antenne distincte est branchée a votre téléviseur, vous pouvez utiliser l'information sur la puissance du signal pour
régler I'antenne, optimiser la puissance du signal et améliorer la réception des chaines HD.

&  Cette fonction est disponible seulement pour les chaines numériques.



Enregistrement d'émissions

L'icéne c s'affiche a coté des émissions et chaines pour lesquelles une Programmation d'enregistrement a été
effectuée.

&  Cette fonction n'est pas disponible aux Etats-Unis et au Canada.

& Lisez toutes les précautions a prendre avant d'utiliser la fonction d'enregistrement. Reportez-vous a la section « Avant
d'utiliser les fonctions Enregistrement et Timeshift » pour plus d'information.

Enregistrement d'émissions

Vous pouvez enregistrer des émissions en cours et a venir.

Enregistrement instantané
Pour commencer a enregistrer immédiatement |'émission en cours, appuyez sur la touche MENU/123 et
sélectionnez la touche ®.

¢ Surlatélécommande standard, appuyez sur la touche @,

Utilisation des options d'enregistrement immédiat et Planifier un enregistrement a partir du
guide

Pour démarrer immédiatement I'enregistrement d'une émission en cours, sélectionnez cette derniére dans le Guide,
puis sélectionnez Enregistrer. Pour Planifier 'enregistrement d'une émission qui sera diffusée ultérieurement,

sélectionnez cette émission dans le Guide, appuyez sur la touche Enter et maintenez la pression, sélectionnez
Afficher les détails, puis sélectionnez enfin Planifier un enregistrement.

Utilisation des options d'enregistrement immédiat et Planifier un enregistrement a partir de
Information, programme

Pour démarrer immédiatement l'enregistrement ou planifier un enregistrement d'une émission, appuyez sur la
touche Enter. La fenétre Information, programme s'affiche.

Pour démarrer l'enregistrement immédiat d'une émission en cours, sélectionnez @

Pour programmer I'enregistrement immédiat d'une émission qui sera diffusée ultérieurement, appuyez sur la
touche directionnelle droite ou gauche, appuyez sur la touche Enter, puis sélectionnez .

¢ Surlatélécommande standard, appuyez sur la touche Enter ou la touche INFO.

Utilisation de I'option Planifier un enregistrement pour effectuer un enregistrement a une

date et une heure spécifiées

MENU/123 > Diffusion > Gestionnaire progr. > Horaire.

1. Sélectionnez Planifier un enregistrement.

2. Indiquez les renseignements ci-dessous pour |'émission que vous désirez enregistrer : Source, Chaine,
Répéter, Heure de début et Heure de fin. Pour terminer, sélectionnez OK.



Utilisation des fonctions disponible pendant I'enregistrement d'une émission

Appuyez sur la touche Entrer durant I'enregistrement d'une émission. Les touches suivantes et la barre de
progression d'enregistrement s'affichent.

e Plus d’information

Permet d’afficher de l'information détaillée sur I'émission dont I'enregistrement est en cours.

> " . . . L. . . . . .
¢ L'information disponible sur les émissions peut varier selon le signal de diffusion et peut ne pas étre du tout
disponible dans le cas de certaines émissions.

e Durée ENREG

Permet de régler I'heure a laquelle I'enregistrement commence.

e Arréter enregistrement / Aller a Télé en direct

Permet d'arréter I'enregistrement. / Permet de passer a I'écoute de la télévision en direct.

Utilisation des touches de la télécommande pendant I'enregistrement d'une
émission
e Pause/Lecture
Appuyez sur la touche p- ou 1 de la télécommande pour faire une pause ou reprendre l'enregistrement.

Lorsque 'enregistrement est en pause, vous pouvez utiliser les fonctions suivantes. Lorsque le mode
enregistrement est en pause, le son n'est pas pris en charge.

— Etape: Appuyez sur la touche MENU/123 de la télécommande Samsung Smart Control, et ensuite sur la
touche Il pour balayer une vidéo une trame a la fois.

@  Surlatélécommande standard, appuyez sur la touche Il

— Ralenti: Appuyez sur la touche MENU/123 de la télécommande Samsung Smart Control, et ensuite sur
la touche BY pour lire I'émission en cours a la moitié de la vitesse normale.

@  Surlatélécommande standard, appuyez sur la touche pp.
e Rembobinage / Avance rapide

Appuyez sur la touche MENU/123 de la télecommande Samsung Smart Control, puis sélectionnez KXl ou [3
pour accélérer le rembobinage ou I'avance rapide.

¢ Surlatélécommande standard, appuyez sur la touche 4€ou pp.

@  Cette fonction n'est pas disponible pendant que'une émission est en cours de diffusion.

Gestion de la liste des enregistrements programmés
MENU/123 > MENU > Diffusion > Gestionnaire progr.

Vous pouvez modifier les paramétres des enregistrements programmés, ou carrément les annuler.



Visionnement d'émissions enregistrées
> Envedette > MON CONTENU

1.

Sélectionnez un enregistreur USB. Le répertoire CONTENTS s'affiche.

2. Sélectionnez un fichier d'émission enregistré a partir du répertoire CONTENTS pour lire le fichier sélectionné.

Utilisation des fonctions disponible pendant la lecture d'une émission

Appuyez sur la touche Entrer. Les touches suivantes s'affichent. Pour masquer les touches, appuyez sur la touche
RETURN.

A

Les touches qui s'affichent varient en fonction du fichier en cours de lecture.
Pause / Lecture
Effectue une pause ou reprend la lecture du fichier de I'émission enregistrée.

Lorsque la vidéo est en pause, vous pouvez utiliser les fonctions suivantes. Toutefois, lorsque la vidéo est en
pause, le son n'est pas pris en charge.

— Etape: Appuyez sur la touche 11 pour balayer une vidéo une image a la fois.

— Ralenti: Appuyez sur la touche pp pour lire la vidéo & 1/2 de la vitesse normale.

Rembobinage / Avance rapide

Rembobinage/avance rapide. Pour rétablir la vitesse normale de lecture, appuyez sur la touche p-.
Précédent / Suivant

Appuyez une fois sur la touche |4« pour relancer du début la lecture de la vidéo en cours.

Pour jouer le prochain fichier d'émission enregistrée, sélectionnez la touche pp|.

Répéter

Joue plusieurs fois le fichier en cours ou tous les fichiers dans le méme dossier.



o Highlight Player

Affiche les moments forts de |'enregistrement en cours.

&  Cette fonction est disponible uniquement si vous avez enregistré les moments forts d'une émission qui a été
enregistrée en mode Mode Sports.

e Options
Fonction
Image Format
Sous-titres
Image Mode
Son Mode
Liste des haut-
parleurs

Son multi-piste

Information

Description

Permet de changer la taille de I'écran. Les formats d'image pris en charge différent selon la vidéo.
Permet d'activer ou de désactiver les sous-titres.
Affiche une liste des modes d'image et vous permet de changer de mode.

Affiche une liste des modes de son et vous permet de changer de mode.

Vous pouvez choisir quels haut-parleurs utiliser pour faire jouer le son.

Affiche une liste des langues et vous permet de sélectionner la langue audio qui sera utilisée
pendant la lecture des vidéos.

Cette fonction est disponible uniquement avec des fichiers qui prennent en charge un son
multipiste.

L'information détaillée sur le fichier en cours s'affiche.



Gestion des fichiers enregistrés

@ > Envedette > MON CONTENU
Sélectionnez un dispositif USB contenant les enregistrements. Une liste d'enregistrements s'affiche.

Utiliser les fonctions a I'écran des fichiers enregistrés

e Filtrer par
Affiche uniquement les fichiers qui correspondent au filtre sélectionné.
e Trier par
Classe les fichiers selon le mode de visionnement sélectionné.
&  Cette fonction n’est disponible que lorsque 'option Filtrer par est réglée a Tout.
e Supprimer

Permet de supprimer les fichiers sélectionnés, a I'exception des fichiers verrouillés.

&  Cette fonction n’est disponible que lorsque l'option Filtrer par est réglée a Tout.
e Liresélection

Permet de lire les fichiers sélectionnés. Sélectionnez les fichiers dans la liste de fichiers et ensuite
sélectionnez 'option Lecture.

Si le mode de visionnement est réglé en mode vue Dossier vous pouvez uniquement sélectionner les fichiers
compris dans le méme dossier. Pour ajouter a la liste de lecture des fichiers provenant d'autres dossiers,
modifiez le mode de visionnement.

&  Cette fonction n’est disponible que lorsque 'option Filtrer par est réglée a Tout.



Configuration de I'option Planifier un visionnement

. ~ [ N . P 0 . P 0 g .
L'icone 9 s'affiche en regard des émissions programmées sous |'option planifier un visionnement.

¢ Pour planifier le visionnement d'une émission, il faut d'abord régler I'horloge du téléviseur (MENU > Systéme > Heure >
Horloge).

Planifier un visionnement sur une chaine

Planifier un visionnement sur une chaine numérique
Vous pouvez planifier le visionnement d'une émission pour une chaine numérique dans le Guide ou a |'écran
Information.

e L'écran du Guide

A I'écran Guide, appuyez sur la touche directionnelle gauche ou droite pour aller & une émission que vous
souhaitez voir, puis appuyez sur la touche Enter. Vous pouvez sélectionner Planifier un visionnement dans le
menu contextuel qui s'affiche. Le visionnement de 'émission est programmé.

e Fenétre Information, programme

Appuyez sur la touche Enter pendant que vous regardez une émission. La fenétre Information, programme
s'affiche. Appuyez sur la touche directionnelle gauche ou droite pour aller a une émission que vous

souhaitez voir, puis appuyez sur la touche ENTER. Sélectionnez [ qui s'affiche dans la fenétre Information,
programme. Le visionnement de I'émission est programmeé.

¢  Surlatélécommande standard, appuyez sur la touche Enter ou INFO.

Planification d'un visionnement avec une chaine analogique

MENU/123 > MENU > Diffusion > Gestionnaire progr. S0

Vous pouvez aussi Planifier un visionnement de I'émission pour une chaine numérique. Sélectionnez Horaire >
Planifier un visionnement. Précisez les options Source, Chaine, Répéter et Heure de début pour I'émission que vous
voulez regarder et sélectionnez OK pour terminer.

Modifier la planification d'un visionnement
MENU/123 > MENU > Diffusion > Gestionnaire progr.

A l'écran Réservé, sélectionnez le visionnement planifié. Un menu contextuel s'affiche. Sélectionnez Modifier.
Changer I'heure, les jours ou la chaine. Sélectionnez OK lorsque vous avez terminé.

Annuler la planification d'un visionnement
MENU/123 > MENU > Diffusion > Gestionnaire progr.

A l'écran Réservé, sélectionnez le visionnement planifié. Un menu contextuel s'affiche. Sélectionnez Supprimer.
Sélectionnez OK dans le menu contextuel. Le visionnement planifié est supprimé.

¢ Vous pouvez enregistrer au maximum 30 Planifier un visionnement et entrées Planifier un enregistrement.



Utilisation du mode Timeshift

Vous pouvez mettre en pause et rembobiner I'émission en direct comme vous le feriez avec un DVD a l'aide de la
fonction Timeshift.

Le fait d'activer cette fonction désactive la fonction Diffusion.

VA
4

Cette fonction n'est pas disponible aux Etats-Unis et au Canada.

Lisez toutes les précautions a prendre avant d'utiliser la fonction Timeshift. Pour plus d'information, reportez-vous a la
section « Avant d'utiliser les fonctions Enregistrement et Timeshift ».

Pour activer la fonction Timeshift pendant que vous regardez la télévision, appuyez sur la touche Enter, puis

sélectionnez c dans la fenétre Information, programme. Le téléviseur affiche une barre de progression et les
touches ci-dessous dans la partie supérieure de I'écran:

Information
Permet d'afficher de l'information détaillée sur I'émission en cours.

¢  Linformation disponible sur les émissions peut varier selon le type de signal de diffusion et peut ne pas étre du tout
disponible dans le cas de certaines émissions.

&  Cette touche n'est disponible que lorsque vous regardez une émission en direct.
Enregistrer
Démarre instantanément I'enregistrement de I'émission en cours.
Aller a Télé en direct / Interrompre Timeshift

Permet de passer a la télévision en direct ou de quitter Timeshift.

Utilisation des touches de la télécommande pendant que vous utilisez la
fonction Timeshift

Pause / Lecture

Appuyez sur la touche p- ou 1 de la télecommande pour faire une pause dans I'émission en cours pendant
que vous utilisez la fonction Timeshift. Les fonctions suivantes sont disponibles lorsque I'émission en cours
est en mode pause. Toutefois, lorsque I'émission en cours est en mode pause, il n'y a pas de son.

— Etape: Appuyez sur la touche MENU/123 de la téléecommande Samsung Smart Control, et ensuite sur la
touche Il pour balayer une vidéo une trame a la fois.

¢  Surlatélécommande standard, appuyez sur la touche Il

— Lecture au ralenti : Appuyez sur la touche MENU/123 de la télécommande Samsung Smart Control, puis
sélectionnez la touche Xl ou B3 pour lire I'émission en cours a la moitié de la vitesse normale.

¢ Surlatélécommande standard, appuyez sur la touche 44 oupp.
Rembobinage / Avance rapide

Appuyez sur la touche MENU/123 de la télecommande Samsung Smart Control, puis sélectionnez KXl ou E3
pour accélérer le rembobinage ou I'avance rapide.

¢  Surlatélécommande standard, appuyez sur la touche 4<ou bp.

¢ Lafonction d'avance rapide n'est pas disponible pendant qu'une émission est en cours de diffusion.



Utilisation de la fonction Liste des chaines

MENU/123 > MENU > Diffusion > Liste des chaines T

En utilisant la fonction Liste des chaines, vous pouvez changer de chaine ou vérifier les émissions sur d'autres
chaines numériques pendant que vous regardez une émission. Pour afficher la fonction Liste des chaines, placez un

doigt sur la touche POINTER de la télécommande Samsung Smart Control, puis sélectionnez l'icéne @ qui apparait
du c6té droit de I'écran.

¢ Surlatéléecommande standard, appuyez sur la touche CH LIST.
L'écran Liste des chaines comprend les icones suivantes :
- : chaine analogique.
- . : chaine favorite.

- ﬂ : chaine verrouillée.

Appuyez sur la touche directionnelle gauche. Les fonctions suivantes sont disponibles :

e Historique
Une liste des chaines que vous avez récemment regardées s'affiche.
e Ajouter une liste
Vous permet de créer une nouvelle liste de chaines en ajoutant des chaines a partir d'une liste des favoris.
&  Cette fonction n'est disponible que si au moins une chaine a été ajoutée a au moins une liste de chaines favorites.
e Chaines aj.

Vous permet d'afficher la liste de chaines sélectionnée.

e Options
Option Description
Vous permet de sélectionner le mode Hertzien ou Cable comme mode de diffusion numérique (DTV).
Antenne Le mode Hertzien convient aux foyers munis d'une antenne distincte. Le mode Cable convient aux

foyers abonnés a un service local par cable local ou satellite. N'utilisez pas cette fonction si votre
téléviseur est connecté a un cablosélecteur ou un décodeur.

Modifier les listes

de chaines Vous permet de réorganiser l'ordre des chaines dans la liste des chaines ou d'en retirer certaines.

Vous permet de supprimer des chaines de l'index, récupérer des chaines supprimées et renommer
des chaines analogiques.

Modifier la chaine
Définit les chaines favorites.
Modif. favoris ¢ Pour plus d'information, reportez-vous a la section « Créer une liste personnelle de chaines
favorites ».



Enregistrer, retirer et modifier des chaines

MENU/123 > MENU > Diffusion > Modifier la chaine ZZHLE0

Les icénes de I'ecran Modifier la chaine indiquent :

e A :chaine analogique.
o : chaine favorite.

e  :chaineverrouillée.

Enregistrement et suppression de chaines

Retrait de chaines enregistrées

Vous pouvez retirer une chaine enregistrée ou toutes les chaines de I'index des chaines. Pour retirer une chaine,
sélectionnez-la et ensuite sélectionnez Supprimer. Pour retirer toutes les chaines, sélectionnez Options > Choisir

tout > Supprimer.

Rajouter des chaines retirées

Vous pouvez ajouter de nouveau les chaines retirées de la liste Tout. Les chaines supprimées s'affichent en gris
dans la liste Tout. Pour afficher la liste Tout, sélectionnez Options > Catégorie > Tout. Ensuite, pour rajouter une
chaine supprimée, sélectionnez-la puis sélectionnez Ajouter. Pour rajouter toutes les chaines retirées, sélectionnez

Options > Choisir tout > Ajouter.



Modifier les chaines enregistrées

Vous pouvez utiliser les fonctions ci-dessous en sélectionnant les Options qui se trouvent dans la partie inférieure
de I'écran. Les options disponibles peuvent varier en fonction du signal de diffusion.

Choisir tout / Désélectionner tout

Permet de sélectionner ou désélectionner toutes les chaines affichées a I'écran Modifier la chaine.
Antenne

Vous permet de sélectionner le mode Hertzien ou Cable comme mode DTV.

Catégorie

Permet d'afficher les chaines d'une catégorie sélectionnée dans la liste. Les chaines enregistrées sur le
téléviseur sont classées dans les catégories ci-dessous : Tout et Chaines aj. :

Modif. favoris
Définit les chaines favorites.

¢ Pour plus d'information, reportez-vous a la section « Créer une liste personnelle de chaines favorites ».
Renommer un canal
Permet de renommer les chaines analogiques. Le nouveau nom peut contenir jusqu'a 5 caractéres.
Information

Permet d'afficher de l'information détaillée sur I'émission en cours.



Utilisation du mode Verrouill. @missions
MENU/123 > MENU > Diffusion > Verrouill. émissions X5

Vous pouvez bloquer des émissions en fonction de leur classification en utilisant la fonction Verrouill. émissions.
Cette fonction est utile pour contréler ce que les enfants regardent. La fonction Verrouill. émissions ne bloque pas
les émission provenant de sources externes, comme les lecteurs Blu-ray, les lecteurs DVD ou les fichiers USB.

Chaque fois que vous accédez a la fonction Verrouill. émissions, vous devez entrer le NIP de sécurité. Vous devez
également entrer le NIP pour écouter une émission bloquée. Le NIP par défaut est 0000. Pour modifier le NIP, allez
a Systéme > Changer NIP.

g lise peut que |'option Verrouill. émissions ne soit pas prise en charge en fonction du signal d'entrée utilisé.

Bloquer des émissions en fonction de leur classification

Vous pouvez bloquer des émissions en fonction de leur classification. Pour bloquer un contenu, sélectionnez une
catégorie de classement a verrouiller. Toutes les émissions classées dans cette catégorie et dans les catégories
supérieures sont bloquées; pour y accéder, il faut entrer le NIP. Pour débloquer une catégorie, sélectionnez le
cadenas. Pour débloquer toutes les catégories d'une rangée, sélectionnez le cadenas sous ALL.

Catégories a gauche:

e TV-Y:jeunesenfants

e TV-Y7:enfants de 7 ans et plus

e TV-G:grand public

e TV-PG: surveillance parentale

e TV-14:téléspectateurs de 14 ans et plus
e TV-MA: adultes

Catégories en haut:

e ALL:blocage de tous les classements télé.
e FV:fantastique et violence

e V:violence

e S:sexualité

e G:langage adulte

e D:dialogues a caractére sexuel



Blocage de films selon le classement MPAA

Vous pouvez bloquer des films en fonction de leur classement MPAA. Cela s'applique a tous les contenus faisant
l'objet d'un classement aux Etats-Unis.

Classement MPAA :

« La Motion Picture Association of America (MPAA) a établi un systéme de classification qui fournit aux parents ou
adultes exercant une surveillance des renseignements sur les films convenant aux enfants. »

Sélectionnez le cadenas situé a c6té de la catégorie a bloquer; les catégories supérieures sont également bloquées
automatiquement. Pour débloquer une catégorie, sélectionnez le cadenas.

e V:grand public (aucune restriction).

e PG:surveillance parentale recommandée.

e PG-13: supervision des parents fortement recommandée.

e R:réservé.Les enfants de moins de 17 ans devraient étre accompagnés d’un adulte.
e NC-17:nonrecommandé aux enfants de moins de 17 ans.

e X:adultes seulement.

e NR:nonclassé.

Blocage d'émissions en fonction du Classement anglais canada

Vous pouvez bloquer des émissions en fonction de leur Classement anglais canada. Cette option s'applique a toutes
les émissions diffusées sur les chaines en anglais canadien.

Sélectionnez le cadenas situé a coté de la catégorie a bloquer; les catégories supérieures sont également bloquées
automatiquement. Pour débloquer une catégorie, sélectionnez le cadenas.

e C:émissions destinées aux enfants de moins de 8 ans

e (C8+:émissions convenant généralement aux enfants de 8 ans et plus, sans surveillance

e V:émissions grand public convenant a tous les auditoires.

e PG:surveillance parentale

e 14+:émissions dont la teneur peut ne pas convenir, en tout ou en partie, aux enfants de moins de 14 ans

e 18+:émissions pour adultes



Blocage d'émissions en fonction du Classement fr. canada

Vous pouvez bloquer des émissions en fonction de leur Classement fr. canada. Cette option s'applique a toutes les
émissions diffusées sur les chaines en francais canadien.

Sélectionnez le cadenas situé a coté de la catégorie a bloquer; les catégories supérieures sont également bloquées
automatiquement. Pour débloquer une catégorie, sélectionnez le cadenas.

V:général

8 ans+ : émissions convenant aux enfants de 8 ans et plus, sans surveillance
13 ans+ : émissions pouvant ne pas convenir aux enfants de moins de 13 ans
16 ans+ : émissions pouvant ne pas convenir aux enfants de moins de 16 ans

18 ans+ : émissions pour adultes

Blocage d'émissions selon la catégorie américaine applicable aux téléchargements

Vous pouvez bloquer des émissions en fonction de leur Catég. américaine téléchargeable. Ce systéme de
classification s'applique aux émissions diffusées sur les chaines numériques américaines.

L'information relative au contréle parental est automatiquement téléchargée lorsque vous écoutez des chaines
numeériques. Le téléchargement peut durer plusieurs secondes. Si information n’est pas accessible a partir de la
station de radiotélévision, le menu Catég. américaine téléchargeable est désactivé.

Les niveaux de contréle parental différent selon la station de radiodiffusion. Le nom du menu par défaut et le nom
de la Catég. américaine téléchargeable varient selon les données téléchargées.

Méme si vous réglez I'affichage a I’écran dans une autre langue, le menu Catég. américaine téléchargeable s’affiche
en anglais seulement.

Sélectionnez le cadenas situé a coté de la catégorie a bloquer; les catégories supérieures sont également bloquées
automatiquement. Pour débloquer une catégorie, sélectionnez le cadenas.

Regarder des émissions bloquées ou dont I'accés est restreint

Pour visionner une émission bloquée, vous devez saisir le NIP.

L'écran devient blanc lorsqu'une émission ou un film, dont I'accés est restreint, est bloqué par I'option Verrouill.
émissions. Pour débloquer |'émission, vous devez saisir le NIP a 'aide de la télécommande lorsqu'un message vous le
demande.



Créer une liste personnelle de chaines favorites

Les chaines favorites sont mises en évidence aux écrans Modifier la chaine et Liste des chaines grace au symbole
. Vous pouvez créer jusqu'a 5 listes de chaines favorites.

Enregistrer des chaines comme chaines favorites
MENU/123 > MENU > Diffusion > Modif. favoris
Vous pouvez enregistrer plusieurs chaines en méme temps dans la liste de chaines favorites.
1. Sélectionnez les chaines que vous voulez ajouter a vos listes de chaines favorites a partir de la liste a 'écran.

2. Sélectionnez Changer Fav. a I'écran pour sélectionner une liste de chaines favorites.

3. Seélectionnez la touche Ajouter a I'écran. Le téléviseur ajoute les chaines sélectionnées a la liste de chaines
favorites que vous avez choisie.

Visionner et sélectionner des chaines a partir des listes de chaines favorites
seulement.

MENU/123 > MENU > Diffusion > Liste des chaines

Vous pouvez afficher la liste de chaines favorites et sélectionner une chaine a l'aide des touches haut/bas.

1. Appuyez sur la touche directionnelle gauche. Une liste de chaines favorites s'affiche.

2. Surlignez une chaine dans la liste de chaines favorites sélectionnée en utilisant les touches ascendante/
descendante des chaines, puis sélectionnez-la. La chaine change.

g . ~ . A - . 2 . . . A~ .
¢  Cependant, la liste des chaines favorites ne peut étre sélectionnée que si elle contient au moins une chaine favorite.



Modifier la liste de chaines favorites

MENU/123 > MENU > Diffusion > Modif. favoris

Utiliser les éléments du menu a I'écran Modifier les chaines favorites
Vous pouvez accéder aux options suivantes en sélectionnant Options a I'écran Modif. favoris.

e Choisir tout / Désélectionner tout

Permet de sélectionner ou désélectionner toutes les chaines enregistrées.
e Copier dans Favoris

Sert a copier des chaines d'une liste de chaines favorites dans une autre.

> . . N . . ~ . A~ .
¢  Pour plus d'information, reportez-vous a la section « Copier des chaines d'une liste de chaines favorites dans une
autre ».

&  Cette fonction n'est disponible que si au moins une chaine a été ajoutée a au moins une liste de chaines favorites.
e Renommer les favoris
Sert a renommer une liste de chaines favorites existante.
¢  Pour plus d'information, reportez-vous a la section « Renommer une liste de chaines favorites ».
&  Cette fonction n'est disponible que si au moins une chaine a été ajoutée a au moins une liste de chaines favorites.
e Antenne
Vous permet de sélectionner le mode Hertzien ou Cable.
e Madifier la chaine
Vous sert a gérer les chaines enregistrées dans le téléviseur.

> . . N . . . g ~
¢  Pour plus d'information, reportez-vous a la section « Enregistrer, retirer et modifier des chaines ».



Retrait de chaines d'une liste de chaines favorites

Sélectionnez Modif. favoris. Sélectionnez Changer Fav. pour aller a la liste de chaines favorites contenant celles
que souhaitez retirer. Sélectionnez les chaines, puis choisissez Supprimer.

Changer l'ordre des chaines dans une liste de chaines favorites

Sélectionnez Modif. favoris. Sélectionnez Changer Fav. pour aller a la liste de chaines favorites contenant celles
que souhaitez réorganiser. Sélectionnez les chaines, puis choisissez Modif. ordre. L'ordre de réorganisation
surligné apparait. Appuyez sur les touches directionnelles haut/bas pour indiquer le nouvel emplacement des
chaines. Appuyez sur la touche Enter pour assigner les chaines a leur nouvel emplacement.

Renommer une liste de chaines favorites

Sélectionnez Options > Renommer les favoris. Sélectionnez la liste de chaines favorites que vous souhaitez
renommer. Entrez un nouveau nom a l'aide du clavier apparaissant a I'écran, puis sélectionnez Fait. Sélectionnez
OK.

Copier des chaines d'une liste de chaines favorites dans une autre

Sélectionnez Modif. favoris. Sélectionnez Changer Fav. pour aller a la liste des chaines favorites source, puis
sélectionnez les chaines a copier. Sélectionnez Options > Copier dans Favoris. Sélectionnez la liste de chaines
cibles, puis sélectionnez OK. Sélectionnez de nouveau OK.

> . . . . . . n ez b PO . ~ .
¢  Copier dans Favoris est disponible seulement si au moins une chaine a été ajoutée a une liste de chaines favorites.



Rendez vos émissions sportives plus réalistes avec le mode
Mode Sports

MENU/123 > MENU > Systéme > Mode Sports ou Mode Soccer D

Le mode Mode Sports offre une qualité d'image et de son optimale pour les événements sportifs, comme si l'on

se trouvait dans I'environnement réel. De plus si un dispositif d'enregistrement est connecté au téléviseur lorsque
vous utilisez le Mode Sports, vous pouvez voir les faits saillants de I'événement sportif enregistré, automatiquement
ou manuellement.

¢  Lenom courant peut différer selon les zones géographiques.

Désactiver le mode sports
MENU/123 > MENU > Systéme > Mode Sports ou Mode Soccer > Mode Sports ou Mode Soccer

Vous pouvez régler le Mode Sports a Activer pour optimiser les modes son et image du téléviseur pour les
événements de soccer.

¢  Enactivantla fonction, le Mode Sports passe Image Mode a Stade et Son Mode a Stade, et désactive les menus Image et
Son.

Extraction automatique des faits saillants
MENU/123 > MENU > Systéme > Mode Soccer > Sélection de faits saillants automatique ZZRLE0R

Vous pouvez régler Sélection de faits saillants automatique a Activer pour configurer le téléviseur de maniére a
extraire les faits saillants d'un événement sportif automatiquement.

Cependant, Sélection de faits saillants automatique n'est pas disponible :

- Lorsque vous changez le signal d'entrée avec la touche SOURCE.
— Lorsque le mode 3D est activé

— Lorsque la fonction Audio Description est activée

— Lorsque vous regardez du contenu enregistré sous Contenu

— Lorsque la fonction Screen Mirroring est en cours d'exécution

— Lorsque vous regardez les faits saillants du match de soccer en cours de diffusion en résolution UHD en
utilisant la fonction Highlight Player

&  Cette fonction n'est pas disponible aux Etats-Unis et au Canada.

¢ Lerendement de la fonction Sélection de faits saillants automatique varie en fonction des caractéristiques du signal
transmis.
J  llest préférable d'utiliser la fonction Sélection de faits saillants automatique seulement pour un match de soccer. Si

vous utilisez cette fonction pour d'autres événements sportifs pourrait provoquer l'affichage de trames d'images non
pertinentes.



Utilisation des fonctions disponibles lorsque vous regardez des événements
sportifs en mode sport

Vous pouvez utiliser les fonctions suivantes lorsque vous appuyez sur la touche Enter a la fenétre Information,
programme.

&  Cette fonction n'est pas disponible aux Etats-Unis et au Canada.
e Zoom

Permet de mettre en pause l'image en cours et d'agrandir toute partie de cette derniére en utilisant les 4
fleches directionnelles.

¢ Surlatélécommande standard, appuyez sur la touche IN.

¢ Vousne pouvez pas utiliser cette fonction lorsque vous regardez des chaines en 3D ou lorsque le mode ISI ou MON
CONTENU est activé.

e Enregistrement
Permet d'enregistrer instantanément la partie que vous écoutez actuellement au téléviseur.
&  Cette fonction est disponible uniquement si le téléviseur prend en charge la fonction d'enregistrement.
e Timeshift

Vous pouvez mettre en pause et rembobiner I'émission en direct comme vous le feriez avec un DVD a l'aide
de la fonction Timeshift.

&  Cette fonction est disponible uniquement si le téléviseur prend en charge la fonction d'enregistrement.
e Plus d’information
Permet d'afficher de l'information détaillée sur I'émission en cours.

> . . . . P . .
¢ Cette fonction n'est disponible que lorsque vous écoutez une émission en cours de diffusion.



Utilisation des fonctions disponibles lorsque vous enregistrez des
événements sportifs en mode sport

Vous pouvez utiliser les fonctions suivantes lorsque vous appuyez sur la touche Enter a la fenétre Information,
programme.

e Sélection manuelle

Permet d'enregistrer une vidéo 10 secondes avant d'appuyer sur cette touche jusqu'a 10 secondes aprés.

¢ Surlatélécommande standard, appuyez sur la touche B,

%

Vous pouvez régler le téléviseur de maniére a sauvegarder automatiquement les faits saillants sans l'intervention
de I'utilisateur. Sélectionnez MENU > Systéme > Mode Sports, et ensuite réglézSélection de faits saillants
automatique a Activer.

e Durée ENREG

Permet de régler I'heure a laquelle I'enregistrement commence.
e Arréter enregistrement / Aller a Télé en direct

— Arréte un enregistrement pendant que vous regardez une émission en direct.

— Permet de passer a une émission en cours de diffusion lorsque vous regardez une émission enregistrée.
e Rembobinage / Avance rapide

Appuyez sur la touche MENU/123 de la télécommande Samsung Smart Control, puis sélectionnez KXl ou E3
pour accélérer le rembobinage ou I'avance rapide.

@  Surlatélécommande standard, appuyez sur la touche 44 ou pp.
e Pause/Lecture

Permet d'interrompre ou de reprendre la lecture d'une vidéo.

e Lecteur de faits saillants

Permet d'afficher 'écran des Lecteur de faits saillants et d'effectuer la lecture des faits saillants enregistrés
automatiquement ou manuellement. Lecteur de faits saillants n'est pas disponible.

- Vous changez le signal d'entrée avec la touche SOURCE.
— Lemode 3D est activé
- Lorsque la fonction Description vidéo est activée

e Regarder la télé en direct en méme temps

Permet de regarder I'émission en cours dans la fenétre ISI tout en regardant une émission enregistrée. Pour
quitter le mode ISI, appuyez sur la touche de nouveau. Regarder la télé en direct en méme temps n'est pas
disponible lorsque :

- Vous changez le signal d'entrée avec la touche SOURCE.
— Lemode 3D est activé
— Lorsque la fonction Description vidéo est activée

- Lorsque vous regardez un match de soccer en résolution UHD

%

Cette touche n'est disponible que lorsque vous écoutez une émission enregistrée.



Visionnement d'un événement sportif enregistré en mode sports
Vous pouvez regarder un match enregistré a I'écran MON CONTENU.

&  Cette fonction n'est pas disponible sur certains modéles dans certaines zones géographiques particuliéres.
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@  Pour plus d'information, reportez-vous a la section « Visionnement d'émissions enregistrées ».

Fonctions de soutien au visionnement de la télévision

Etablir un fournisseur de services
MENU/123 > MENU > Smart Hub > Configurer fournisseur de serv.

Vous pouvez sélectionner le fournisseur de services qui doit étre utilisé. Suivez les directives a |'écran afin de régler
la source du signal et le fournisseur de services.

&  Cette fonction n'est pas disponible sur certains modeéles dans certaines zones géographiques particuliéres.

Afficher les sous-titres
MENU/123 > MENU > Systéme > Accessibilité > Sous-titres ZLE

Permet l'affichage de sous-titres pendant que vous regardez la télévision. Appuyez sur cette touche 7 et
maintenez la pression pour activer ou désactiver la fonction Sous-titres.
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@  Lessous-titres ne sont pas affichés par les émissions qui ne les prennent pas en charge.

¢ Surlatélécommande standard, appuyez sur la touche CC et maintenez la pression pour activer ou désactiver la fonction
Sous-titres.

Activation des sous-titres

Sélectionnez Systéme > Accessibilité > Sous-titres > Sous-titres

¢ Letéléviseur ne peut pas contréler ou modifier les sous-titres présents sur les DVD ou Blue-ray. Pour contréler les sous-
titres des DVD ou Blue-ray, utilisez la fonction de sous-titre du lecteur DVD ou Blue-ray et la télécommande du lecteur.

Sélection de la langue de sous-titrage
MENU/123 > MENU > Systéme > Accessibilité > Sous-titres > Mode ss-titres codés
e Pardéfaut/CC1~ CC4/Texte1 ~ Texte4

(Chaines analogiques seulement) Peut étre exécutée avec les chaines analogiques ou lorsque le signal recu
par le téléviseur provient d'un appareil externe. (Selon le signal de diffusion, il se peut que le sous-titrage
analogique ne fonctionne pas avec les chaines numériques.)

e Par défaut/ Service1 ~ Service6 / CC1 ~ CC4 / Texte1 ~ Texte4

(Chaines numériques seulement) Fonctionne avec les chaines numériques. Les fonctions Service1 a Service6
pourraient ne pas étre disponibles en mode de sous-titrage numérique, selon le systéme de diffusion utilisé.



Modification de la couleur et de I'opacité de la police ainsi que la taille des sous-titres

MENU/123 > MENU > Systéme > Accessibilité > Sous-titres > Options de sous-titrage numérique

Vous pouvez modifier les valeurs des parameétres de couleur de la police, de couleur de l'arriere plan et de la taille
des sous-titres.

e Taille

Sert a modifier la taille de la police. La fonction Taille n'est pas prise en charge par les chaines analogiques.
e Style des polices

Permet de choisir le style de la police des sous-titres.
e Couleur de police

Permet de changer la couleur de la police.
e Couleur arriére-plan

Permet de changer la couleur de l'arriére-plan des sous-titres.
e Couleur de la fenétre

Permet de choisir la couleur de la fenétre de sous-titrage numérique.
e Opacité de la police

Permet de changer l'opacité des sous-titres.
e Opacité arriére-plan

Permet de changer l'opacité de I'arriére-plan des sous-titres.
e Opacité de la fenétre

Permet de choisir le niveau de transparence de la fenétre de sous-titrage numérique.
e Typebord.

Permet de choisir le type de contour des sous-titres numériques.
e Cou. bord.

Permet de choisir la couleur du contour des sous-titres numériques.
e Retour par défaut

Permet de restaurer toutes les options d'affichage des sous-titres aux parameétres par Par défaut. Les
paramétres Par défaut appliquent aux sous-titres les réglages transmis par la station de diffusion.

& Les parametres d'opacité et de couleur de l'avant-plan et de l'arriére-plan ne peuvent étre identiques.



Activer le guide audio pour la description vidéo
MENU/123 > MENU > Systéme > Accessibilité > Description vidéo ZLED

Permet d'activer le guide audio pour les personnes malvoyantes. Cette fonction est disponible seulement avec

les diffusions qui offrent ce service. Appuyez sur la touche [ de la télecommande Samsung Smart Control en
maintenant la pression pour activer ou désactiver la fonction Description vidéo.

& Surlatélécommande standard, appuyez sur la touche CC et maintenez la pression pour activer ou désactiver la fonction
Description vidéo.

Recherche des chaines disponibles
MENU/123 > MENU > Diffusion > Prog. auto D

Recherche et indexe automatiquement toutes les chaines recues grace au connecteur d'entrée de I'antenne du
téléviseur.
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¢  Nutilisez pas cette fonction si votre téléviseur est connecté a un cable ou un décodeur.

> . I ~ . z . . . . . A~
@ Sile téléviseur a des chaines enregistrées, la fonction Prog. auto supprime la liste existante, puis sauvegarde les chaines
nouvellement balayées.

Sélection de la langue audio de diffusion
MENU/123 > MENU > Diffusion > Options audio ZLF

Vous pouvez sélectionner la langue audio du téléviseur. C'est la langue qui sera utilisée si elle est comprise dans les
langues audio prises en charge par le signal de diffusion. Les fonctions Options audio différent pour les chaines
analogiques et numériques.

& Pour avoir de linformation sur le signal audio de diffusion, appuyez sur la touche INFO de la télécommande standard.

Vous pouvez aussi appuyer sur la touche MENU/123 sur la télécommande Samsung Smart Control, puis sélectionner la
touche INFO a partir de la télécommande a I'écran.

Sélection de la langue audio de diffusion pour les chaines numériques

o Sélection d'une langue ZFTT

Sélectionnez Options audio > Langue privilégiée, puis choisissez une langue. Les émissions numériques
contenant la langue que vous avez choisie pour le signal de diffusion sont automatiquement lues dans cette
langue. Si la langue que vous avez choisie n'est pas prise en charge par le signal de diffusion, le téléviseur
utilisera la langue audio par défaut configurée par la station de télévision.



Sélection de la langue audio des émissions et autres options pour les diffusions analogiques

o Ecouter une sortie audio multipistes ZHE

Sélectionnez Options audio > Son multi-piste. Permet de configurer le son pour I'émission en cours de
diffusion. L'option Son multi-piste peut étre réglée sur le mode mono ou stéréo, en fonction du signal
de diffusion ou de I'émission. Cette option est automatiquement réglée sur le mode mono si le signal de
diffusion ou I'émission ne prend pas en charge le mode stéréo.

Sélectionnez I'émission pour voir si I'émission que vous étes en train de regarder est transmise avec une
piste comprenant une traduction simultanée dans la langue souhaitée. Si c'est le cas, sélectionnez la piste a
écouter pour entendre la traduction.

Syntonisation du signal en mode de diffusion analogique
MENU/123 > MENU > Diffusion > Config. des chaines > Syn. Précise &0

Lorsque les images en mode analogique tremblotent et sont accompagnées d'un bruit de fond, syntonisez le signal
pour avoir une image plus claire.

¢  Cette fonction n'est disponible que pour les chaines analogiques.

Retirer des chaines payantes
MENU/123 > MENU > Diffusion > Config. des chaines > Effacer les canaux brouillés

L'option Prog. auto recherche et indexe toutes les chaines, les chaines gratuites et les chaines payantes,
respectivement. Vous pouvez retirer toutes les chaines payantes brouillées de la liste des chaines a |'aide de l'option
Effacer les canaux brouillés.



Ajustement de la qualité de I'image

Sélectionnez le mode d’image.
MENU/123 > MENU > Image > Image Mode D

Vous pouvez sélectionner un mode d'image qui vous offre une qualité de visionnement du plus haut niveau.

¢
4

Dynamique
Permet d'avoir l'image plus claire lorsque la lumiére ambiante est si puissante qu'il est difficile de voir I'image.
Standard

C'est le mode par défaut qui convient a la plupart des environnements.

Naturel

Il réduit la fatigue oculaire.

Cinéma

Permet d'assombrir I'écran, de réduire I'éblouissement et de soulager la fatigue oculaire. Utilisez ce mode
lorsque vous regardez la télévision dans une piéce sombre ou lorsque vous regardez un film.

Divertiss.

Permet d'accentuer la netteté de l'image et offre une expérience de visionnement plus dynamique.

Lorsque la Source d'entrée est réglée a PC, seuls les modes Standard et Divertiss. sont disponibles.

Lorsqu'un ordinateur est branché au téléviseur, mais que le mode Divertiss. n'est pas disponible, réglez Modifier le type
de périphérique a DVI PC ou PC.

Stade

Lorsque vous réglez Mode Sports (MENU > Systéme > Mode Sports ou Mode Soccer > Mode Sports ou
Mode Soccer) sur Activer, les deux modes Image Mode et Son Mode sont automatiquement réglés a Stade.
Le téléviseur modifie les réglages de I'image et du son afin qu'ils soient adaptés aux événements de soccer.



Ajustement de la qualité de I'image
MENU/123 > MENU > Image

Vous pouvez ajuster les paramétres de la qualité de I'image manuellement pour toute combinaison d'une source
d'entrée et d'un mode d'image.

.

A

Contre-jour ZHED

Permet d'ajuster la luminosité et les pixels. Permet de réduire la luminosité afin de diminuer la consommation
électrique.

Contraste |m

Permet de régler le contraste de I'image.

Luminosité |m

Permet de régler la luminosité globale.

Netteté TN

Permet d'accentuer ou de diminuer la définition des bords des objets.

Couleur ZHFID

Permet de régler la saturation globale des couleurs.

Teinte (V/R) |m

Permet de régler le niveau du vert vers le rouge. Vous pouvez augmenter les valeurs du vert et du rouge
pour que ces couleurs deviennent saturées.

Le téléviseur enregistre les valeurs ajustées concernant la source d'entrée et le mode d'image en cours. Ces valeurs sont
applicables chaque fois que vous sélectionnez le méme mode d'image et la méme source d'entrée.

Les réglages Couleur et Teinte (V/R) ne peuvent étre ajustés lorsque le téléviseur est branché & un ordinateur par
l'intermédiaire d'un cable HDMI vers DVI.

Appliquer les réglages de l'image en cours a d'autres sources d'entrée

MENU/123 > MENU > Image > Appliquer le mode image b0

Vous pouvez appliquer les réglages de la qualité d'image a la source en cours et a d'autres sources d'entrée.

Toutes sources
Applique les réglages a tous les appareils externes branchés au téléviseur.
Source active

Applique les réglages a la source d'entrée en cours seulement.



Ajustement des réglages avancés
MENU/123 > MENU > Image > Réglages avancés 29
Vous pouvez ajuster l'affichage des images a I'écran pour les modes standard et cinéma.

¢ L'option Réglages avancés n'est disponible que lorsque la Image Mode est réglée sur Standard ou Cinéma.

o Lorsque le téléviseur est branché & un ordinateur au moyen d'un cable HDMI vers DVI, seules les options Equilibrage du
blanc et Gamma sont disponibles.

o Contraste dyn. ZUFTD

Ajuste automatiquement le contraste de Iimage pour avoir un réglage optimal du contraste.

o Tonalité noire YLD

Permet de régler la profondeur du noir.

e Ton chair |m

Permet d'assombrir ou d'éclaircir les tons chair.

e Mode RVB uniqu. ZIFIR

Permet de régler les niveaux du rouge, du vert et du bleu séparément.

o Espace couleur ZHIFD

Permet de régler la gamme de couleurs qui peuvent étre affichées a 'écran.

— Auto : ajuste automatiquement I'espace de couleur afin de correspondre au signal d'entrée.
— Natif : applique une gamme de couleurs plus large que le signal d'entrée.

— Personnalisé : permet d'ajuster manuellement I'espace de couleur. Sélectionnez Couleur, et modifiez les
saturations du Rouge, Vert et Bleu. L'option Régler vous permet de restaurer les valeurs par défaut pour
la Espace couleur.
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¢  Vous pouvez configurer la fonction Couleur uniquement si 'option Espace couleur est réglée a Personnalisé.

o Equilibrage du blanc ZFH

Permet de régler la température de la couleur de I'image pour que les objets blancs paraissent blancs; ainsi,
l'intégralité de l'image parait naturelle.

— 2 Points : vous permet de régler la luminosité du rouge, du vert et du bleu grace au menu Décal. et la

luminosité grace au menu Gain. L'option Régler vous permet de restaurer les valeurs par défaut.

— 10 Points : permet de diviser le vert, le rouge et le bleu en 10 sections chacun, et de modifier I'équilibrage
des blancs en réglant la luminosité de chacune des sections. L'option Niveau vous permet de sélectionner
la section a ajuster.

¢ Vous pouvez utiliser la fonction 10 Points uniquement si I'option Image Mode est réglée a Cinéma. Il se peut que
certains appareils externes ne prennent pas en charge cette fonction.

e Gamma |m

Permet de régler I'intensité de la couleur primaire.



Ajustement des options d'image
MENU/123 > MENU > Image > Options d'image 500

Vous pouvez ajuster les options d'image pour avoir une qualité de visionnement du plus haut niveau. Sélectionnez
un mode d'image, et ensuite ajustez les options d'image.

e Nuance coul. ZHFTD

Permet de régler la nuance de couleur. La nuance de couleur que vous sélectionnez est enregistrée dans la
mémoire du téléviseur. Lorsque vous changez le mode d'image en cours, la nuance de couleur enregistrée
s'applique automatiquement au nouveau mode d'image.

& Les options Froide et Standard ne sont disponibles que lorsque Image Mode est réglé a Dynamique.

¢ Nuance coul. est uniquement accessible lorsque le téléviseur est branché a un ordinateur a l'aide d'un cable HDMI-
DVI.

o Image claire numérique ZLFID

Permet d'éliminer les parasites et les images rémanentes causées par un signal faible. Lorsque vous
sélectionnez le mode Visualisation auto, le téléviseur affiche la force du signal au bas de I'écran. Le vert
indique le meilleur signal possible.

&  Cette fonction n'est disponible que pour les chaines analogiques.

o Filtre bruit MPEG L FTD

Permet de réduire le bruit MPEG et d'améliorer la qualité vidéo.

o Nvnr HDMI ZFD

Compense les effets causés par un faible niveau de noir, comme des contrastes faibles et des couleurs
ternes.

&  Cette fonction est disponible uniquement lorsque le signal d'entrée, et que la connexion au téléviseur est assurée
par un connecteur HDMI, est réglé a RGB444.

e Mode Film |m

Permet d'optimiser la qualité de l'image pour les films.

&  Cette fonction est disponible seulement lorsque le signal d'entrée est TV, AV, Composante (480i, 1080i), ou HDMI
(1080i).



HDMI UHD Color

Vous permet de régler le mode HDMI UHD Color a Activer ou Désactiver pour chacun des connecteurs
HDMI du téléviseur. Lorsque le mode est réglé a Activer, le téléviseur optimise le traitement des signaux UHD
50P/60P.
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@  Sivous réglez la connexion HDMI & Activer, le téléviseur se met automatiquement hors tension et de nouveau sous
tension.

¢  La connexion HDMI avec l'option HDMI UHD Color réglée a Désactiver prend en charge des signaux d'entrée jusqu'a
UHD 50P/60P 4:2:0, alors que la connexion HDMI avec 'option HDMI UHD Color réglée a Activer prend en charge
des signaux d'entrée jusqu'a UHD 50P/60P 4:4:4 et 4:2:2. Pour avoir de plus amples renseignements, reportez-vous
a la rubrique "Résolutions prises en charge pour chaque type de signaux d'entrée UHD".

&

Chacune des connexions HDMI peut étre optimisée individuellement en ce qui a trait a la HDMI UHD Color. Lorsque
vous connectez le téléviseur a I'appareil externe qui prend en charge uniquement la fréquence 24 ou 30 Hz UHD
ou toute fréquence FHD, il se peut que la fonction couleur HDMI UHD ne soit pas disponible. Dans ce cas, réglez la
fonction HDMI UHD Color a Désactiver.

Auto Motion Plus |

Permet d'éliminer le flou et 'effet de flou de scénes trés animées. Si vous sélectionnez la fonction
Personnalisé, vous pouvez configurer les options Réduction du flou et Réd. effet de flou manuellement
et régler DEL mouvement clair a Activer pour obtenir une image DEL plus nette. Pour retourner aux
parameétres par défaut, sélectionnez Régler.
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¢  Lorsque l'option DEL mouvement clair est réglée a Activer, |'écran est plus sombre que lorsqu'elle est sur
Désactiver.

DEL Intelligentes

Permet de contréler la luminosité de zones individuelles a I'écran afin de maximiser le contraste de lI'image
automatiquement.

Noir cinéma

En mode Cinéma, cette fonction réduit la luminosité des zones situées en haut et en bas de 'image vidéo afin
de vous offrir une plus grande expérience immersive.

&  Cette fonction n'est pas disponible sur certains modeéles dans certaines zones géographiques particuliéres.



Visionnement 3D

MENU/123 > MENU > Image > 3D

Vous pouvez visionner des diffusions et du contenu en 3D. Pour pouvoir voir du contenu 3D, vous devez porter les
lunettes Samsung 3D Active. Les lunettes 3D Active de Samsung de type IR ou les lunettes 3D d'un autre fabricant
ne sont pas connecteurs en charge.

&  Cette fonction n'est pas disponible sur certains modéles dans certaines zones géographiques particuliéres.
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@ Sileslunettes Samsung 3D Active ne sont pas fournies avec le téléviseur, achetez-les séparément.

¢ Lisez attentivement les instructions de santé et sécurité concernant le visionnement de contenus en 3D avant de
visionner du contenu en mode 3D. Pour plus d'information, reportez-vous a la section « Précautions a suivre pour
visionner du contenu 3D ».

¢ L'affichage en haute définition de la vidéo 3D dépend habituellement de la qualité et du format du contenu.

Démarrage de la fonction 3D
MENU/123 > MENU > Image > 3D

Mettez et activez les lunettes 3D Samsung, et ensuite sélectionnez un mode Mode 3D. Veuillez noter que les modes
3D qui sont disponibles a un moment précis dépendent du format du contenu 3D.

. (Off)

Désactive le visionnement 3D.

o (Normal)

Convertit les images normales en images 3D.
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¢  Lestypes de résolutions prises en charge varient selon le mode. Pour plus d'information, reportez-vous a la section «
Résolutions prises en charge pour les modes 3D ».

La distance de visionnement idéale est d’au moins trois fois la hauteur de I’écran. Les images 3D pourraient ne pas
étre affichées si vous ne respectez pas les angles ou la distance de visionnement recommandés.

La fonction 3D peut ne pas fonctionner correctement si un autre produit ou appareil électronique 3D est sous
tension a proximité. En cas de probléme, éloignez le plus possible les autres appareils électroniques des lunettes
3D Active.

Les images 3D de droite et de gauche pourraient se superposer plus qu'a I'habitude lorsque le téléviseur est allumé.
Il faut un moment pour que l'affichage soit optimisé et que la superposition cesse.

Lorsque vous choisissez d'utilisez le mode 3D, prenez en considération les restrictions suivantes :

e Lemode 3D se désactive automatiquement lorsque vous lancez Smart Hub.
e L'option ISl ne peut pas étre utilisée.

e Certaines options d'image sont désactivées.



Ajustement des effets 3D
MENU/123 > MENU > Image > 3D

Régle les paramétres du point de référence visuel, de profondeur et autres paramétres 3D pour personnaliser
votre expérience de visionnement.

¢ Tousles effets 3D & I'exception de Affichage 3D auto peuvent étre utilisés lors du visionnement d'un contenu 3D.

e Perspective 3D

Ajuste la perspective 3D d'ensemble pour les images a I'écran.
e Profond 3D

Ajuste la profondeur 3D d'ensemble pour les images a I'écran.
e Inversion G/D

Permute l'image de gauche vers la droite et I'image de droite vers la gauche.
e 3D->2D

Permet de convertir les images 3D en images normales.

&  Cette fonction n'est pas disponible si le mode Mode 3D est réglé & Bl (Normal) ou Kl (Off).

e Affichage 3D auto

Active le Mode 3D automatiquement lorsqu'il détecte du contenu ou une émission 3D.

Auto1 commute automatiquement I'écran du téléviseur a un écran 3D lorsque le téléviseur détecte du
contenu 3D ou une émission contenant de l'information 3D.

Auto2 commute automatiquement I'écran du téléviseur a un écran 3D lorsque le téléviseur détecte du
contenu 3D lorsque le téléviseur détecte du contenu 3D ou une émission indépendamment du fait qu'elle
contienne de l'information 3D.

e Optimisation 3D
Vous permet d'optimiser les images 3D a l'aide d'une barre d'ajustement.

g . T . . .
¢ |l se peut que vous ne puissiez pas regarder la télévision en mode 3D pendant que certaines applications sont en
cours d'exécution. Pour regarder la télévision en mode 3D, quittez ces applications.



Fonctions de connecteur en charge de I'image

Mode de visionnement image sur image (ISI)
MENU/123 > MENU > Image > ISI ZE0D

Lorsque vous regardez une vidéo a partir d'un appareil externe tel qu'un lecteur Blu-ray sur I'écran principal, vous
pouvez regarder une émission de télévision dans la fenétre Image sur image.

o ISI

Permet d'activer/de désactiver la fonction ISI.
e Antenne

Permet de sélectionner Hertzien ou Cable comme mode de chaine numérique.
e Chaine

Permet de sélectionner la chaine ISI.
e Taille

Permet de régler la taille de la fenétre ISI.
e Position

Permet de régler la position de la fenétre ISI.
e Sélectionson

Permet de sélectionner la source audio. Pour ajuster le volume de I'appareil audio branché, vous devez
utiliser la fonction Sound Share ou connecter la source audio au port HDMI (ARC) du téléviseur.

¢ Vousne pouvez pas utiliser la fonction ISl lorsque la fonction Smart Hub ou 3D est activée.

& Jouer ou utiliser la fonction karaoké sur 'écran principal peut diminuer la qualité de I''mage en mode ISI.

¢ Lafonction ISl est disponible uniquement selon les conditions suivantes : 1) La source de I'écran principal est une
connexion Composantes ou HDMI. 2) La résolution d'entrée est inférieure a la qualité FHD (HD intégrale).

¢ Lafenétrels| prend en charge seulement les chaines numériques et ne prend pas en charge les chaines UHD.



Modifier la position et la taille de I'image

Modifier le format de I'image

MENU/123 > MENU > Image > Image Format > Image Format S, P

Vous pouvez modifier la taille des images affichées a I'écran.

A

21:9
Réglez I'i'mage au format écran large 21:9.
¢  Cemode est pris en charge seulement par les téléviseurs de série SOW.

Auto

La taille de I'image s'ajuste automatiquement en fonction du signal vidéo d'entrée. Cependant, la taille de
I'image peut étre modifiée en fonction des sous-titres, des logos ou de tout autre contenu affiché a I'écran.

¢ Cemode est pris en charge seulement par les téléviseurs de série SOW.

& lise peut que ce mode ne fonctionne pas correctement en fonction des signaux d'entrée.
16:9
Réglez I''mage au format écran large 16:9.
Zoom

Permet d'agrandir verticalement I'image 16:9. Vous pouvez déplacer une image agrandie vers le haut ou vers
le bas.

Sous-titres

Vous permet de modifier les réglages des sous-titres pour pouvoir lire les sous-titres plus facilement lorsque
vous regardez une vidéo sous-titrée.

¢  Cemode est pris en charge seulement par les téléviseurs de série SOW.

Personnalisé

Permet d'agrandir ou de diminuer les images 16:9 verticalement ou horizontalement. Vous pouvez déplacer
une image agrandie ou diminuée vers la gauche, vers la droite, vers le haut ou vers le bas.

4:3

Permet de régler la taille de I'image au mode 4:3.

Il ne faut pas régler votre téléviseur au format d'image 4:3 pendant de trop longues périodes. Cela peut
entrainer I'apparition de barres noires en haut, en bas, a gauche et a droite de I'écran en mode 4:3 qui
causent des « brilures d'écran » et qui restent de maniére temporaire ou permanente a I'écran. Tout

endommagement de I'écran n'est pas couvert par votre garantie.

Les tailles d'image prises en charge different selon le signal d'entrée. Pour de plus amples renseignements sur les tailles
d'image prises en charge, reportez-vous a la section « Dimensions de l'image et signaux d'entrée ».



Ajuster la taille de I'image a I'écran

MENU/123 > MENU > Image > Image Format > Ajust a I'écran
Vous pouvez configurer le téléviseur de sorte que toute l'image couvre I'écran sans coupure de la taille choisie.

&  Cette fonction ne sera pas toujours disponible, en fonction de la Image Format.

Ajustement de la position de lI'image

MENU/123 > MENU > Image > Image Format > Zoom/Position
Vous pouvez ajuster la position de l'image.

&  Cette fonction ne sera pas toujours disponible, en fonction de la Image Format. Cependant, vous ne pouvez pas modifier
la position de I'image lorsque le téléviseur est réglé sur une chaine numérique et que la Image Format est réglée a
Personnalisé.

Utiliser la fonction Panorama Plus

MENU/123 > MENU > Image > Image Format > Panorama Plus

Le téléviseur ajuste le ratio du centre de I'image aux bords de I'écran avec que votre expérience de visionnement
soit plus immersive.

& Cette fonction est prise en charge seulement par les téléviseurs de série 82S9W.

&  Cette fonction ne sera pas toujours disponible, en fonction de la Image Format.

Ecouter en mode audio seulement (Image non)
MENU/123 > MENU > Image > Image Non ZZ4.FTI

Vous pouvez désactiver I'écran et exécuter la lecture audio par les haut-parleurs seulement. Pour rallumer I'écran,
appuyez sur une touche (sauf les touches du volume et de mise sous tension).

Réinitialiser les réglages du mode Image
MENU/123 > MENU > Image > Réinitial. image X500

Vous pouvez réinitialiser le mode d'image en cours a ses valeurs par défaut. Cette procédure n'a pas d'incidence sur
les autres modes d'image.



Ajustement de la qualité du son

Sélectionner un mode de son.
MENU/123 > MENU > Son > Son Mode 5D

Vous pouvez sélectionner le mode de son pour avoir une qualité d'écoute du plus haut niveau.

Standard

C'est le mode par défaut qui convient a la plupart des environnements.
Musique

Accentue la musique et non les voix.

Cinéma

Offre le meilleur son pour les films.

Voix claire

Accentue les voix.

Amplifier

Accroit l'intensité d'ensemble du son haute fréquence pour aider les malentendants.
Stade

Lorsque vous réglez le Mode Sports (MENU > Systéme > Mode Sports ou Mode Soccer) a Activer, I'option
Son Mode est réglée automatiquement a Stade de sorte que les réglages du son et de l'image sont définis
comme ceux étant les plus adéquats pour les événements de soccer.



Appliquer les effets sonores
MENU/123 > MENU > Son > Effet sonore 20000

Les effets sonores vous permettent de modifier le son provenant du téléviseur.

e Virtual Surround |m

Produit un son qui vous donne l'impression d'étre dans une salle de cinéma ou dans une salle de concert.

o Dialog Clarity 4D
Cette fonction permet de mieux entendre les dialogues en augmentant l'intensité des dialogues.

e Son ambiophonique des écouteurs

Grace a votre casque d'écoute, vous serez immergé dans un son ambiophonique comme celui de votre
systéme de cinéma maison.

&  Cette fonction n'est pas disponible sur certains modeéles dans certaines zones géographiques particuliéres.

o Balance ZJID

Vous permet d'ajuster les réglages du son des haut-parleurs gauche et droit pour avoir un meilleur équilibre
du son. Pour restaurer les valeurs par défaut, sélectionnez Régler.

o Egaliseur ZHFID

Vous permet de régler la sonie de certaines gammes de fréquence afin de contréler la richesse du son. Pour
restaurer les valeurs par défaut, sélectionnez Régler.

&  Cette fonction n'est pas disponible lorsque le mode audio passe par les haut-parleurs externes.

&  Cette fonction n’est accessible que lorsque l'option Son Mode est réglée a Standard.



Personnalisation du son
MENU/123 > MENU > Son > Personnalisation son ZZ4.E 0

Vous permet d'étalonner le téléviseur pour obtenir une qualité de son optimale en fonction de vos capacités
auditives et des sons ambiants.

Appliquer un profil de son personnalisé

MENU/123 > MENU > Son > Personnalisation son > Profil de son perso 23T

Lorsqu'il y a plusieurs profils de son personnalisés, vous pouvez sélectionner celui que vous voulez appliquer a
partir de la liste.

Créer un profil de son personnalisé

MENU/123 > MENU > Son > Personnalisation son > Ajouter son perso ZZHuE0

Une analyse en 6 étapes démarre. Suivez les instructions a I'écran pour terminer I'analyse.

Modifier un son personnalisé

MENU/123 > MENU > Son > Personnalisation son > Modifier les sons 5L

Vous pouvez modifier un profil de son personnalisé. Sélectionnez un Profil de son perso que vous voulez modifier.
Une analyse en 6 étapes démarre. Suivez les instructions a I'écran pour terminer l'analyse.

Renommer ou supprimer des profils de son personnalisés.

MENU/123 > MENU > Son > Personnalisation son > Gérer le son perso S0
Vous pouvez renommer ou supprimer un profil de son personnalisé dans la liste de sons personnalisés.

1. Sélectionnez un Profil de son perso que vous voulez renommer ou supprimer.

2. Sélectionnez Renommer ou Supprimer. Le clavier s'affiche a I'écran si vous sélectionnez I'option Renommer.
Servez-vous du clavier pour changer le nom.



Utilisation des fonctions de soutien du son

Sélection des haut-parleurs
MENU/123 > Liste des haut-parleurs

¢ Surlatélécommande standard, appuyez sur la touche TOOLS, et sélectionnez I'option Liste des haut-parleurs. Ou,
ajustez le volume, et ensuite appuyez sur la touche €.

Vous pouvez choisir les haut-parleurs qui seront utilisés pour la sortie audio. Lorsque vous branchez au téléviseur
plusieurs haut-parleurs compatible avec I'application Samsung Multiroom, vous pouvez en sélectionner certains
selon le nombre de haut-parleurs et leur emplacement, et vous pouvez également utiliser les dispositifs Bluetooth
pour la sortie audio.

V4 Lorsque le mode Liste des haut-parleurs est réglé de telle sorte que le son provient de haut-parleurs externes seulement,
les touches Volume et Mute et certaines fonctions audio sont désactivées.
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¢ Le mode haut-parleur Multiroom est disponible seulement lorsque, au moins, un haut-parleur Samsung Multiroom
compatible est connecté au téléviseur.

¢ La qualité du son peut étre affectée par I'état du réseau sans fil.

f Le haut-parleur Multiroom est désactivé lorsque vous activez la fonction Screen Mirroring.

& Les haut-parleurs branchés en réseau peuvent se déconnecter automatiquement, en fonction des conditions
environnementales du réseau.

¢ Pour avoir de plus amples renseignements au sujet de la fonction Multiroom, reportez-vous au site Web Samsung. (www.
samsung.com > PROPRIETAIRES & SOUTIEN > Guides de logiciel & Téléchargements)

¢  Le mode audio de chacun des appareils secondaires peut étre décalé par rapport aux modes vidéo et audio de I'appareil

principal sur lequel joue le contenu de la source.

Ecouter le son du téléviseur au moyen d'un appareil audio Bluetooth
Samsung
MENU/123 > MENU > Son > Paramétres supplém. > Connex son du téléviseur

Vous pouvez brancher les appareils audio Bluetooth au téléviseur. lls doivent étre appariés a l'aide de la fonction
Bluetooth du téléviseur. Pour en savoir davantage sur le pairage, reportez-vous au guide d'utilisation de 'appareil
audio Bluetooth Samsung.

e Ajouter un appareil

Permet d'ajouter un nouvel appareil a la liste des appareil appariés. Les signaux de connexion des nouveaux
appareils sont ignorés si la fonction Ajouter un appareil est réglée a Désactiver.

e Liste d'appareils audio Samsung

Permet d'afficher une liste des appareils audio Samsung appariés. Sélectionnez un appareil pour afficher les
options du menu. Vous pouvez activer ou désactiver I'appareil audio ou le supprimer de la liste.

A

Cette fonction est disponible uniquement pour les appareils audio Samsung qui prennent en charge l'optionConnex son
du téléviseur.

4 L'option Connex son du téléviseur, Surround et les dispositifs Bluetooth ne peuvent pas étre utilisés simultanément.

A

vant d'utiliser un appareil Bluetooth, reportez-vous a la section « Read A lire avant d'utiliser les appareils Bluetooth ».



Ecouter le son du téléviseur a I'aide de dispositifs Bluetooth
MENU/123 > MENU > Son > Paramétres supplém. > Sortie audio Bluetooth

Vous pouvez brancher les dispositifs Bluetooth au téléviseur. lls doivent étre appariés a l'aide de la fonction
Bluetooth du téléviseur. Pour en savoir davantage sur le pairage, reportez-vous au guide d'utilisation du dispositif
Bluetooth.

N

&

"

Appareils audio Bluetooth

Affiche une liste de dispositifs Bluetooth qu'il est possible d'apparier au téléviseur. Sélectionnez un dispositif
Bluetooth pour afficher les options du menu. A partir de ce menu, vous pouvez activer ou désactiver (c.-a-d.
apparier/ne pas apparier) le dispositif Bluetooth ou le supprimer de la liste.

Son a sorties multiples

Vous permet d'avoir le son simultanément par les haut-parleurs du téléviseur et les dispositifs Bluetooth
branchés.

Lorsque le mode Multi-Link Screen est désactivée, le dispositif Bluetooth se déconnecte du téléviseur.

Si le téléviseur ne détecte pas un dispositif Bluetooth, rapprochez-le du téléviseur, puis sélectionnez la fonction
Rafraichir.

Si vous mettez sous tension un dispositif Bluetooth pour lesquels vous avez déja effectué le pairage, le téléviseur
le détecte automatiquement et une fenétre contextuelle s'affiche. La fenétre contextuelle vous permet d'établir la
connexion au dispositif Bluetooth.

vant d'utiliser un appareil Bluetooth, reportez-vous a la section « Read A lire avant d'utiliser les appareils Bluetooth ».

Configurer des fonctions supplémentaires
MENU/123 > MENU > Son > Paramétres supplém. ZuET0

Vous pouvez personnaliser la qualité du son en ajustant les paramétres suivants.

Format audio HDMI

Régle le format du signal d'entrée audio adéquat pour que l'appareil externe soit branché a un des ports
HDMI du téléviseur.

Format audio |m

Permet de sélectionner le format de sortie audionumérique (SPDIF). Les formats disponibles dépendent de la
source d'entrée.

Retardateur audio TR

Permet de corriger les problémes de synchronisation audio-vidéo lorsque vous regardez un programme
télévisé tout en écoutant une sortie audio numérique provenant d'un appareil externe. Vous pouvez ajuster
un décalage allant jusqu'a 250 ms.



e Comp. Dolby num. ZFID

Régle le mode de compression Dolby Digital.
e AudioHD

Procure un son en qualité audio HD.

¢ Uun signal audio standard fait I'objet d'un échantillonnage a 48 kHz, alors qu'un signal audio HD fait I'objet d'un
échantillonnage a 96 kHz.

& llest possible que certains récepteurs S/PDIF ne soient pas compatibles. Si votre récepteur est incompatible,
désactivez ce mode et utilisez plutét le mode audio normal.

¢ Un signal audio HD disponible sur le téléviseur ne sera pas disponible sur des lecteurs audio externes connectés par
HDMI, Bluetooth ou un réseau Wi-Fi.

¢ Volume auto |w

Ajuste automatiquement le volume du téléviseur lorsque vous changez de chaine, de source vidéo ou de
contenu de sorte que le niveau de volume soit le méme pour toutes les sources. Le mode Volume auto peut
modifier le volume de 12 db au maximum pour égaliser le son. Normal applique un volume normal et Nuit
applique un volume légérement plus bas. Cette option est idéale pour regarder la télévision tard dans la nuit.

g . ™ . 2 ~
¢  Sivous voulez utiliser la commande du volume d'un appareil source externe branché pour contréler le volume, vous
devez désactiver la fonction Volume auto. Lorsque vous utilisez la fonction Volume auto avec un appareil source
externe, il se peut que la commande du volume ne fonctionne pas correctement.

Ecouter le son 3D en mode 3D
MENU/123 > MENU > Son > Audio 3D

Vous pouvez ajouter |'amplitude de sorte que le téléviseur offre un environnement d'immersion qui corresponde a
l'effet saisissant 3D du contenu que vous étes en train de regarder.

&  Cette fonction n'est pas disponible sur certains modéles dans certaines zones géographiques particuliéres.

&  Cette fonction n’est disponible qu’en mode 3D.

Cette option permet de préciser le type d'installation du téléviseur.
MENU/123 > MENU > Son > Paramétres supplém. > Haut-parleur TV > Type d'installation télé

Vous pouvez spécifier le type d'installation Mural ou Socle afin d'optimiser automatiquement le son du téléviseur.

Réinitialisation de tous les réglages du son
MENU/123 > MENU > Son > Réinitial. son ZuEID

Permet de rétablir tous les réglages du son aux réglages définis par défaut.



Configuration de I'heure et utilisation de la minuterie

Réglage de I'heure actuelle
MENU/123 > MENU > Systéme > Heure > Horloge ZZ P

Vous pouvez régler I’'horloge manuellement ou automatiquement. Une fois I'horloge réglée, vous pouvez voir
I'heure courante sur le téléviseur en tout temps. Appuyez sur la touche MENU/123 puis sélectionnez INFO.

¢ Surlatélécommande standard, appuyez sur la touche INFO.

¢ lifaut régler I’horloge de nouveau chaque fois que le téléviseur est débranché du secteur d'alimentation.

Réglage de I'horloge a partir de I'écran d'information sur la diffusion numérique

MENU/123 > MENU > Systéme > Heure > Horloge > Mode horloge ZZH FI

Vous pouvez régler le téléviseur de sorte qu'il télécharge I'information d'une chaine numérique et régle I'heure
actuelle. Pour activer cette fonction, réglez I'option Mode horloge a Auto. Vous devez régler I'heure manuellement
si le téléviseur est branché a un cablosélecteur par cable HDMI ou composante.

> . . . e s a
@  Cette fonction est valable uniquement lorsque la prise pour I'antenne du téléviseur est connectée a une antenne ou une
sortie de cable et recoit des émissions numériques.

¢ L'exactitude de Iinformation relative a l'heure recue peut dépendre de la chaine et du signal.

Sil'horloge n'est pas a la bonne heure en mode automatique...

MENU/123 > MENU > Systéme > Heure > Horloge > Fuseau horaire ZuE0

Vous pouvez régler I'horloge en intervalles d'une heure, pour une variation de +/- 12 heures, si I'heure réglée
automatiquement par le téléviseur est incorrecte.

¢ Fuseau horaire ajuste I'heure par une connexion réseau. Cette fonction est disponible uniquement si l'option Mode
horloge est réglée a Auto et que le téléviseur est connecté a Internet par l'intermédiaire d'un réseau local.

> . . . . R . 2 2z . .
¢ Lafonction Fuseau horaire permet de régler I'heure si le téléviseur ne recoit pas les données nécessaires par l'entremise
des signaux numériques réguliers.

Réglage manuel de I'horloge

MENU/123 > MENU > Systéme > Heure > Horloge > Réglage Horloge Z3FT>

Vous pouvez régler I'horloge de fagon manuelle. Réglez le Mode horloge a Manuel, et ensuite entrez I'heure et la
date actuelles.



Utilisation des minuteries

Utilisation de la mise en veille

MENU/123 > MENU > Systéme > Heure > Mise en veille ZHET

Vous pouvez utiliser cette fonction pour éteindre automatiquement le téléviseur aprés une période précise. Vous
pouvez régler la minuterie en intervalles de 30 minutes, pour une période allant jusqu'a 3 heures.

Mise sous tension du téléviseur a I'aide de la fonction minuterie activée

MENU/123 > MENU > Systéme > Heure > Progr. activ. S0

Vous pouvez régler a Progr. activ. afin que le téléviseur se mette automatiquement en marche a une heure donnée.
Vous pouvez utiliser jusqu'a trois configurations séparées : Les options Progr. activ. 1, 2 et 3. Progr. activ. sont
disponibles uniquement lorsque l'option Horloge a déja été réglée.

Configuration

Si vous sélectionnez Manuel, vous pouvez mettre en surbrillance et sélectionner chaque jour afin de
sélectionner les jours pour lesquels vous souhaitez que l'option Progr. activ. mette le téléviseur sous tension.

Heure
Volume

Source

A partir de la liste, sélectionnez une source de signal pour que le téléviseur I'utilise lorsqu'il se met sous
tension. Si vous souhaitez faire jouer du contenu enregistré dans un dispositif USB ou du contenu a partir
d'une source HDMI ou Composante, comme un lecteur DVD, un lecteur Blu-ray ou un décodeur, connectez
le dispositif au téléviseur avant de configurer Progr. activ. Pour que la Progr. activ. fonctionne, il faut que le
dispositif soit connecté au téléviseur.

Antenne

Permet de sélectionner une source de signal de diffusion, Hertzien ou Céable, lorsque 'option source est
régléea TVv.

Chaine

Permet de sélectionner une chaine lorsque 'option source est réglée a TV.



e Musique / Photo

Si vous avez réglé la source a USB, vous pouvez sélectionner le dossier d'un dispositif USB contenant des
fichiers de musique dans le champ Musique ou le dossier contenant des fichiers de photos dans le champ
Photo. Si vous sélectionnez un dossier contenant des fichiers de musique et un dossier contenant des
fichiers de photos, le téléviseur lit les fichiers de musique et affiche en méme temps les photos.

&  Sile dossier contient des sous-dossiers, vous pouvez sélectionner un sous-dossier de la méme facon.

& Cette option ne s'exécute pas correctement si le dispositif USB sélectionné ne contient aucun fichier média ou si
aucun dossier n'a été précisé.

’ Le diaporama ne débutera pas si le dispositif USB ne contient qu'un seul fichier image.

¢  Lesdossiers portant des noms longs ne peuvent étre sélectionnés.

¢ Assurez-vous que les noms des dossiers soient toujours différents pour chaque clé USB.

@  Utilisez une clé USB ou un lecteur multicartes. L'option Progr. activ. peut ne pas fonctionner avec certains

dispositifs USB dotés d’une pile intégrée, les lecteurs MP3, ou les lecteurs média portables car il faut trop de temps
au téléviseur pour reconnaitre ces périphériques.

Mise hors tension du téléviseur a I'aide de la fonction minuteur désactivé

MENU/123 > MENU > Systéme > Heure > Progr. désact. ZZ3LE0

Réglez |'option Progr. désact. de maniére que le téléviseur s’éteigne automatiquement a une heure prédéfinie.
Vous pouvez programmer trois configurations différentes : Les options Progr. désact. 1, 2 et 3. Progr. désact. sont
disponibles uniquement lorsque I'option Horloge a déja été réglée.

e Configuration

Régle les jours de la semaine au moment ou le téléviseur se met hors tension automatiquement. Si vous
sélectionnez Manuel, vous pouvez sélectionner chaque jour.

e Heure

Permet de régler I'heure a laquelle le téléviseur se mettra automatiquement hors tension.



Utilisation des fonctions Protection contre la brialure d'écran
et Economie d'énergie

Prévention des brilures d'écran
MENU/123 > MENU > Systéme > Délai protect. auto. R0

Vous pouvez utiliser la fonction de protection contre la bralure d'écran afin de protéger I'écran. Les images fixes
affichées sur I'écran pendant une longue période peuvent laisser des images rémanentes. Sélectionnez I'heure
dans la liste. Si une image fixe est affichée a I'écran pendant une plus longue période que celle que vous avez
sélectionnée, le téléviseur active automatiquement la fonction de protection contre la brdlure d'écran.

Réduire la consommation d'électricité du téléviseur
MENU/123 > MENU > Systéme > Solution Eco I

Vous pouvez ajuster le niveau de luminosité du téléviseur et empécher la surchauffe, ce qui réduit la consommation
électrique globale.

o Econ. Energie ZFID

Vous permet de sélectionner un réglage de luminosité dans la liste pour réduire la consommation électrique
du téléviseur.

o Capteur Eco ZFID

Permet de régler automatiquement le niveau de luminosité du téléviseur en fonction de la lumiére ambiante
afin de réduire la consommation d'énergie. Si le niveau de luminosité de I'écran a été réglé par le Capteur
Eco, vous pouvez ajuster manuellement la luminosité minimale de I'écran au moyen de la fonction Rétroécl.
min. ou Lumiére cell. min. (pour les modéles concernés).

o Veille abs. sign. ZHUEID

Vous permet de sélectionner une durée dans la liste. Si aucun signal n'a été recu aprés la période de temps
sélectionnée, le téléviseur se met automatiquement hors tension pour réduire la consommation d'électricité.

o Arrétautom. IHEID

Met automatiquement le téléviseur hors tension pour prévenir la surchauffe dans le cas ot l'utilisateur
n'active aucune fonction du téléviseur pendant une période donnée.

e Luminosité mouvement

Permet d'ajuster la luminosité en fonction des mouvements a I'écran afin de réduire la consommation
d'énergie.

&  Cette fonction n'est disponible que si le Image Mode est réglé a Standard; elle n’est pas prise en charge en mode 3D.

> . . .. . N s "
¢  Cette fonction est désactivée lorsque vous ajustez un paramétre de la qualité de l'image, comme Contraste et
Luminosité.



Utilisation du mode Anynet+ (HDMI-CEC)

Vous pouvez utiliser la télécommande du téléviseur pour commander les appareils externes qui sont connectés
au téléviseur par un cable HDMI et qui prennent en charge Anynet (HDMI-CEC). Veuillez prendre note que vous
pouvez configurer et commander Anynet+ (HDMI-CEC) uniquement avec la télécommande.

Configuration de Anynet+ (HDMI-CEC)
MENU/123 > MENU > Systéme > Anynet+ (HDMI-CEC) ZFTD

e Anynet+ (HDMI-CEC) ZIFTID

Permet d'activer ou de désactiver la fonction Anynet+ (HDMI-CEC). Sélectionnez Désactiver ou Activer pour
activer ou désactiver toues les fonctions li€es a Anynet+.

o Arrét automatique D

Quand le réglage est a Oui, met hors tension les appareils externes compatibles avec Anynet + lorsqu'on
éteint le téléviseur.

&  Cette fonction n'est pas prise en charge par certains appareils compatibles avec Anynet +.

o Recherche d'appareil XD

Recherche et repére automatiquement les appareils externes compatibles avec Anynet+ (HDMI-CEC) qui
sont connectés au téléviseur.

Utilisation du mode Anynet+ (HDMI-CEC)

Liste d'appareils compatibles avec le mode Anynet+ (HDMI-CEC)

Apreés avoir branché les appareils externes au téléviseur, sélectionnez MENU/123 > MENU > Systéme > Anynet+
(HDMI-CEC) > Recherche d'appareil. Le téléviseur affiche une liste des appareils compatibles avec le mode
Anynet+ (HDMI-CEC) que vous pouvez configurer comme des appareils contrélés par le mode Anynet+ (HDMI-CEC)
(c.-a-d. des appareils qui peuvent étre commandés a l'aide de la télécommande du téléviseur). Pour configurer un
appareil compatible avec le mode Anynet+ (HDMI-CEC) que vous pouvez configurer comme un appareil controlé
par le mode Anynet+ (HDMI-CEC), vous devez le sélectionner a I'écran Source. Suivez les instructions indiquées
dans la prochaine section.

¢ Siun appareil externe est configuré comme un appareil compatible avec le mode Anynet+ (HDMI-CEC) (c.-a-d. qui

peut étre controélé avec la téléecommande du téléviseur) et comme un appareil qui peut étre commandé a l'aide d'une
télécommande universelle, il peut étre contrélé uniquement avec la télécommande universelle.



Configuration d'un appareil comme étant compatible avec le mode Anynet+ (HDMI-CEC)

1. Appuyez sur la touche SOURCE. L'écran Source s'affiche. Sélectionnez un appareil connecté, puis appuyez
sur la touche directionnelle vers le bas.

2. Sélectionnez Anynet+ (HDMI-CEC) dans le menu. L'appareil sélectionné est configuré comme étant
compatible avec le mode Anynet+ (HDMI-CEC) Les options de menu suivantes sont disponibles.

g . . 2 . .
¢  Les options de menu affichées peuvent varier selon l'appareil.

e Anynet+ (HDMI-CEC)

Configure I'appareil sélectionné comme un appareil compatible avec le mode Anynet+ (HDMI-CEC) et,
ensuite, affiche une liste de tous les appareils externes branchés au téléviseur. Si vous sélectionnez un
appareil externe dans la liste, il est utilisé comme source d'entrée et vous pouvez donc I'utiliser pour regarder
la télévision. Si vous sélectionnez Regarder téléviseur, Anynet+ (HDMI-CEC) est activé de sorte que vous
pouvez regarder la télévision sans avoir d'appareil externe.

Veuillez lire les instructions suivantes avant de brancher I'appareil au mode Anynet+ (HDMI-
CEC)

¢ Vous pouvez configurer la fonction de la télécommande universelle du téléviseur pour commander des cablosélecteurs,
des lecteurs Blu-ray et des chaines de cinéma maison qui ne prennent pas en charge la fonction HDMI-CEC. Pour plus
d'information, reportez-vous a la section « Commande des appareils externes avec la télécommande — Utilisation de la
télécommande universelle ».

A

La fonction Anynet+ ne peut pas étre utilisée pour commander des appareils externes non compatibles avec la fonction
HDMI-CEC.

'~

Les appareils fonctionnant avec le mode Anynet+ (HDMI-CEC)-doivent étre raccordés au téléviseur a l'aide d'un céble
HDMI. Veuillez prendre note que certains cables HDMI ne prennent pas en charge le mode Anynet+ (HDMI-CEC).

& llest possible que la télécommande du téléviseur ne fonctionne pas dans certaines conditions. Si c'est le cas, configurez
I'appareil comme étant compatible avec le mode Anynet+ (HDMI-CEC)
4 L'option Anynet+ (HDMI-CEC) fonctionne uniquement avec des appareils externes compatibles avec HDMI-CEC, et

seulement lorsque ces appareils sont en mode de veille ou sous tension.

RS

La fonction Anynet+ (HDMI-CEC) permet de commander jusqu'a 12 appareils externes compatibles (jusqu'a 3 du méme
type), a I'exception des systémes de cinéma maison. Anynet+ (HDMI-CEC) permet de commander un seul systéme de
cinéma maison.

A

Pour écouter le son en 5.1 canaux provenant d'un appareil externe, branchez |'appareil au téléviseur a l'aide d'un céble
HDMI et le connecteur de la sortie audio numérique du connecteur directement a la chaine de cinéma maison.



Mise a jour du logiciel du téléviseur

MENU/123 > MENU > Support technique > Mise a jour du logiciel ZHLETDR

Vous pouvez afficher la version du logiciel du téléviseur et procéder a une mise a jour au besoin.

Mise a jour du logiciel du téléviseur a la toute derniére version
MENU/123 > MENU > Support technique > Mise a jour du logiciel > Mettre a jour ZHLELD

Vous pouvez mettre a jour le logiciel du téléviseur en téléchargeant directement la mise a jour a partir d'Internet
ou en copiant la mise a jour sur une clé USB que vous devrez brancher au téléviseur.

> . . .
@  Cette fonction exige une connexion Internet.

> . . N . P 7 . L1z
¢  Enregistrez la trousse de mise a jour dans le dossier supérieur de la clé USB. Sinon, le téléviseur n'est pas en mesure de
localiser la trousse de mise a jour.

A\ EVITEZ de couper I'alimentation avant la fin de la mise a jour. Le téléviseur se mettra hors tension et
redémarrera automatiquement une fois la mise a jour terminée. Tous les réglages vidéo et audio sont rétablis

aux valeurs par défaut apreés la mise a jour.

Mise a jour automatique du logiciel du téléviseur
MENU/123 > MENU > Support technique > Mise a jour du logiciel > Mise a jour auto ZZHLFID

Si le téléviseur est raccordé a Internet, celui-ci peut effectuer la mise a jour automatiquement pendant que vous
regardez la télévision. Lorsque la mise a jour en arriére-plan est terminée, elle sera appliquée la prochaine fois que
le téléviseur sera sous tension.

R

Cette fonction peut prendre du temps si une autre fonction de réseau est exécutée en paralléle.

> . . .
@  Cette fonction exige une connexion Internet.

RS

Si vous acceptez les modalités de Smart Hub, la fonction Mise a jour auto est réglée automatiquement a Activer. Si vous
ne voulez pas que le logiciel du téléviseur se mette a jour automatiquement, réglez Mise a jour auto a Désactiver.



Protection du téléviseur contre les intrusions informatiques et
les programmes malveillants

MENU/123 > MENU > Systéme > Sécurité intell.

Vous pouvez utiliser la fonction Sécurité intell. pour protéger le téléviseur contre les intrusions informatiques et
les logiciels malveillants lorsque vous étes connecté a Internet.

Vérifiez si le téléviseur et le dispositif qui lui est branché ont des logiciels

malveillants
MENU/123 > MENU > Systéme > Sécurité intell. > Recher.

Cette option analyse le téléviseur et le support de données branché a la recherche de programmes malveillants. Si
aucun programme malveillant n'est détecté, une notification a cet effet s'affiche a I'écran.

Si un programme malveillant a été détecté...

Si un logiciel malveillant est découvert, le résultat de I'analyse apparait a I'écran. La fenétre affiche tous les logiciels
malveillants détectés. Vous pouvez mettre en quarantaine (isoler) le logiciel afin d'empécher qu'il ne s'exécute.

1. Sélectionnez tous les logiciels malveillants & mettre en quarantaine.

2. Seélectionnez Isoler. Cette action déplace le programme malveillant sélectionné vers Liste d’éléments isolés.

g . . L1z . z . .. . . .
¢  Laliste Liste d’éléments isolés affiche tous les logiciels malveillants mis en quarantaine.



Configurer des fonctions supplémentaires
MENU/123 > MENU > Systéme > Sécurité intell. > Paramétres

Vous pouvez rechercher des virus sur votre téléviseur ou activer des fonctions de sécurité supplémentaires,
comme la sécurité réseau.

Antivirus

Controle le téléviseur en temps réel pour empécher les virus d'infecter le téléviseur.

Sécurité du réseau

Protége le téléviseur des attaques informatiques afin de réduire les fuites de renseignements privés.
App. ph.

Permet d'utiliser les caméras branchées au téléviseur.

Microphone

Permet d'utiliser les microphones branchés au téléviseur.

Analyse auto.

A pour effet que le téléviseur exécute un balayage automatique de son programme et de tout support de
données connecté lorsqu'il est sous tension.

Isolement automatique

Ajoute automatiquement a la Liste d’éléments isolés les programmes malveillants détectés pendant le
processus de balayage.



Utilisation d'autres fonctions

Exécuter rapidement les fonctions d'accessibilité

Vous pouvez utiliser le menu Raccourcis d'accessibilité pour exécuter rapidement les fonctions d'accessibilité
destinées aux personnes ayant des déficiences. Appuyez sur la touche [ de la télecommande Smart Control et
maintenez la pression. Le menu Raccourcis d'accessibilité offre les options Guide vocal, Description vidéo, Sous-
titres, Transparence menu, Contraste élevé, Enlarge, Apprendre les fonctions de la télécommande et Son a sorties
multiples.

» . e 2 . . . . .

¢  Avecle menu de raccourcis d'accessibilité, certaines fonctions ne sont pas disponibles dans certains pays.
> - . .

@ Sur latélécommande standard, appuyez sur la touche CC en maintenant la pression.

> ~ . . L 1z a P - . P . .
¢  Méme sile Guide vocal est réglé a Désactiver ou que le son est en sourdine, vous pouvez exécuter les fonctions Guide
vocal a partir du menu Raccourcis d'accessibilité.

Activation des guides vocaux pour les personnes malvoyantes
MENU/123 > MENU > Systéme > Accessibilité > Guide vocal

Vous pouvez utiliser des guides vocaux qui décrivent les options de menu a voix haute pour aider les personnes
malvoyantes. Pour activer cette fonction, réglez I'option Guide vocal a Activer. Lorsque le Guide vocal est activé,
le téléviseur donne des directives vocales pour changer de chaine, ajuster le volume, avoir de l'information sur les
émissions en cours et a venir, les visionnements planifiés, d'autres fonctions du téléviseur et divers contenus sur le
Web avec le Web Browser, dans Recherche ou dans MON CONTENU.

¢ Le Guide vocal est offert dans la langue qui est indiquée a I'écran Langue menu. Cependant, certaines langues ne sont
pas prises en charge par Guide vocal méme si elles sont indiquées a I'écran Langue menu. L'English est toujours pris en

charge.

¢ silafonction Guide vocal est réglée a Activer, le capteur de mouvement de la télécommande Samsung Smart Control ne
fonctionne pas. Pour utiliser le capteur de mouvement, réglez la fonction Guide vocal a Désactiver.

i Si le Guide vocal est réglé a Activer, la fonction Commande gestuelle est désactivée. Pour activer de nouveau cette

fonction, réglez le Guide vocal a Désactiver.

Modifier le volume, la vitesse et la tonalité du Guide vocal
Vous pouvez configurer le volume, la vitesse, la tonalité et le niveau du Guide vocal.
e Volume
Permet de changer le niveau du volume du Guide vocal.
e Vitesse
Modifier le débit du Guide vocal.
e Tonalité

Moadifie la hauteur de diction du Guide vocal.



Texte en caractéres blancs sur fond noir (contraste élevé)
MENU/123 > MENU > Systéme > Accessibilité > Contraste élevé

Cette option permet de transformer les principaux écrans de service en texte a caractéres blancs sur fond noir,
ou rend opaque les menus transparents du téléviseur pour rendre la lecture du texte plus facile. Pour activer cette
fonction, réglez I'option Contraste élevé a Activer.

Ajustement de la transparence des menus
MENU/123 > MENU > Systéme > Accessibilité > Transparence menu ZLFD
Vous pouvez ajuster la transparence des menus.

4 Régler l'option Contraste élevé (MENU > Systéme > Accessibilité > Contraste élevé) & Activer fait passer le mode
d'affichage du menu a opaque. Vous pouvez modifier manuellement les réglages Transparence menu.

Agrandir la police de caractéres (a I'intention des personnes malvoyantes)
MENU/123 > MENU > Systéme > Accessibilité > Enlarge ZIF

Vous pouvez agrandir la taille des caractéres a I'écran. Pour activer cette fonction, réglez Enlarge a Activer.

Apprendre les fonctions de la télécommande (3 I'intention des personnes
malvoyantes)
MENU/123 > MENU > Systéme > Accessibilité > Apprendre les fonctions de la télécommande

Cette fonction permet aux personnes malvoyantes d'apprendre les positions des touches de la télécommande.
Lorsque cette fonction est activée, appuyez sur une touche de la télécommande et le téléviseur vous dit comment
elle s'appelle. Pour retourner a I'écran précédent, appuyez deux fois sur la touche RETURN. Pour quitter la
fonction, appuyez deux fois sur la touche EXIT.

&  Cette fonction est disponible uniquement aux Etats-Unis et au Canada.

Ecouter la télévision a I'aide de dispositifs Bluetooth (3 I'intention des

personnes malentendantes)
MENU/123 > MENU > Systéme > Accessibilité > Son a sorties multiples

Vous pouvez activer en méme temps les haut-parleurs du téléviseur et les dispositifs Bluetooth. Lorsque cette
fonction est activée, vous pouvez régler le volume des dispositifs Bluetooth de sorte qu'il soit plus fort que celui des
haut-parleurs du téléviseur.

> . " L1z e a . - s .
¢  Lorsque vous branchez les dispositifs Bluetooth au téléviseur, le menu Son a sorties multiples est activé. Pour avoir de
plus amples renseignements au sujet de la connexion des dispositifs Bluetooth au téléviseur, reportez-vous a la rubrique
«Ecouter le son du téléviseur a 'aide de dispositifs Bluetooth ».



Changer la langue des menus
MENU/123 > MENU > Systéme > Langue menu 50D

Vous pouvez utiliser cette fonction pour changer la langue du menu. Sélectionnez une langue a partir de la liste.

Ajouter un mot de passe
MENU/123 > MENU > Systéme > Changer NIP ZFTD

Vous pouvez ajouter un NIP (huméro d'identification personnel) pour verrouiller des chaines, réinitialiser le
téléviseur et modifier les réglages du téléviseur.

La fenétre de saisie du NIP s'affiche. Saisissez votre NIP. Entrez-le de nouveau pour le confirmer. Le NIP par défaut
est 0000.

&  Sivous oubliez votre NIP, vous pouvez le réinitialiser a I'aide de la télécommande. Pendant que le téléviseur est sous
tension, appuyez sur les touches suivantes sur la télécommande, dans I'ordre indiqué, pour rétablir le code a 0000 : %4 —
+(Augmenter le volume) — RETURN — —(Baisser le volume) — RETURN — + — RETURN.

Vérifier les notifications
MENU/123 > MENU > Systéme > Avis

Vous pouvez voir la liste des messages d'événements générés par le téléviseur. Le message Avis apparait a I'écran
lorsque des événements comme la sortie d'une mise a jour pour une application ou l'ouverture ou la fermeture
d'une session dans le compte Samsung se produisent..

¢ Pour supprimer toutes les notifications, sélectionnez Supprimer tout.

¢ Sélectionnez Notification pour consulter les notifications de service du téléviseur intelligent (SMART TV) dans un
navigateur Web.

Réglage de I'angle de visionnement
MENU/123 > MENU > Systéme > Réglage automatique du support
Vous pouvez regarder I'écran d'une position plus confortable en le déplacant vers la droite ou la gauche.

&  Cette fonction est prise en charge seulement par les téléviseurs de série 82S9W.

Activation du mode Jeu
MENU/123 > MENU > Systéme > Général > Mode Jeu ZED

Vous pouvez activer le mode Jeu pour optimiser les parameétres du téléviseur pour vous permettre de jouer a des
jeux vidéo sur une console de jeu telle que PlayStation™ ou Xbox™.

» . . . P
¢ Lemode jeu n'est pas disponible pour le visionnement normal.

¢ Lécran peut légérement trembloter.

.

Lorsque le Mode Jeu est activé, le Image Mode et le Son Mode passent automatiquement en mode Jeu.

&  Pour utiliser un autre appareil externe, vous devez d'abord débrancher la console de jeu et désactiver le Mode Jeu.



Des couleurs plus riches et une qualité d'image de qualité supérieure (BD
Wise)
MENU/123 > MENU > Systéme > Général > BD Wise THEID

Vous pouvez améliorer les couleurs et la qualité de I'image si vous connectez un lecteur DVD Samsung DVD, un
lecteur Blu-ray, ou une chaine de cinéma maison qui prend en charge BD Wise. Lorsque le mode BD Wise est activé,
cela optimise automatiquement la résolution du téléviseur.

& Cette fonction est disponible seulement si I'appareil externe est branché au moyen d'un cable HDMI.

Activation/désactivation de la rétroaction audio
MENU/123 > MENU > Systéme > Général > Rétroaction audio THELP

Vous pouvez utiliser la rétroaction audio pour obtenir des repéres sonores lorsque vous vous déplacez dans les
menus et sélectionnez des options. Vous pouvez la régler a Bas, Moyen, Elevé ou a Désactiver.

Verrouiller et déverrouiller I'option Manche de commande
MENU/123 > MENU > Systéme > Général > Verrouill. panneau 3 E0D

Vous pouvez verrouiller et déverrouiller les boutons du panneau avant du téléviseur (menu, chaine, volume) et le
manche de commande a l'arriére du téléviseur.

Afficher/masquer le logo Samsung au démarrage
MENU/123 > MENU > Systéme > Général > Logo au démarr. ZH LD
Vous pouvez activer ou désactiver I'affichage du logo Samsung qui apparait au démarrage du téléviseur.

&  Cette fonction n’est pas accessible lorsque I'option Activ. instantanée Samsung est réglée a Activer.

Permettre le démarrage rapide du téléviseur
MENU/123 > MENU > Systéme > Général > Activ. instantanée Samsung

Vous pouvez régler l'option Activ. instantanée Samsung a Activer de sorte que le téléviseur démarre plus
rapidement.

4 Lorsque Activ. instantanée Samsung est réglé a Activer, I'historique des applications que vous avez utilisées sur le
téléviseur peut étre enregistré dans ce dernier.

> . P z . e . A
¢  Lafonction Activ. instantanée Samsung fonctionne lorsque vous mettez le téléviseur sous tension alors que le cable
d'alimentation est toujours branché apres avoir réglé Activ. instantanée Samsung a Activer. Si vous le déconnectez puis
reconnectez le cable d'alimentation et mettez le téléviseur sous tension, la configuration n'est plus mémorisée.
> ~ . . . z Y . . . e
¢  Méme silafonction Activ. instantanée Samsung est activée, la consommation électrique pendant que le téléviseur est
hors tension répond aux spécifications en mode de veille présentées sur I'étiquette du produit.
» . . . . N . - . . .
@  Cette fonction n'est pas disponible sur certains modéles dans certaines zones géographiques particuliéres.

Activer/désactiver les voyants a I'avant du téléviseur
MENU/123 > MENU > Systéme > Général > Effet lumiére ZHLEL0

Vous pouvez allumer ou éteindre les voyants a I'avant du téléviseur. Lorsque vous réglez Effet lumiére a Désactiver,
cela réduit la consommation électrique du téléviseur.

> s P e . \
¢ Lacouleur de lalumiére émise par le téléviseur peut varier selon le modéle.

&  Cette fonction n'est pas disponible sur certains modeéles dans certaines zones géographiques particuliéres.



Activer ou désactiver le son de bienvenue
MENU/123 > MENU > Systéme > Général > Son de bienvenue

Vous pouvez activer et désactiver le son de bienvenue que le téléviseur émet lorsque vous le mettez sous tension.

&  Cette fonction est prise en charge seulement par les téléviseurs de série 82S9W.

Activer ou désactiver la lumiére du support
MENU/123 > MENU > Systéme > Général > llluminer le cube
Vous pouvez activer et désactiver la lumiére émise par la partie supérieure du support du téléviseur.

¢  Cette fonction est prise en charge seulement par les téléviseurs de série 82S9OW.

Enregistrer le téléviseur a titre d'appareil certifié DivX (pour regarder des

vidéos DivX a la carte).
MENU/123 > MENU > Systéme > Vidéo sur demande DivX®

Pour regarder sur votre téléviseur des films en format DivX protégés par une gestion des droits numériques, vous
devez enregistrer votre téléviseur en tant qu'appareil certifié DivX.

¢ La gestion des droits numériques (DRM) a le réle d'un mécanisme de sécurité technique afin de protéger les doits
d'auteur du fournisseur du contenu.

> . . . . . s a . .
@  Vous pouvez regarder des films que vous possédez ou des films DivX gratuits sans avoir a vous inscrire.

& Visitez le site Web DivX (http://www.divx.com) et ouvrez une session dans votre compte utilisateur avant d'enregistrer le
téléviseur comme appareil DivX-certified. Si vous n'avez pas de compte, veuillez en créer un.

Rétablissement des réglages du téléviseur aux réglages définis par défaut
MENU/123 > MENU > Support technique > Autodiagnostic > Régler S EID

Vous pouvez restaurer tous les réglages du téléviseur (sauf les réglages relatifs a I'lnternet et au réseau) aux
valeurs par défaut du fabricant.

1. Sélectionnez Régler. La fenétre de saisie du NIP de sécurité apparait.

2. Entrezle NIP de sécurité et sélectionnez Oui. Tous les réglages sont réinitialisés. Le téléviseur s’éteint et se
rallume automatiquement, puis il affiche I'écran Configuration.

¢  Pour en savoir davantage sur Configuration, consultez le guide de |'utilisateur fourni avec l'appareil.

Utiliser le téléviseur comme modéle de démonstration (seulement pour les
magasins de détail).
MENU/123 > MENU > Support technique > Mode utilisation I

Vous pouvez transformer le téléviseur en appareil de démonstration (pour les magasins) en réglant le Mode
d'utilisation a Démo magasin.

¢ Sélectionnez Util. a domicile pour tout autre utilisation.

> . m z . . . z s L1z e TR .
@ Sivous utilisez Démo magasin, certaines fonctions seront désactivées et le téléviseur se réinitialisera automatiquement
apreés un certain temps.



Sauvegarder les données du téléviseur avec I'ensemble UHD Evolution Kit
MENU/123 > MENU > Systéme > Sauvegarde de la trousse Evolution Kit UHD

Vous pouvez mettre le logiciel de votre téléviseur Samsung a jour avec le dispositif Evolution Kit 2016 ou une
version supérieure et déverrouiller les nouveaux services et fonctions offerts par Samsung Electronics. Pour faire
la mise a jour, vous devez d'abord faire une sauvegarde des données et applications enregistrées et les convertir
afin qu'elles soient compatibles avec le dispositif Evolution Kit.

Pour sauvegarder les données du téléviseur,

1. Sélectionnez Démarrer. Les données du téléviseur sont sauvegardées.

g e . , 2 . . T
¢  Ne mettez pas le téléviseur hors tension et ne débranchez pas le cable d'alimentation du téléviseur au cours de cette
sauvegarde.

2. Une fois la sauvegarde effectuée, sélectionnez Fait.

Visionnement d'émissions enregistrées
MENU/123 > MENU > Systéme > Mettre a jour les émissions enregistrées

&  Cette fonction n'est pas disponible aux Etats-Unis et au Canada.

Vous pouvez voir une émission enregistrée antérieurement qui est sauvegardée dans une clé USB sur un téléviseur
Samsung qui a été mis a jour avec |'ensemble 2016 Evolution Kit.

Pour convertir une émission enregistrée antérieurement,
1. Connectez la clé USB contenant cette émission a la prise USB HDD 5V 1A.

2. Aumenu Systéme, sélectionnez Mettre a jour les émissions enregistrées. L’écran Mettre a jour les émissions
enregistrées s’affiche.

3. Seélectionnez Démarrer. Le processus de conversion commence.

g R . ~ a . . L1z
¢  Ne mettez pas le téléviseur sous tension et ne débranchez pas le cable d'alimentation du téléviseur au cours de cette
conversion.

> " . . .
¢  N'interrompez pas la connexion avec la clé USB au cours de cette conversion.

4. Lorsque la conversion est terminée, sélectionnez Fait.



Obtenir du soutien technique

Obtenir du soutien technique par I'entremise de la fonction Gestion a
distance
MENU/123 > MENU > Support technique > Gestion a distance ZZHLEL

Cette fonction vous permet de demander a Samsung Electronics de diagnostiquer votre téléviseur a distance. Vous
devez d'abord lire et accepter l'entente de service avant d'utiliser cette fonction.

g . . .
@  Cette fonction exige une connexion Internet.

Obtenir du soutien a distance

Vous pouvez obtenir du soutien assuré par un technicien du service de soutien a distance de Samsung qui effectue
la procédure ci-apreés.

e diagnostiquer votre téléviseur;
e ajuster les réglages du téléviseur;
e Réinitialisez votre téléviseur en lui redonnant tous ses parameétres par défaut

e installer les derniéres versions du micrologiciel recommandées.

Comment fonctionne le soutien technique a distance?

Pour avoir facilement accés au soutien technique a distance, suivez les étapes ci-apreés:

- -6
m Il vous suffit d'appeler un centre d'appels Samsung et de demander un soutien technique
a distance.

Ouvrez le menu de votre téléviseur et allez a la section Support tech..

Sélectionnez Gestion a distance, puis acceptez les ententes sur le service aprés en avoir
pris connaissance. Lorsque I'écran du NIP s'affiche, communiquez le NIP a 'agent.

Ce dernier accéde a votre téléviseurr.




Comment trouver les coordonnées pour obtenir des services de soutien
MENU/123 > MENU > Support technique > Contacter Samsung

Vous pouvez obtenir I'adresse du site Web de Samsung, le numéro de téléphone du centre d'appels, le numéro de
modeéle de votre téléviseur, la version du logiciel de votre téléviseur, les renseignements sur Smart Hub, et d'autres
renseignements dont vous pourriez avoir besoin pour obtenir du soutien technique d'un agent du service de
soutien technique Samsung, ou sur le site Web de Samsung.

> . . . e
@  Pour consulter l'avis sur les licences des logiciels ouverts, appuyez sur la touche IEX.

Demande de service
MENU/123 > MENU > Support technique > Demander du support technique

¢  Cette fonction n'est pas disponible dans certaines zones géographiques.

Lorsque votre téléviseur présente un probléme, vous pouvez demander un service de soutien technique.
Sélectionnez Demander du support technique, et ensuite acceptez les modalités relatives a la demande de service.
Sélectionnez de nouveau Demander du support technique, sélectionnez |'élément correspondant au probléme que
présente votre téléviseur, puis sélectionnez Envoyer.



Probléme concernant I'image

Tester l'image

MENU/123 > MENU > Support technique > Autodiagnostic > Essai d'image

Avant d'essayer de corriger le probléme en consultant la liste de problémes et de solutions ci-dessous, utilisez
I'option Essai d'image pour savoir si le probléme provient du téléviseur. L'essai d'image affiche une image haute
définition permettant de détecter les imperfections.

Le probléeme

Scintillement et
diminution de la
luminosité

Branchement de
composantes/Couleur de
I’écran

Luminosité de I’écran

Images rémanentes,
floues, effet de saccades

Mise hors tension
inopportune

Problémes de mise sous
tension

Impossible de trouver
une chaine

Conseil

En cas de scintillement ou de diminution de la luminosité de maniére sporadique de votre
téléviseur Samsung, vous devrez peut-étre désactiver certaines fonctions d’économie
d’énergie. Désactivez Econ. Energie (MENU/123 > MENU > Systéme > Solution Eco >
Econ. Energie) ou Capteur Eco (MENU/123 > MENU > Systéme > Solution Eco > Capteur
Eco).

Si vous constatez que la couleur de I’écran de votre téléviseur Samsung n’est pas bonne
ou que le noir et le blanc ne sont pas bons, exécutez Essai d'image (MENU/123 > MENU >
Support technique > Autodiagnostic > Essai d'image).
Si les résultats du test indiquent que le probléme n'est pas causé par le téléviseur, suivez les
étapes ci-dessous :

e Est-ce que les connecteurs d'entrée vidéo du boitier One Connect sont branchés aux

connecteurs de sortie vidéo adéquats de I'appareil externe?

o Vérifiez également les autres branchements. Si le téléviseur est branché a un appareil
externe au moyen d’un cable composante, vérifiez que les prises Pb, Pr et Y sont
branchées aux connecteurs correspondants.

Si les couleurs du téléviseur Samsung sont bonnes, mais [égérement sombres ou brillantes,
réglez d’abord les paramétres ci-apres.
e Allez au menu Image et ajustez les réglages Contre-jour, Contraste, Luminosité, Netteté,

Couleur et Teinte (V/R).

Si vous constatez 'apparition d'images rémanentes ou floues, utilisez la fonction Auto Motion
Plus (MENU/123 > MENU > Image > Options d'image > Auto Motion Plus) pour résoudre
le probléme.

Si votre téléviseur Samsung semble se mettre hors tension par lui-méme, essayez de
désactiver certaines fonctions d'économie d'énergie automatiques. Vérifiez si la fonction Mise
en veille (MENU/123 > MENU > Systéme > Heure > Mise en veille) a été activée. L'option
Mise en veille met automatiquement le téléviseur hors tension aprés une période de temps
précise. Si la mise en veille n’a pas été activée, vérifiez si l'option Veille abs. sign. (MENU/123
> MENU > Systéme > Solution Eco > Veille abs. sign.) ou Arrét autom. (MENU/123 >
MENU > Systéme > Solution Eco > Arrét autom.) a été activée et désactivez-la.

Ala mise sous tension du téléviseur, le récepteur de la télecommande clignote cing fois avant
que I’écran ne s’allume.

Si vous avez de la difficulté a mettre votre téléviseur Samsung sous tension, procédez

a certaines vérifications avant d’appeler le service de dépannage. Assurez-vous que le
cordon d'alimentation du téléviseur est branché correctement aux deux extrémités et que

la télécommande fonctionne normalement. Assurez-vous que le cable de I'antenne ou du
service de cablodistribution est bien branché. Si vous avez un cablosélecteur ou un décodeur,
assurez-vous qu'il soit branché et mis sous tension.

Si votre téléviseur n'est pas branché a un cablosélecteur ou un décodeur, exécutez
Configuration (MENU/123 > MENU > Systéme > Configuration) ou Prog. auto (Diffusion >
Prog. auto).



Le probléme

L’image du téléviseur
n’est pas aussi belle qu’en
magasin.

L’image est déformée.

Les couleurs sont
faussées ou absentes.

La couleur est médiocre
ou 'image manque de
luminosité.

Ligne pointillée sur le
bord de I’écran.

L’image est en noir et
blanc.

Conseil

Les affichages en magasin sont tous réglés en fonction de chaines numériques haute
définition (HD).
Si vous avez un cablosélecteur ou un boitier décodeur analogique, procurez-vous un
récepteur numérique. Utilisez des cables HDMI ou composantes pour obtenir une image de
qualité HD (haute définition).
De nombreuses chaines HD sont soumises a une interpolation a partir du contenu SD
(définition standard). Cherchez une chaine diffusant du contenu HD pur.

e Abonnés au cable ou au satellite : essayez des chaines HD figurant dans la liste des chaines.

e Connexion antenne Air ou Cable : essayez les chaines HD aprés I’exécution de fonction de
programmation automatique.
Réglez la résolution de la sortie vidéo du cablosélecteur ou du décodeur a 1080i ou 720p.

La compression du contenu vidéo peut causer une déformation de I'image, surtout lorsque
les mouvements sont rapides, comme dans les émissions de sport et les films d’action.

Un signal faible ou médiocre peut causer une déformation de I'image. Il ne s’agit pas d’un
probléme du téléviseur.

L'utilisation de téléphones cellulaires a proximité du téléviseur (jusque'a une distance d'un
métre environ (3,2 pi) peut causer des parasites a l'affichage de chaines analogiques ou
numériques.

Si vous avez une connexion avec des cables composantes, assurez-vous que ces derniers sont
branchés aux prises correspondantes. Des connexions incorrectes ou laches peuvent causer
des problémes de couleur ou une absence d’image.

Allez au menu Image et ajustez les réglages Image Mode, Luminosité, Netteté et Couleur.
Vérifiez si la fonction Econ. Energie (MENU/123 > MENU > Systéme > Solution Eco >
Econ. Energie) a été activée.

Essayez de réinitialiser image. (Image > Réinitialisation de I'image)

Réglez la taille Image Format a 16:9.

Si vous utilisez une entrée AV composite, branchez le cable vidéo (jaune) a la prise
composante verte du boitier One Connect.

Si l'image d'essai ne s'affiche pas ou si celle-ci présente du bruit ou une distorsion, il se peut que le téléviseur soit
défectueux. Communiquez avec le centre d'appels de Samsung pour obtenir de l'aide.

Si 'image d’essai s’affiche correctement, il est possible que'un appareil externe soit défectueux. Vérifiez les

branchements.

Si le probléme persiste, vérifiez la puissance du signal ou consultez le guide d’utilisation de I’appareil externe.



Le son n'est pas clair

Tester le son
MENU/123 > MENU > Support technique > Autodiagnostic > Essai de son 35

Sila mélodie est jouée par le téléviseur pendant I'essai de son, il est possible qu'un appareil externe soit défectueux
ou qu'il y ait un probléme de force du signal.

Le probléme Conseil

IIn’y a pas de sonoule

son est trop bas alors que Vérifiez le controle du volume de I'appareil (cablosélecteur, décodeur, lecteur DVD,
le volume est réglé au lecteur Blue-ray, etc.) branché a votre téléviseur.
maximum.

Réglez la fonction MENU/123 > Liste des haut-parleurs a Haut-parleur TV.
Si vous utilisez un appareil externe, vérifiez I’option de sortie audio de cet appareil. (Par
exemple, vous pourriez avoir a changer I'option audio de votre cablosélecteur a HDMI si
votre récepteur est branché au téléviseur a I’aide d’un cable HDMI.)
L’image est bonne, mais il n’y Pour entendre le son provenant de l'ordinateur, branchez des haut-parleurs externes au
a pas de son. connecteur de sortie audio de I'ordinateur.
Si votre téléviseur est doté d’une prise pour casque d’écoute, vérifiez qu’aucun appareil
n’y est branché.
Réinitialisez I’'appareil branché en débranchant et en rebranchant son cordon
d’alimentation.

Assurez-vous que le cable audio est branché correctement au connecteur de la sortie
audio de I’'appareil externe.
Les haut-parleurs émettent Si le téléviseur est branché a une antenne ou a un cablosélecteur, vérifiez les données sur
un son étrange. le signal. Un signal faible peut causer une distorsion sonore.
Exécutez Essai de son (MENU/123 > MENU > Support technique > Autodiagnostic >
Essai de son).



Les images 3D ne sont pas claires

Effectuer un essai de la qualité des images 3D
MENU/123 > MENU > Support technique > Autodiagnostic > Test de I'image 3D

Cette fonction n'est pas disponible sur certains modéles dans certaines zones géographiques particuliéres.

Si l'image d'essai ne s'affiche pas ou si celle-ci présente du bruit ou une distorsion, il se peut que le téléviseur soit
défectueux. Communiquez avec le centre d'appels de Samsung pour obtenir de l'aide.

Le probléme

Les lunettes 3D ne
fonctionnent pas
correctement.

Les images 3D ne sont pas
claires.

Les piles des lunettes 3D
sont a plat.

Conseil

Assurez-vous que les lunettes sont sous tension.

La fonction 3D peut ne pas fonctionner correctement si un autre produit ou appareil
électronique 3D est sous tension a proximité.

En cas de probléme, éloignez le plus possible les autres appareils électroniques des lunettes
3D Active.

La distance de visionnement idéale est d’au moins trois fois la hauteur de I’écran.
Nous vous recommandons de regarder le contenu 3D de sorte que vos yeux soient au
méme niveau que I’écran.

Mettez les lunettes 3D hors tension lorsque vous ne les utilisez pas. Si vous les laissez sous
tension, la durée de vie des piles sera réduite.

Pour effectuer un essai de la qualité des images 3D, vous devez porter des lunettes 3D appariées au téléviseur.

Probleme concernant la diffusion d'émissions

Le probléme

Le téléviseur ne recgoit pas
toutes les chaines.

Pas de sous-titres pour les
chaines numériques.

L’image est déformée.

Conseil

e assurez-vous que le cable coaxial est bien branché au téléviseur.

e Exécutez Configuration (MENU/123 > MENU > Systéme > Configuration) ou Prog.
auto (MENU/123 > MENU > Diffusion > Prog. auto).

e Sivous utilisez une antenne, assurez-vous que'elle est bien positionnée et bien
branchée.

Allez & Sous-titres (MENU/123 > MENU > Systéme > Accessibilité > Sous-titres) puis
modifiez le réglage du Mode ss-titres codés.
Il est possible que certaines chaines n’aient pas de sous-titres.

La compression du contenu vidéo peut causer une déformation de I'image, surtout lorsque
les mouvements sont rapides, comme dans les sports et les films d’action.

Un signal faible peut causer une déformation de I'image. Il ne s’agit pas d’un probléme du
téléviseur.



Je n'arrive pas a connecter mon ordinateur.

Le probléme Conseil
Le message « Mode non Réglez la résolution de sortie de votre ordinateur pour que’elle corresponde a une
disponible » s’affiche. résolution prise en charge par le téléviseur.

Si vous avez branché I’ordinateur a I’aide d’un cable HDMI, vérifiez le réglage de sortie
audio de votre ordinateur.
Si vous utilisez un cable HDMI a DVI, un cable audio distinct est nécessaire.

La vidéo est bonne, mais il
n’y a pas de son.

Le téléviseur ne se connecte pas a Internet

Le probléme Conseil

Perte de connexion au

» . Vérifiez que votre modem/routeur est bien allumé et branché a Internet.
réseau sans fil.

Veérifiez la connexion réseau (MENU/123 > MENU > Réseau > Etat du réseau).
Connectez le téléviseur au réseau, le cas échéant.
Si vous avez la version la plus récente du logiciel, aucune mise a niveau ne sera effectuée.

Echec de la mise & jour du
logiciel par Internet.

La fonction Planifier un enregistrement/Timeshift ne marche
pas.

Cette fonction n'est pas disponible aux Etats-Unis et au Canada.

Le probléme Conseil
L'option Planifier un Vérifiez si un dispositif USB est connecté au téléviseur.
enregistrement ne peut pas L'enregistrement s'arréte automatiquement si le signal faiblit trop. La fonction

étre utilisée. Timeshift ne marche pas s'il n'y a pas assez d'espace sur le dispositif USB.



Le mode Anynet+ (HDMI-CEC) ne fonctionne pas.

Le probléeme

Anne+ ne fonctionne pas.

Je souhaite lancer
Anne+.

Je souhaite quitter
Anynet+.

Le message « Connexion
al’appareil Anynet+... »
ou « Déconnexion de
I’appareil Anynet+ ... »
s’affiche a ’écran.

Impossible de lire quoi
que ce soit a l'aide de
I'appareil Anynet+.

L’appareil branché n’est
pas affiché.

Le son n’est pas émis
par I'intermédiaire du
récepteur.

Conseil

Vérifiez si ’'appareil est bien un appareil compatible avec Anne+. Le systéme Anne+ ne prend
en charge que les appareils Anne+.

Vérifiez si le cordon d’alimentation de I’appareil Anne+ est bien branché.

Vérifiez les branchements des cables de I’appareil Anne+.

Allez 3 Anynet+ (HDMI-CEC) (MENU/123 > MENU > Systéme > Anynet+ (HDMI-CEC)) et
assurez-vous que le mode Anynet+ (HDMI-CEC) est réglé sur Activer.

Vérifiez si la télécommande est en mode TV.

Vérifiez si la télécommande est compatible avec Anne+.

Anynet+ peut ne pas fonctionner lorsque certaines autres fonctions sont actives, par exemple
la Recherche de chaines, Smart Hub, la configuration initiale, etc.

Si vous avez débranché puis rebranché le cable HDMI, lancez une nouvelle recherche des
appareils ou éteignez et rallumez le téléviseur.

Assurez-vous que I'appareil Anynet+ est bien branché au téléviseur, puis sélectionnez le
Anynet+ (HDMI-CEC) (MENU/123 > MENU > Systéme > Anynet+ (HDMI-CEC)) pour
vérifier sile mode Anynet+ (HDMI-CEC) est réglé a Activer.

Sélectionnez Regarder téléviseur dans le menu Anynet+.
Sélectionnez un appareil non compatible Anynet+ dans la liste Source.

Vous ne pouvez pas utiliser la télécommande lorsque vous configurez Anynet+ ou basculez
vers un mode d’affichage. La télécommande n’est utilisable qu’au terme de la configuration
d’Anynet+ ou du passage a un mode de visualisation.

Vous ne pouvez pas utiliser la fonction de lecture lorsque Configuration est en cours.

Vérifiez que I’appareil est compatible avec Anynet+.

Vérifiez que le cable HDMI est bien branché.

Allez & Anynet+ (HDMI-CEC) (MENU/123 > MENU > Systéme > Anynet+ (HDMI-CEC)) et
assurez-vous que le mode Anynet+ (HDMI-CEC) est réglé sur Activer.

Lancez une nouvelle recherche d’appareils Anynet+.

Les appareils Anynet+ doivent étre branchés au téléviseur a I’aide d’un cable HDMI. Vérifiez
que I'appareil est branché a votre téléviseur au moyen d’un cable HDMI. Certains cables HDMI
peuvent ne pas prendre en charge la fonction Anynet+.

En cas d’arrét anormal résultant d’un débranchement du cable HDMI ou du céble
d’alimentation, ou encore d’une panne de courant, effectuez une nouvelle recherche
d’appareils.

Branchez un céble optique reliant le téléviseur au récepteur.

La fonction ARC permet une sortie numérique du son du téléviseur a I’aide du port HDMI (ARC).
Toutefois, elle n’est disponible que lorsque le téléviseur est branché a un récepteur audio qui
prend cette fonction en charge.



J'éprouve des problémes a lancer ou utiliser les applications.

Le probléeme

J'ai lancé une application,

mais elle est en anglais.
Comment puis-je
changer de langue?

L'application ne
fonctionne pas.

Conseil

Les langues prises en charge par une application peuvent étre différentes de la langue
de Pinterface utilisateur. La disponibilité du contenu dans plusieurs langues dépend du
fournisseur de service.

Communiquez avec le fournisseur de service.
Reportez-vous a la section d'aide du site Web du fournisseur de services liés a I'application.

Impossible de lire mon fichier.

Le probléme

Conseil

Impossible de lire certains = Ce probléme peut survenir en cas de fichiers a haut débit. Bien que la lecture de la plupart des

fichiers.

fichiers soit possible, les fichiers a un haut débit risquent de poser probléme.

Je veux réinitialiser le téléviseur.

Réinitialiser

Réinitialiser les
réglages

Réinitialiser Smart
Hub

Chemin Description
MENU/123 > MENU > Réinitialiser aux valeurs par défaut les paramétres Image, Son,
Support technique > Chaine, Smart Hub et tous les autres parameétres, a I'exception des
Autodiagnostic > Régler paramétres réseau.

Permet de rétablir tous les paramétres par défaut de Smart Hub
et de supprimer toute information associée aux comptes Samsung
et aux comptes de service associés, ainsi que les applications et les
ententes de service Smart Hub.

MENU/123 > MENU >
Smart Hub > Réinitialiser
Smart Hub



Autres problémes

Le probléme

Le téléviseur est chaud.

L’image ne s’affiche pas en
mode plein écran.

Le message « Mode non
disponible » s’affiche.

L’option Sous-titres dans le
menu du téléviseur est en
gris.

Le téléviseur dégage une
odeur de plastique.

L'option Info. sur signal
sous Autodiagnostic n'est
pas activée.

Le téléviseur est incliné d’'un
coteé.

Conseil

Le panneau peut dégager de la chaleur si le téléviseur est utilisé pendant une période
prolongée. La chaleur se dissipe par les orifices de ventilation aménagés dans le haut du
téléviseur. Le bas peut aussi devenir chaud au toucher apreés une utilisation prolongée.
Les parents doivent surveiller les enfants qui regardent la télévision pour les empécher de
toucher I'appareil. Cette chaleur ne découle toutefois par d'un défaut et elle n'affecte en
rien le fonctionnement du téléviseur.

Des barres noires apparaissent de chaque c6té de I'image des chaines HD durant I’affichage
d’un contenu SD (4:3) soumis & une interpolation.

Des barres noires au haut et au bas de I'image apparaissent dans les films dont le rapport
hauteur/largeur est différent de celui du téléviseur.

Réglez I'option de format de I'image de votre appareil externe ou du téléviseur a plein
écran.

La résolution de sortie de l'appareil branché n'est pas prise en charge par le téléviseur.
Vérifiez la résolution prise en charge par le téléviseur et réglez la résolution de sortie de
I’appareil externe en conséquence.

Vous ne pouvez pas sélectionner le menu Sous-titres si vous avez sélectionné une source
branchée au téléviseur au moyen d’un cable HDMI ou composante. Pour afficher les sous-
titres, activez la fonction de sous-titres de I'appareil externe.

Cette odeur est normale et s’atténuera avec le temps.

Vérifiez si la chaine active est numérique.
L'option Info. sur signal est disponible seulement pour les chaines numériques.

Retirez la base du téléviseur et assemblez-la de nouveau.



Le probléme

L'option Diffusion a été
désactivée.

Les réglages sont perdus
apreés 5 minutes ou chaque
fois que le téléviseur est
éteint.

Perte intermittente du son
ou de I'image.

Il'y a de petites particules
sur le cadre du téléviseur.

Le menu ISI n’est pas
disponible.

Une banniére publicitaire
interne du téléviseur (POP)
apparait a I’écran.

Le téléviseur émet un bruit
de craquement.

Le téléviseur émet un
bourdonnement.

Conseil

L'option Diffusion n'est disponible que lorsque la Source est réglée sur TV.

Vous ne pouvez pas accéder au menu Diffusion si vous regardez la télévision par
Pintermédiaire d’un cablosélecteur ou d’un récepteur satellite.

Vous ne pouvez pas accéder au menu Diffusion pendant qu'une émission est en cours
d'enregistrement ou que la fonction Timeshift est en cours d'exécution.

Si l'option Mode utilisation est réglée a Démo magasin, les réglages audio et vidéo du
téléviseur sont réinitialisés toutes les 5 minutes.

Passez de Mode utilisation (MENU/123 > MENU > Support technique > Mode utilisation)
a Util. a domicile.

Vérifiez les branchements des cables et refaites-les.

La perte du son ou de I'image peut étre causée par I'utilisation de cables trop rigides ou
trop épais.

Assurez-vous que les cables sont suffisamment souples pour une utilisation a long terme.
Pour la fixation murale, nous recommandons I'utilisation de cables pourvus de connecteurs
a90 degrés.

Cela fait partie de la conception du produit et ne constitue pas un défaut.

La fonction ISl est disponible uniquement lorsque vous visionnez une vidéo provenant
d'une source HDMI ou d'une composante, sur I'écran principal.

Passez de Mode utilisation (MENU/123 > MENU > Support technique > Mode utilisation)
a Util. a domicile.

L'expansion et la contraction du boitier du téléviseur peuvent engendrer des craquements.
Il ne s’agit pas d’une défaillance du produit. Vous pouvez utiliser le téléviseur en toute
sécurité.

Votre téléviseur utilise des circuits de commutation a grande vitesse et des courants
électriques de forte intensité. Il peut sembler plus bruyant que’un téléviseur conventionnel
compte tenu du niveau de luminosité sélectionné.

Votre téléviseur a fait 'objet de procédures strictes de contréle de qualité qui répondent a
nos strictes exigences en matiére de rendement et de fiabilité.

Un simple bruit provenant du téléviseur est tout a fait normal et ne constitue donc pas une
raison valable pour un échange ou un remboursement.



Avant d'utiliser les fonctions Enregistrement et Timeshift

Avant d'utiliser les fonctions Enregistrement et Planifier un enregistrement
La fonction d'enregistrement n'est pas prise en charge aux Etats-Unis et au Canada.

e Pour programmer la fonction Planifier un enregistrement, vous devez d'abord régler I'horloge du téléviseur.
Réglez la fonction Horloge (MENU/123 > MENU > Systéme > Heure > Horloge).

e Vous pouvez enregistrer au maximum 30 Planifier un visionnement et entrées Planifier un enregistrement.

e Lesenregistrements sont protégés par la gestion des droits numériques (DRM) et, par conséquent, ne
peuvent pas étre lus sur un ordinateur ou un autre téléviseur. En outre, ces fichiers ne peuvent pas étre lus
sur votre téléviseur si le circuit vidéo a été remplacé.

e llestrecommandé d'utiliser un lecteur de disque dur USB ayant une vitesse de 5 400 tr/min ou supérieure.
Cependant, les lecteurs de disque dur de type RAID (réseau redondant de disques indépendants) ne sont pas
pris en charge.

e Lesclés USB ne sont pas prises en charge.

e Lacapacité d'enregistrement totale peut varier en fonction de I'espace disponible sur le lecteur de disque
dur et du niveau de qualité de I'enregistrement.

e Lafonction Planifier un enregistrement nécessite au moins un espace libre de 100 Mo sur le dispositif de
stockage USB. L'enregistrement en cours s'arréte si I'espace de stockage disponible est inférieur a 50 Mo.

e Sil'espace de stockage disponible est inférieur a 500 Mo pendant que les deux fonctions Planifier un
enregistrement et Timeshift sont en cours, seule la fonction d'enregistrement s'arréte.

e Ladurée d’enregistrement maximale est de 720 minutes.
e Lalecture des vidéos s'effectue selon la configuration du téléviseur.

e Silesignal d'entrée change pendant que l'enregistrement est en cours, I'écran s'affiche en blanc jusqu'a
ce que le changement soit effectué. Dans ce cas, I'enregistrement reprend, mais la fonction ® n'est pas
disponible.

e Lorsque vous utilisez la fonction Enregistrement ou Planifier un enregistrement, I'enregistrement en cours
peut démarrer une seconde ou deux plus tard que I'heure réglée.

e Silafonction Planifier un enregistrement est en cours d'exécution pendant qu'un enregistrement s'effectue
sur un appareil HDMI-CEC externe, la priorité est accordée a la fonction Planifier un enregistrement.

e Le fait de raccorder un dispositif d'enregistrement au téléviseur efface automatiquement les fichiers
d'enregistrement qui n'ont pas été enregistrés correctement.

e Siles options Progr. désact. ou Arrét autom. ont été réglées, le téléviseur ignore ces paramétres, continue a
enregistrer, et s'éteint une fois que I'enregistrement est terminé.



Avant d’utiliser la fonction Timeshift

La fonction Timeshift n'est pas prise en charge aux Etats-Unis et au Canada.

e Il estrecommandé d'utiliser un lecteur de disque dur USB ayant une vitesse de 5 400 tours par minute ou
plus. Cependant, les lecteurs de disque dur de type RAID (réseau redondant de disques indépendants) ne
sont pas pris en charge.

e Lesclés USB et les disques a mémoire flash ne sont pas prises en charge.

e Lacapacité d'enregistrement totale peut varier en fonction de I'espace disponible sur le lecteur de disque
dur et du niveau de qualité de I'enregistrement.

e Sil'espace de stockage disponible est inférieur a 500 Mo pendant que les deux fonctions Planifier un
enregistrement et Timeshift sont en cours, seule la fonction d'enregistrement s'arréte.

e Ladurée maximale disponible pour la fonction Timeshift est de 90 minutes.

e Lafonction Timeshift n'est pas disponible pour les chaines verrouillées.

e Lalecture des vidéos décalées temporellement s'effectue selon la configuration du téléviseur.

e Lafonction Timeshift peut s'interrompre automatiquement une fois que'elle a atteint sa capacité maximale.

e Lafonction Timeshift nécessite au moins un espace libre de 1,5 Go sur le dispositif de stockage USB.



A lire avant d'utiliser le Mode 3D

Cette fonction n'est pas disponible sur certains modéles dans certaines zones géographiques particuliéres.

Précautions a suivre pour visionner du contenu 3D

/\ Avertissement

e Sivous regardez une vidéo en 3D sous une lampe fluorescente (50 Hz - 60 Hz) ou une lampe a trois
longueurs d'ondes, il est possible que vous remarquiez un léger scintillement a I'écran.
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¢  Sicestle cas, réduisez l'intensité de la lampe ou éteignez-la.

Le fait de changer de mode d'entrée pendant le visionnement d'un film en 3D peut désactiver la fonction 3D
du téléviseur.

& Sice symptéme se produit, il est possible que les lunettes 3D se mettent automatiquement hors tension.

e Sivous étes en position allongée sur le c6té lorsque vous utilisez les lunettes 3D Active, il se peut que
vous ne voyiez pas d'image ou que'elle soit sombre. La perception des effets 3D peut varier en fonction
du téléspectateur. L'effet 3D peut ne pas étre perceptible si les capacités de votre ceil gauche sont trés
différentes de celles de votre ceil droit.

e Sileslunettes 3D ou les lentilles sont endommagées, entiérement ou partiellement, elles ne peuvent pas étre
réparées; les lunettes doivent étre remplacées. Si les lunettes ne fonctionnent pendant la période de validité
de la garantie, elles peuvent étre réparées ou remplacées gratuitement. Si les lunettes ont été endommagées
apreés l'expiration de la période de garantie ou en raison d'une faute de |'utilisateur, ce dernier doit acheter
des lunettes neuves.

e Slilexiste une grande différence entre votre vision de |'ceil droit et de I'ceil gauche, il est possible que vous ne
perceviez pas aussi bien les effets 3D que d'autres personnes, ou que vous ne les perceviez pas du tout.

e Assurez-vous de respecter la distance de fonctionnement lorsque vous regardez une vidéo en 3D.

@  llest possible que vous ne puissiez pas voir les images en 3D si vous dépassez la distance d'émission du téléviseur
pendant trois secondes.

> . R . i . - .

@  Sileslunettes 3D sont a une trop grande distance par rapport au téléviseur, le signal émis par ce dernier n'est
plus capté et |'affichage 3D s'arréte au bout de quelques secondes. Lorsque cela se produit, la DEL rouge s'allume
pendant trois secondes.

e Leslunettes 3D pourraient ne pas fonctionner correctement en raison de l'interférence avec d'autres
appareils 3D ou appareils électroniques qui fonctionnent avec une fréquence de 2,4 GHz, comme un four
a micro-ondes ou des points d'accés Internet. Si la fonction 3D est perturbée en raison de l'interférence,
assurez-vous que les autres appareils électroniques ou de communication sans fil sont le plus loin possible
des lunettes et du téléviseur.

e Sivous regardez une vidéo 3D dans un endroit exposé a la lumiére directe du soleil ou a I'éclairage, la clarté
de l'image peut vous sembler se dégrader.

e Leslunettes 3D peuvent ne pas bien fonctionner en présence d'un champ électrique ou d'un objet métallique
tel une plaque d'acier a proximité. Eloignez le plus possible les lunettes des champs électriques et des objets
métalliques.

e Leslunettes du modele SSG-3570 peuvent se mettre hors tension si vous regardez des vidéos 3D pendant
une période prolongée dans la méme position.

e Sileslunettes 3D de modéle SSG-3570 ne fonctionnent pas immédiatement alors que le téléviseur est en
mode 3D, retirez-les et remettez-les de nouveau.



A\ Mise en garde

CONSIGNES IMPORTANTES SUR LA SANTE ET LA SECURITE RELATIVEMENT AUX VISIONNEMENTS EN 3D.
LISEZ LES AVERTISSEMENTS SUIVANTS AVANT D’UTILISER OU DE LAISSER VOTRE ENFANT UTILISER LA
FONCTION 3D.

Les enfants qui utilisent la fonction 3D doivent étre supervisés fréquemment par un adulte. Si l'enfant se
plaint de fatigue oculaire, de maux de téte, d'étourdissements ou de nausée, il doit arréter de regarder le film
3D et se reposer.

N'utilisez pas les lunettes 3D a d'autres fins (comme lunettes de vue, lunettes de soleil ou de protection, etc.)

Certaines personnes peuvent éprouver des étourdissements, des nausées, des maux de tétes, etc..
lorsqu"elles regardent un film en mode 3D. Si vous éprouvez ce genre de symptémes, arrétez de regarder le
film 3D, enlevez les lunettes 3D et reposez-vous pendant quelques minutes.

Si vous regardez des films 3D pendant une période prolongée, cela peut vous causer de la fatigue oculaire. Si
vous éprouvez de la fatigue oculaire, arrétez de regarder le film 3D, enlevez les lunettes 3D et reposez-vous
pendant quelques minutes.

N'utilisez pas la fonction 3D ou les lunettes 3D lorsque vous vous déplacez. Si vous utilisez la fonction 3D ou
des lunettes 3D Active en vous déplacant, vous pourriez vous blesser en heurtant des objets, en trébuchant
ou en tombant.

Ne gardez pas les lunettes 3D pour dormir. Cela risquerait d'endommager ou de briser les branches des
lunettes.

Les branches de vos lunettes 3D ne sont pas pliables. Vous endommagerez vos lunettes 3D si vous tentez de
plier les branches de force.

Sivous possédez des lunettes 3D de modéle SSG-3570, ne les secouez pas de facon répétée. Cela les
activera, ce qui risque de décharger les piles prématurément.

Concernant les modéles de lunettes SSG-5100GB et SSG-5150GB, il y a un risque d'explosion si vous installez
le mauvais type de pile.

Concernant les modéles de lunettes SSG-5100GB et SSG-5150GB, assurez-vous de remplacer la pile par une
pile du méme type.



A\ Consignes de sécurité

Pour votre sécurité personnelle et afin d'éviter tout dommage matériel, veuillez lire les consignes de sécurité ci-
apreés. Pour une utilisation adéquate du produit, veuillez lire les consignes suivantes.

Veillez a ce que le produit ne soit pas exposé directement a la lumiére du soleil, une flamme nue, la chaleur ou
I'eau. Ceci pourrait causer une défectuosité du produit ou un incendie.

Evitez d'exercer une pression sur les lentilles des lunettes 3D. Veillez & ne pas échapper ou plier les lunettes.
Eviter d'exercer une pression, de laisser tomber ou de plier les lunettes 3D car ceci pourrait causer une
défectuosité.

Tenez les composants des lunettes 3D hors de la portée des enfants. En particulier, surveillez les enfants afin
que'ils n'avalent pas de composants. Dans le cas ou votre enfant a avalé un composant de lunettes, consultez
immédiatement un médecin.

Lorsque vous nettoyez les lunettes, veillez a ne pas vaporiser de produit nettoyant ou d'eau directement
sur la surface. Evitez de vaporiser de I'eau ou un produit nettoyant directement sur les lunettes pour éviter
qu'elles prennent en feu ou que vous subissiez un choc électrique, que des dommages soient causés a la
partie extérieure du produit ou que les étiquettes d'information qui y sont apposées se décollent.

N'utilisez pas de produits chimiques contenant de I'alcool, des solvants ou des agents tensio-actifs tels que
de la cire, du benzéne, des diluants, pesticides, désodorisants, lubrifiants ou détergents pour nettoyer les
lunettes. Si vous utilisez ces produits chimiques, la partie extérieure des lunettes risque de se décolorer ou
se fissurer et les étiquettes contenant les instructions risquent de se détacher. Utilisez seulement un chiffon
doux en fibres superfines ou flanelle de coton pour nettoyer les lunettes, étant donné que les lentilles et la
surface des lunettes se rayent facilement. Etant donné que les lunettes se rayent facilement sous I'action de
substances étrangeéres, assurez-vous de secouer le chiffon avant son utilisation.

Ne démontez pas les lunettes 3D, et n'essayez pas de les réparer ou de les modifier vous-méme.

Manipulez avec précaution les branches des lunettes 3D Active pour éviter que les extrémités vous blessent
les yeux.

Ne gardez pas les lunettes 3D pour dormir. vous risqueriez d'en casser les branches.
Utilisez toujours vos mains pour retirer ou porter les lunettes 3D.

Pour les modéles de lunettes SSG-5100 et SSG-5150, utilisez uniquement les piles standard indiquées.
Lorsque vous remplacez la pile, veillez a respecter la polarité (+, -) indiquée. Le non-respect de cette consigne
peut causer des dommages a la pile, un incendie, des blessures ou des dommages environnementaux en
raison de la fuite du liquide interne.

Pour les modeéles de lunettes SSG-5100 et SSG-5150, conservez les piles usées hors de la portée des enfants
pour éviter qu'ils ne les avalent accidentellement. Si votre enfant a avalé une pile, consultez immédiatement
un médecin.

L'ingestion des piles sphériques (de type bouton) peut causer des blessures sévéres aux organes internes. En
cas d'ingestion, consultez immédiatement un médecin.



Résolutions prises en charge pour les modes 3D
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¢  Cette fonction n'est pas disponible sur certains modéles dans certaines zones géographiques particuliéres.

& Ces spécifications s'appliquent seulement au format d'image 16:9.

HDMI
1280 x 720p 50/60
1920 x 1080i 50/ 60
1920 x 1080p 24/25/30/50/60
3840 x 2160p 24/25/30/50/60
Composante
1280 x 720p 59.94/ 60
1920 x 1080i 59.94/ 60
1920 x 1080p 23.98/24/29.97/30/59.94 /60

Chaine numérique

1280 x 720p 59.94/60

1920 x 1080i 59.94 /60

Vidéos ou photos

Reportez-vous a la section « Instructions a lire avant d'effectuer la lecture des fichiers photos, vidéos ou de
musique ».

Connexion a un ordinateur a l'aide d'un cable HDMI

Pour un ordinateur branché au téléviseur a l'aide d'un cable HDMI, la résolution optimale est 1920 x 1080 pixels. Si
vous sélectionnez une résolution différente, il est possible que le téléviseur n'affiche pas correctement les images
3D, ou qu'il ne soit pas possible d'afficher en plein écran les vidéos issues de I'ordinateur.



Résolutions prises en charge pour chaque type de signaux
d'entrée UHD

e Résolution: 3840 x 2160p, 4096 x 2160p

¢  La connexion HDMI avec I'option HDMI UHD Color réglée a Désactiver prend en charge des signaux d'entrée jusqu'a
UHD 50P/60P 4:2:0, alors que la connexion HDMI avec I'option HDMI UHD Color réglée a Activer prend en charge
des signaux d'entrée jusqu'a UHD 50P/60P 4:4:4 et 4:2:2.

Lorsque la fonction HDMI UHD Color est réglée a Désactiver

50/60 8 bits - - - 0

Lorsque la fonction HDMI UHD Color est réglée a Activer

8 bits o o O O

50/60 10 bits - - o 0]

12 bits - - o o]




Avis de non-responsabilité pour S-Recommendation

Selon le modéle, certaines des fonctions recommandées par S-Recommendation peuvent ne pas étre disponibles.

S Recommendation est disponible uniquement pour les modéles faits pour les Etats-Unis.

S-Recommendation avec interaction vocale
Voici quelques recommandations au sujet des commandes vocales les plus fréquemment utilisées :

L'interaction vocale se limite aux langues officielles du pays d'achat. Le résultat peut varier en fonction de la
disponibilité du contenu, de la clarté et du volume de votre voix et du niveau de bruit ambiant. Il est possible que les
forts accents régionaux ne soient pas compris.

Il est possible que vous ne puissiez pas utiliser certaines fonctions Samsung Smart TV si vous n'avez pas
expressément autorisé la collecte et |'utilisation de vos renseignements personnels.

Certaines fonctions de S-Recommendation nécessitent l'accés a Internet et peuvent ne pas étre disponibles selon
le fournisseur de services, la langue, le dialecte et la zone géographique.

Il est possible que votre télécommande ne corresponde pas aux images qui figurent dans ce manuel.

S-Recommendation
Pour des recommandations de contenu qui correspond a vos préférences télévisuelles :

Il est possible que vous ne puissiez pas utiliser certaines fonctions Samsung Smart TV si vous n'avez pas
expressément autorisé la collecte et |'utilisation de vos renseignements personnels.

Certaines fonctions de S-Recommendation nécessitent I'accés a Internet et peuvent ne pas étre disponibles selon
le fournisseur de services, la langue, le dialecte et la zone géographique.

Il est possible que votre télécommande ne corresponde pas aux images qui figurent dans ce manuel.



Instructions a lire avant d'utiliser la commande vocale, la
commande gestuelle ou la reconnaissance faciale

Précautions a suivre pour utiliser les fonctions de reconnaissance vocale,
commande gestuelle et reconnaissance faciale

Reconnaissance faciale

e Ce produit enregistre les images miniatures des visages des utilisateurs qui seront utilisées pendant
l'ouverture de session par reconnaissance faciale.

e L'ouverture d'une session dans Smart Hub a l'aide de la Reconnaissance faciale pourrait étre moins
sécuritaire que l'utilisation d'un identifiant et d'un mot de passe.

Utiliser la télécaméra

e Dans certaines situations et selon certaines conditions juridiques, I'utilisation/la mauvaise utilisation de la télé
caméra peut entrainer des gestes illégaux. Des obligations peuvent exister en vertu des lois locales régissant
la protection de la vie privée des personnes quant aux renseignements personnels et a la libre circulation
de tels renseignements, et possiblement en vertu d'autres lois, y compris les lois criminelles qui régissent la
surveillance par caméra, en milieu de travail et ailleurs.

e Lorsde l'utilisation de la télécaméra, les utilisateurs conviennent qu'ils n'utiliseront pas I’appareil i) dans des
lieux ou les caméras sont généralement interdites (comme les toilettes, les vestiaires ou les salles a langer),
ii) d’'une maniére qui pourrait constituer une violation de la vie privée ouiiii) d'une maniére contraire a la
législation, aux lois et reglements applicables.

e Quand vous n'utilisez plus la caméra, installez le couvre-objectif ou repliez-la dans son logement. Cela vous
permet d'éviter un fonctionnement involontaire de la télécaméra.

Commande gestuelle

e Lesfonctions Commande gestuelle sont activées par I'entremise de la caméra branchée au téléviseur. Pour
pouvoir utiliser la fonction Commande gestuelle, vous devez étre dans le champ de reconnaissance de la
caméra. Le champ de reconnaissance de la caméra varie selon la luminosité ambiante et d'autres facteurs.

e Activez I'option Test environnement de commande gestuelle avant d'utiliser la fonction de commande
gestuelle pour déterminer la portée de reconnaissance de la caméra.

e Vous pourriez ressentir de la fatigue physique en cas d'utilisation de la fonction Commande gestuelle
pendant de longues périodes.



Reconnaissance vocale

e Lorsque le téléviseur est un modéle de série 9000, 9100, SOW ou 900D ou qu'il n'a pas de caméra intégrée et
qu'un modéle de série SEK-3500 d'ensemble UHD Evolution est installé, nous vous recommandons d'utiliser
la télécommande Samsung Smart Control pour utiliser cette fonction.

e Lafonction Reconnaissance vocale n'est pas disponible dans tous les dialectes, langues et zones
géographiques. Son fonctionnement varie selon la langue choisie, le volume de la voix et le niveau de bruit
ambiant.

e Pour utiliser le mode vocal de saisie de texte, vous devez accepter la politique de protection des
renseignements personnels de toute application tierce.

e Le mode vocal de saisie de texte vous permet d'entrer du texte a l'aide de votre voix, sans avoir a utiliser
une souris, un clavier ou une télécommande. Cette fonction est particulierement utile pour effectuer des
recherches sur le Web ou y naviguer et pour utiliser des applications.

e Vous devez accepter I'énoncé de confidentialité suivant avant d'utiliser la fonction Reconnaissance vocale
interactive :

- Enoncé de confidentialité pour la reconnaissance vocale et Nuance

Exigences s'appliquant a l'utilisation des fonctions Reconnaissance vocale,
Commande gestuelle et Reconnaissance faciale

Exigences s'appliquant a l'utilisation de la reconnaissance vocale

e Letaux de reconnaissance vocale varie en fonction du volume ou du ton de voix, de la prononciation et de
I'environnement des sons ambiants (son du téléviseur et bruit ambiant).

e Ditesla commande en vous plagant de 10 cm a 15 cm du micro de la télécommande Samsung Smart Control.
Le volume optimal pour les commandes vocales se situe entre 75 dB et 80 dB.



Exigences pour l'utilisation de la reconnaissance des mouvements

e Ence quiconcerne la commande gestuelle, veillez a vous tenir a la distance recommandée, soit entre 1,5m
(4,9 pi) et 3,5m (11,4 pi). La portée de reconnaissance réelle peut varier en fonction de I'angle de la caméra
et d'autres facteurs.

e Pour connaitre la distance recommandée pour utiliser la commande gestuelle avec I'ensemble Evolution
branché au téléviseur, reportez-vous au guide d'utilisation du téléviseur.

e Vous devez vous trouver dans la portée de la lentille de la caméra parce que la commande gestuelle
fonctionne en interaction avec la caméra intégrée au téléviseur. Ajustez I'angle de la caméra en appuyant
sur la partie avant de cette derniére, vers le bas et en avant ou vers le haut et vers l'arriére. Ne dirigez pas la
caméra directement vers le soleil ou une autre source lumineuse et n'obstruez pas sa vision.

e Vous devez vous démarquer de l'arriére-plan pour que la caméra reconnaisse vos mouvements.

e Laluminosité ambiante doit étre de 50 a 500 lux. (En régle générale, il y a une luminosité de 100 lux. dans une
salle de bain, et de 400 lux. dans un salon.)

e Lorsque vous utilisez la fonction Commande gestuelle, évitez I'exposition directe a la lumiére du soleil.

e Activez e Test environnement de commande gestuelle avant d'utiliser la fonction Commande gestuelle pour
évaluer la portée de reconnaissance de la caméra.

Exigences pour l'utilisation de la reconnaissance faciale

e En ce qui concerne la reconnaissance faciale, veillez a vous tenir a la distance recommandée, soit entre 1,5m
(4,9 pi) et 4 m (13,1 pi). La portée de reconnaissance réelle peut varier en fonction de I'angle de la caméra et
d'autres facteurs.

e Pour connaitre la distance recommandée pour utiliser la reconnaissance faciale avec I'ensemble Evolution
branché au téléviseur, reportez-vous au guide d'utilisation du téléviseur.

e Laluminosité ambiante doit étre de 50 a 500 lux. (En régle générale, il y a une luminosité de 100 lux. dans une
salle de bain, et de 400 lux. dans un salon.)

e Lafonction de reconnaissance faciale peut reconnaitre jusqu'a 5 utilisateurs différents.

e Le téléviseur peut avoir de la difficulté a différentier les personnes jumelles ou celles ayant des visages
similaires.

e Respectez les consignes suivantes lorsque vous utilisez la fonction de reconnaissance faciale :

— Ne portez pas de chapeau, ne vous couvrez pas les cheveux et ne portez pas de lunettes de soleil.

— Lacaméra doit couvrir I'ensemble de votre visage. Evitez que des ombres couvrent votre visage. Les
ombres empéchent la caméra de reconnaitre votre visage avec précision.

- Adoptez une expression aussi neutre que possible. De plus, gardez votre bouche fermée et aussi neutre
que possible.

— Lorsque vous ouvrez une session sur votre compte Samsung, vous devez avoir la méme expression
faciale que celle que vous avez adoptée au cours du processus d'inscription.



A lire avant d'utiliser les applications

En raison des caractéristiques des produits présentés dans Smart Hub de Samsung et des restrictions
s'appliquant au contenu disponible, certains services, options et applications peuvent ne pas étre disponibles
sur tous les appareils ou dans toutes les zones géographiques. Il se peut aussi que certaines options de
Smart Hub exigent des périphériques additionnels ou des frais d'adhésion. Veuillez visiter le site Samsung a
I'adresse http://www.Samsung.com. pour obtenir plus de renseignements sur les contenus disponibles ou
des appareils en particulier. La disponibilité des services et des contenus peut faire I'objet de modifications
sans préavis.

Samsung Electroniques n'assume aucune responsabilité juridique que ce soit a I'égard de toute interruption
des services des applications causée par le fournisseur de services, pour quelque raison que ce soit.

Les services des applications peuvent étre fournis en anglais seulement et les contenus peuvent varier selon
les zones géographiques.

Pour de plus amples renseignements sur les applications, visitez le site Web du fournisseur du service en
question.

Une connexion Internet instable peut causer des délais ou des interruptions. En outre, les applications
risquent de s'interrompre automatiquement en fonction des conditions du réseau. Si cela se produit, vérifiez
votre connexion Internet et essayez de nouveau.

Il se peut que les services et les mises a niveau des applications ne soient pas disponibles.

Le contenu des applications peur faire I'objet de modifications sans préavis par le fournisseur de service
concerné.

Les services particuliers peuvent varier en fonction de la version de I'application installée sur le téléviseur.

Les fonctionnalités de I'application peuvent varier selon les versions futures de I'application. Dans ce cas,
exécutez le tutoriel de 'application en question ou visitez le site Web du fournisseur de service.

Selon les politiques du fournisseur de service, certaines applications pourraient ne pas prendre en charge le
fonctionnement multitache.

A lire avant d'utiliser le Web Browser

Sélectionnez Web Browser. L’écran de navigation peut différer de celui de votre ordinateur.
Le navigateur Web n’est pas compatible avec les applications Java.

Vous pouvez télécharger les types de fichiers pris en charge, comme des fichiers vidéos, des fichiers mp3 et
des images, mais vous ne pouvez pas télécharger des fichiers qui ne sont pas pris en charge par le téléviseur.
Si vous essayez de télécharger un fichier qui n'est pas pris en charge, un message d’erreur s’affiche.

Le navigateur Web peut ne pas accéder a certains sites Web.

Le téléviseur ne prend pas en charge les vidéos Flash.



Le commerce électronique pour I’'achat de produits en ligne n’est pas pris en charge.

La navigation dans des sites Web contenant des fenétres déroulantes peut entrainer I’altération de certains
caractéres.

ActiveX n’est pas pris en charge.

Certaines options sont inaccessibles en mode Navi. par lien. (Pour accéder a ces options, passez en mode
Navi. par pointeur.)

Le nombre de polices prises en charge est limité. Certains symboles et caractéres peuvent ne pas s’afficher
correctement.

La réponse a une commande transmise depuis la télécommande ou 'affichage a I’écran peuvent étre ralentis
si la page Web est en cours de téléchargement.

Sur certains systémes d’exploitation, le chargement d’une page Web peut étre lent ou ne pas s’effectuer.
La fonction copier/coller n’est pas prise en charge.

Lorsque vous rédigez des courriels ou des messages, certaines fonctions (comme le changement de la taille
ou de la couleur) ne seront peut-étre pas prises en charge.

Le nombre de signets et de fichiers journaux pouvant étre enregistrés est limité.

Le nombre de fenétres pouvant étre ouvertes en méme temps peut varier selon les conditions de navigation
ou le modéle du téléviseur.

La vitesse de navigation sur le Web dépend des conditions du réseau.
Les vidéos intégrées peuvent étre lues en méme temps que vous utilisez la fonction ISI (image sur image).
Seuls les fichiers audio MP3 peuvent étre lus dans le navigateur Web.

Si vous n'avez pas réglé les options Horloge (MENU/123 > MENU > Systéme > Heure > Horloge) votre
historique de navigation ne sera pas enregistré.

L’historique des sites visités est enregistré selon un ordre chronologique; les derniéres pages visitées
effacent les plus anciennes.

Selon les codecs vidéo et audio pris en charge, la lecture Flash de certains fichiers vidéo et audio pourrait ne
pas fonctionner.

Les sources vidéo des fournisseurs de services de transmission en continu optimisés sur PC peuvent ne pas
fonctionner correctement sur notre navigateur Web.

L'utilisation d'un clavier QWERTY a I'écran désactive automatiquement le mode ISI ( excepté si vous entrez
une adresse URL).



Instructions a lire avant d'effectuer la lecture des fichiers
photos, vidéos ou de musique

Restrictions en ce qui concerne l'utilisation de fichiers photos, vidéos et de
musique

Le téléviseur prend en charge seulement les dispositifs USB & mémoire de grande capacité (MSC). MSC se
rapporte a une catégorie de dispositifs 8 mémoire de grande capacité. les disques durs externes, les lecteurs
de carte mémoire et les appareils photo numériques. (Les concentrateurs USB ne sont pas pris en charge.)
Ces périphériques doivent étre branchés directement au port USB du téléviseur. Si le téléviseur est branché
a un dispositif USB au moyen d'un cable de rallonge USB, il se peut qu'il ne reconnaisse pas ce dispositif ou
qu'il ne lise pas les fichiers qu'il contient. Evitez de débrancher le dispositif USB pendant le transfert des
fichiers.

Pour brancher un disque dur externe, vous devez utiliser le port USB (HDD). Il est recommandé d'utiliser le
disque dur externe avec l'adaptateur avec lequel il est fourni.

Certains appareils photo numériques ou appareils audio peuvent ne pas étre compatibles avec le téléviseur.

Si plus d'un appareil USB est connecté au téléviseur, il est possible que le téléviseur ne reconnaisse pas
I'ensemble des appareils. Les appareils USB trés énergivores doivent étre branchés au port USB [5V, 1A].

Le téléviseur prend en charge les systémes de fichiers FAT, enfant et NTFS..

Aprés avoir trié les fichiers en mode Vue Dossier, jusqu'a 1000 fichiers par dossier peuvent étre affichés par
le téléviseur. Si le dispositif USB contient plus de 8 000 fichiers et dossiers, il se peut toutefois que certains
fichiers et dossiers ne soient pas accessibles.

Le mode de connexion PTP (point a point) est disponible avec les appareils photo numériques seulement.
Si vous branchez un téléphone intelligent ou une tablette au téléviseur en mode PTP, I'appareil ne sera pas
reconnu par le téléviseur.

Assurez-vous de connecter au port USB 3.0 un dispositif USB ou un disque dur externe qui prend en charge
la version USB 3.0.

Le téléviseur peut ne pas lire certains fichiers en raison de leur type d'encodage.

En fonction du modéle, certains fichiers ne sont pas pris en charge.



Sous-titres externes pris en charge

MPEG-4 (texte minuté) ttxt
SAMI .smi
SubRip .srt
SubViewer .sub

Micro DVD .sub ou .txt
SubStation Alpha .ssa
Advanced SubStation Alpha .ass
Powerdivx .psb
SMPTE-TT (texte) xml

Sous-titre internes pris en charge

Xsub AVI
SubStation Alpha MKV
Advanced SubStation Alpha MKV
SubRip MKV
VobSub MKV
MPEG-4 (texte minuté) MP4
TTML en diffusion en continu fluide MP4
SMPTE-TT (texte) MP4
SMPTE-TT PNG MP4




Formats de fichiers d'image et résolutions pris en charge

*

. IP3 JPEG 153608640
Jpeg

*png PNG 4096x4096

* bmp BMP 4096x4096

*mpo MPO 153608640

Codecs et formats de fichiers de musique pris en charge

*.mp3 MPEG MPEG1 Audio Layer 3

*.m4a

*.mpa MPEG4 AAC

*.aac

*.flac FLAC FLAC Prend en charge jusqu'a 2 canaux
*.099 0GG Vorbis Prend en charge jusqu'a 2 canaux

Prend en charge jusqu'a 10 canaux 5.1 Pro
*.wma WMA WMA Format WMA audio sans perte non pris en charge.
Prend en charge jusqu'au profil M2.

*.wav wav wav
* mid . . Type O ettype 1 pris en charge .
. midi midi La fonction de recherche n'est pas prise en charge.
‘midi appareils USB sont pris en charge.
*.ape ape ape
*.aif
AIFF AIFF
* aiff

*mda ALAC ALAC




Codecs vidéo pris en charge

Format
de fichier

*avi
*.mkv
*.asf
*wmy
*mp4
*.mov
*.3gp
*vro
*.mpg
*.mpeg
*1s
*tp
*trp
*.mov
*flv
*.vob
*.svi
*.m2ts
*.mts
*.divx

*.webm

Contenant

AVI
MKV
ASF
MP4
3GP
MOV
FLV
VRO
VOB
PS
TS
SVAF

WebM

Fréquence de Débit

Codec vidéo Résolution  trames (image/  binaire
sec) (Mbsp)
4096 x2160: 30
H.264 BP / MP / HP 60
3840x2160: 60
HEVC (H.265 - Main, Main10,

Maind:2:2 10) 4096 x 2160 60 80
Motion JPEG 30 80

MVC

DivX3.11/4/5/6
MPEG4 SP/ASP 60
Windows Media Video v9 (VC1)
MPEG2 1920x 1080 20
MPEG1
Microsoft MPEG-4 v1,v2,v3
Windows Media Video vZ(WMV1), 30
v8(WMV2)
H.263 Sorrenson

VP6

VP8 1920x 1080 60 20

4096 x2160:30
VP9 4096 x 2160
3840x2160:60

Codec audio

Dolby Digital
LPCM
ADPCM (IMA, MS)
AAC
HE-AAC
WMA
Dolby Digital Plus
MPEG (MP3)
DTS (Core, LBR)

G.711 (A-Law,
p-Law)

Vorbis



Autres restrictions

e Les codecs peuvent ne pas fonctionner correctement si un probléme survient au niveau du contenu.
e Slilyaune erreur dans le contenu ou le contenant, la lecture du contenu vidéo risque d'étre compromise.

e Lesonoulavidéo peuvent ne pas fonctionner si le nombre d'images par seconde ou le débit binaire est
supérieur a la capacité du téléviseur.

e Sile tableau d'indexation contient des erreurs, la fonction Recherche (Saut) ne fonctionne pas.

e Lorsque vous visionnez une vidéo par l'intermédiaire d’une connexion réseau, la lecture pourrait étre altérée
en raison des vitesses de transmission des données.

e Certains types d’appareil audio ou d’appareil photo numériques USB ne sont pas compatibles avec le
téléviseur.

e Lecodec HEVC est seulement disponible dans les contenants MKV/MP4/TS.

Décodeurs vidéo

e Lesfichiers H.264 en résolution FHD sont pris en charge jusqu'au niveau 4.1. (FMO/ASO/RS non pris en
charge)

e Lesfichiers H.264 en résolution UHD sont pris en charge jusqu'au niveau 5.1.

e HEVCFHD est pris en charge jusqu'au niveau 4.1, et HEVC UHD est pris en charge jusqu'au niveau 5.1.
e VC1 AP L4 non pris en charge.

e Tous les codecs vidéo a l'exception de WMV v7, v8, MSMPEG4 v3, MVC, et VP6 :

Résolution inférieure a 1280 x 720 : 60 images maximum

Résolution supérieure a 1280 x 720 : 30 images maximum
e Format GMC 2 ou supérieur non pris en charge.
e Prend en charge SVAF Haut/Bas. Types de séquences (2ES) haut/bas, cote a cote et gauche/droite.

e Prend en charge seulement les spécifications MVC du lecteur de disques Blu-ray.

Décodeurs audio

e WMA 10 Pro prend en charge jusqu'au format canaux 5.1. Prend en charge jusqu'au profil M2. Format WMA
audio sans perte non pris en charge.

e QCELP et AMR NB/WB ne sont pas pris en charge.

e Vorbis est pris en charge par jusqu'a 5.1 canaux.

e Vorbis est pris en charge jusqu'a un format de canaux 5.1.

e Lecodec DTS LBR est seulement disponible pour les formats MKV, MP4 et TS.

e Lestaux pris en charge sont 8, 11.025, 12, 16, 22.05, 24, 32, 44.1, et 48 KHz, et sont différents selon le
codec.



A lire aprés avoir installé le téléviseur

Dimensions de I'image et signaux d'entrée

La configuration Image Format s'applique a la source en cours. La fonction Image Format gardera les mémes
réglages jusqu'a la prochaine sélection de la source a moins que vous en changiez.

Signal d'entrée

Composante

Chaine numérique (720p)

Chaine numérique (1080i, 1080p)

Chaine numérique (3840 x 2160p @ 24/30Hz)
Chaine numérique (3840 x 2160p @ 50/60Hz)
Chaine numérique (4096 x 2160p)

HDMI (720p)

HDMI (1080i, 1080p)

HDMI (3840 x 2160p)

HDMI (4096 x 2160p)

USB (720p)

USB (1080i/p @ 60Hz)

USB (3840 x 2160p @ 24/30Hz)

USB (3840 x 2160p @ 60Hz)
USB (4096 x 2160p @ 24/30/60Hz)

Taille de I'image

21:9, 16:9, Zoom, Sous-titres, Personnalisé, 4:3

21:9, 16:9, Zoom, Sous-titres, Personnalisé, 4:3

21:9, Auto, 16:9, Zoom, Sous-titres, Personnalisé, 4:3
21:9, Auto, 16:9, Zoom, Sous-titres, Personnalisé
21:9, 16:9, Zoom, Sous-titres, Personnalisé

21:9, 16:9, Zoom, Sous-titres, Personnalisé

21:9, 16:9, Zoom, Sous-titres, Personnalisé, 4:3

21:9, Auto, 16:9, Zoom, Sous-titres, Personnalisé, 4:3
21:9, Auto, 16:9, Zoom, Sous-titres, Personnalisé
21:9, 16:9, Zoom, Sous-titres, Personnalisé

21:9, 16:9, Zoom, Sous-titres, Personnalisé, 4:3

21:9, Auto, 16:9, Zoom, Sous-titres, Personnalisé, 4:3

21:9, Auto, 16:9, Zoom, Sous-titres, Personnalisé

21:9, 16:9, Zoom, Sous-titres, Personnalisé

¢ 21:9, Sous-titres, Auto en format 21:9 dont seulement pris en charge par les modéles de la série SOW.

> . . . ' .
¢  Auto |l se peut que ce mode ne fonctionne pas correctement en fonction des signaux d'entrée.

Installation du systéme antivol

Le dispositif antivol permet de protéger physiquement le téléviseur contre le vol. Recherchez la fente du dispositif
antivol a l'arriére de l'appareil. La fente est indiquée par l'icéne (). Pour utiliser le systéme antivol, enroulez le verrou
autour d'un objet lourd, puis faites-le glisser dans la fente du téléviseur. Le systéme antivol est vendu séparément.
La méthode d'utilisation du dispositif antivol peut différer selon le modéle du téléviseur. Pour en savoir davantage,

reportez-vous au guide d'installation du dispositif antivol.

¢  Cette fonction n'est pas disponible sur certains modéles dans certaines zones géographiques particuliéres.



Veuillez lire ces instructions avant de configurer une connexion a Internet
sans fil

Précautions a suivre pour la connexion Internet sans fil

e Ce téléviseur prend en charge les protocoles de communication IEEE 802.11 a /b /g /n /ac. Samsung
recommande l'utilisation du protocole IEEE 802.11n. La lecture de certains fichiers vidéo enregistrés sur un
dispositif connecté au téléviseur par I'entremise d'un réseau domestique pourrait étre altérée.

e Pour utiliser une connexion Internet sans fil, le téléviseur doit &tre connecté a un routeur ou un modem
sans fil. Si le routeur sans fil est compatible avec le protocole DHCP, le téléviseur peut utiliser une adresse IP
statique ou DHCP pour établir la connexion au réseau sans fil.

e Sélectionnez une chaine actuellement inutilisée pour le routeur sans fil. Si la chaine choisie pour le routeur
est actuellement utilisée par un autre appareil, il y aura des interférences et la communication échouera.

e Laplupart des systémes de réseau sans fil sont équipés d’un systéme de sécurité optionnel. Pour mettre en
service le systéme de sécurité d'un réseau sans fil, vous devez créer un mot de passe a l'aide de caractéres
et de chiffres. Ce mot de passe est ensuite nécessaire pour se connecter a un point d'accés dont la fonction
sécurité est activée.

Protocoles de sécurité du réseau sans fil

Votre téléviseur prend seulement en charge les protocoles de sécurité du réseau sans fil qui suivent. Le téléviseur
ne peut se connecter a des routeurs sans fil non-certifiés.

— Modes d'authentification : WEP, WPAPSK, WPA2PSK
— Types de chiffrement : WEP, TKIP, AES

Les téléviseurs Samsung ne prennent pas en charge le type de chiffrement WEP ou TKIP conformément aux
nouvelles spécifications de certification de produits sans fil lorsque le mode (Greenfield) 802.11n est sélectionné.

Si le routeur sans fil prend en charge la configuration WPS (Configuration Wi-Fi protégée), vous pouvez vous
connecter au réseau a I’aide de la configuration par touches (PBC) ou d’un NIP (numéro d’identification personnel).
WPS configurera automatiquement les clés SSID et WPA.

Lire avant de brancher un ensemble Evolution

Certaines fonctions ne sont pas disponibles en fonction des spécifications du téléviseur lorsque I'ensemble
Evolution est branché.



Instructions a lire avant de procéder a la connexion d'un
ordinateur (résolutions prises en charge)

Lorsque vous branchez le téléviseur a un ordinateur, choisissez, pour l'ordinateur, I'une des résolutions standard
indiquées dans les tableaux sur cette page ou la page suivante. Le téléviseur se réglera automatiquement a la
résolution choisie. Veuillez noter que la résolution recommandée et optimale est 3840 x 2160, a 60 Hz. Si vous
sélectionnez une résolution ne figurant pas dans le tableau, I'écran de votre téléviseur pourrait étre vide ou seul le
voyant de mise sous tension pourrait s'allumer. Reportez-vous au manuel de I'utilisateur de votre carte graphique
pour connaitre les résolutions compatibles.

IBM
Résolution Fréquence Fréquence Fréquence de Polarité
d'Ff?f'mI-'l\at horizontale verticale I'horloge (horlzontaler
i i affichage -
(Points x Lignes) 9 (kH2) (Hz) (MHz2) verticale)
720 x 400 70 Hz 31.469 70.087 28.322 -/+
MAC
Résolution Fréquence Fréquence Fréquence de Polarité
d'F:frTxat horizontale verticale I'horloge (horizontale/
i i affichage :
(Points x Lignes) 9 (kHz) (Hz) (MHz2) verticale)
640 x 480 67 Hz 35.000 66.667 30.240 -/-
832x624 75Hz 49.726 74.551 57.284 -/-

1152 x 870 75Hz 68.681 75.062 100.000 -/-



VESA DMT

Résolution

(Points x Lignes)

640 x 480
640 x 480
640 x 480
800 x 600
800 x 600
800 x 600
1024 x 768
1024 x 768
1024 x 768
1152 x 864
1280x 720
1280 x 800
1280 x 1024
1280 x 1024
1366 x 768
1440 x 900
1600 x 900 RB
1680 x 1050
1920 x 1080

*2560X1080

*: Cette résolution est prise en charge seulement par les téléviseurs de série SOW.

Format
d'affichage

60 Hz
72 Hz
75Hz
60 Hz
72 Hz
75Hz
60 Hz
70 Hz
75 Hz
75Hz
60 Hz
60 Hz
60 Hz
75Hz
60 Hz
60 Hz
60 Hz
60 Hz
60 Hz

60Hz

Fréquence
horizontale

(kHz)

31.469
37.861
37.500
37.879
48.077
46.875
48.363
56.476
60.023
67.500
45.000
49.702
63.981
79.976
47.712
55.935
60.000
65.290
67.500

112.500

Fréquence
verticale

(Hz)

59.940
72.809
75.000
60.317
72.188
75.000
60.004
70.069
75.029
75.000
60.000
59.810
60.020
75.025
59.790
59.887
60.000
59.954
60.000

60.000

Fréquence de
I'horloge

(MHz)

25.175
31.500
31.500
40.000
50.000
49.500
65.000
75.000
78.750
108.000
74.250
83.500
108.000
135.000
85.500
106.500
108.000
146.250
148.500

594.000

Polarité
(horizontale/
verticale)

+/+

+/+

+/+

+/+

+/+

+/+

-/+

+/+

+/+

+/+

_/+

+/+

_/+

+/+

+/+



Résolutions prises en charge pour les sighaux vidéo

CEA-861
Résolution . Fréquence Fréquence Fréquence de Polarité
reriret: horizontale verticale I'horloge (horizontale/

(Points x Lignes) el el (kHz) (Hz) (MH2) verticale)
720 (1440) x 576i 50 Hz 15.625 50.000 27.000 -/-
720 (1440) x 480i 60 Hz 15.734 59.940 27.000 -/-
720x 576 50 Hz 31.250 50.000 27.000 -/-
720 x 480 60 Hz 31.469 59.940 27.000 -/-
1280x 720 50 Hz 37.500 50.000 74.250 +/+
1280x 720 60 Hz 45.000 60.000 74.250 +/+
1920 x 1080i 50 Hz 28.125 50.000 74.250 +/+
1920 x 1080i 60 Hz 33.750 60.000 74.250 +/+
1920 x 1080 24 Hz 27.000 24.000 74.250 +/+
1920 x 1080 25Hz 28.125 25.000 74.250 +/+
1920 x 1080 30Hz 33.750 30.000 74.250 +/+
1920 x 1080 50 Hz 56.250 50.000 148.500 +/+
1920 x 1080 60 Hz 67.500 60.000 148.500 +/+
3840 x 2160 24 Hz 54.000 24.000 297.000 +/+
3840x 2160 25Hz 56.250 25.000 297.000 +/+
3840 x 2160 30Hz 67.500 30.000 297.000 +/+
3840x 2160 50 Hz 112.500 50.000 594.000 +/+
3840x 2160 60 Hz 135.000 60.000 594.000 +/+
4096 x 2160 24 Hz 54.000 24.000 297.000 +/+
4096 x 2160 25Hz 56.250 25.000 297.000 +/+
4096 x 2160 30Hz 67.500 30.000 297.000 +/+
4096 x 2160 50 Hz 112.500 50.000 594.000 +/+

4096 x 2160 60 Hz 135.000 60.000 594.000 +/+



Read A lire avant d'utiliser les appareils Bluetooth

Restrictions s'appliquant a l'utilisation d'un appareil Bluetooth

La fonction de haute-parleurs Bluetooth de Samsung est seulement disponible pour les appareils qui
prennent en charge la fonction Connex son du téléviseur.

Vous ne pouvez pas utiliser simultanément les appareils Bluetooth, Connex son du téléviseur (MENU > Son
> Paramétres haut-parleur > Connex son du téléviseur) et |la fonction Surround.

Il est possible que vous éprouviez des problémes de compatibilité, selon le modéle d'appareil Bluetooth.
(L'utilisation d'écouteurs mobiles peut étre impossible, en fonction de I'environnement.)

Des erreurs de synchronisation labiale peuvent se produire.

Il est possible que la connexion entre 'appareil Bluetooth et le téléviseur soit interrompue, en fonction de la
distance qui les sépare.

Il est possible qu'un appareil Bluetooth sille ou ne fonctionne pas comme il se doit :

— Siune partie de votre corps est en contact avec le systéme de réception et de transmission de l'appareil
Bluetooth ou du téléviseur.

- Sil'appareil subit des variations électriques causées par une obstruction comme un mur, un coin ou une
cloison.

— Sil'appareil est exposé a de l'interférence électrique causée par un appareil qui emploie la méme bande
de fréquence, notamment des appareils médicaux, des fours micro-ondes et des réseaux sans fil.

Si le probléme persiste, essayez de brancher I'appareil a I'aide du port numérique optique ou du port HDMI
(ARC).
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Lexique

480i/480p/720p/1080i/1080p

Fait généralement référence au nombre de lignes de balayage réelles qui détermine la résolution de I'écran. Il
existe deux méthodes de balayage : entrelacé et progressif.
- Balayage

Projection séquentielle de pixels pour former les images. Plus le nombre de pixels est élevé, plus les
images sont claires et vives.

- Progressif
Une méthode de balayage séquentielle balayant chaque ligne, une aprés l'autre.
- Entrelacé

Une méthode de balayage en étage qui balaie une ligne sur deux jusqu'a la fin de I'écran, puis remplit les
lignes restantes.

(Exemple) Si le nombre de lignes horizontales balayées est 480i
Balaie 240 lignes du début a la fin, puis balaie les 240 lignes restantes pour un total de 480 lignes.

* Les principales différences entre 480i et 480p sont :

480i 480p
Fréquence horizontale 15,75Khz 31,5Khz
Image/sec 30 60
Ligne a I'écran 480 480

ARC (Audio Return Channel)

Le mode ARC permet la sortie audio numérique du téléviseur vers un appareil audio et I'entrée audio
numérique provenant du méme appareil audio a l'aide d'un seul cable HDMI. Cependant, le mode ARC n'est
disponible qu'a partir de la prise HDMI (ARC) et seulement lorsque le téléviseur est branché a un récepteur
audiovisuel prenant en charge la fonction ARC.

DVI (interface vidéo numérique)

Le branchement du connecteur DVI du téléviseur au connecteur DVI de l'ordinateur a l'aide d'un cable
HDMI-DVI vous permet d'utiliser le téléviseur comme écran d'ordinateur. Cependant, les cables HDMI-DVI
ne transmettent que le signal vidéo. Vous devez brancher des haut-parleurs a l'ordinateur a l'aide d'un autre
cable pour entendre le son de l'ordinateur.

HDMI (Interface multimédia haute définition)

HDMI est une méthode de transmission permettant le transfert des signaux vidéo et audio par I'entremise
d'un seul cable.



Adresses IP dynamiques et statiques

Si votre réseau nécessite une adresse IP dynamique, vous devez utiliser un modem ou routeur ADSL prenant
en charge le protocole DHCP (Dynamic Host Configuration Protocol). Les modems et routeurs qui prennent
en charge le protocole DHCP fournissent automatiquement I’adresse IP, le masque de sous-réseau, la
passerelle et les valeurs DNS dont votre téléviseur a besoin pour accéder a Internet, de sorte que vous n’ayez
pas a les saisir manuellement. La plupart des réseaux domestiques utilisent une adresse IP dynamique.

Sile réseau nécessite une adresse IP statique, vous devez saisir manuellement I’'adresse IP, le masque de
sous-réseau, la passerelle et les valeurs DNS lors de la configuration de votre connexion au réseau. Pour
obtenir ces données, veuillez communiquer avec votre fournisseur d'accés Internet.

Sile réseau nécessite une adresse IP statique, vous devez utiliser un modem ADSL qui prend en charge le
protocole DHCP. Les modems ADSL qui prennent en charge le protocole DHCP permettent aussi d’utiliser
des adresses IP statiques.

Bluetooth

La technologie Bluetooth est un protocole de communication sans fil sur de courtes distances qui permet
permet d'échanger des données entre des téléphones cellulaires, des ordinateurs portables, des écouteurs
et des casques d'écoute connectés et compatibles avec la technologie Bluetooth. La technologie est
principalement employée pour établir des connexions sans fil a faible puissance sur une distance de 10 m (32,8
pi) ou moins.

Ethernet
Ethernet est un réseau local (LAN) utilisant des cables coaxiaux respectant la norme IEEE.
Branchement d'une composante

Les cables composantes sont principalement utilisés pour les consoles de jeux et transmettent le signal vidéo
en le convertissant en un signal de luminance (Y) et deux signaux des couleurs (Pb et Pr). Le connecteur est
identifié par [Component IN]_(Pr, Pb, Y) a l'arriére du téléviseur. Sur certains appareils, vous pourriez voir les
noms Cr, Cb et Y. Cb et Cr sont les versions numériques des signaux Pb et Pr.

Les connecteurs sont habituellement identifiés par leur couleur rouge (R), bleu (B) et vert (V) et offrent la
meilleure qualité d'image possible pour une connexion analogique.
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